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Q1: What are the four fundamental parts of computer? Explain it with the help of 

diagram. 

Ans . The 5 different parts of a computer—

taking a look under the hood 

By: iD Tech | Jun 11, 2019 3:11 PM 

 S h a r e   

 

What is a computer? 
A computer is any machine that can be programmed to carry out a set of 
algorithms and arithmetic instructions.  

Of course, the computers we think of today are so much more than that—and I‘m 
talking beyond just being machines used to play games and watch videos of cats 
on the internet! 

5 parts of a computer 
Whether it's a gaming system or a home PC, the five main components that 
make up a typical, present-day computer include: 

 A motherboard 
 A Central Processing Unit (CPU) 
 A Graphics Processing Unit (GPU), also known as a video card 
 Random Access Memory (RAM), also known as volatile memory 
 Storage: Solid State Drive (SSD) or Hard Disk Drive (HDD) 

In terms of construction, each of these main components are attached to the 
motherboard and then put into a protective case—resembling the clean, polished 
look most of us are accustomed to seeing.  

Sure, most computers have their own distinct design - and different brands of 
hardware installed - but the components listed above are standard across all 
computers.  

Important: A quick note before we dive into the details—I‘m listing and talking 
about the different components of a computer. This is by no means intended to 
be an invitation to disassemble your computer, nor is it a set of instructions to do 
so. Without the proper knowledge, you can severely damage your computer, and 
importantly, doing so is unsafe.  

1. The motherboard 

https://www.idtech.com/blog/author/id-tech


What it is: All components of a computer communicate through a circuit board 
called the motherboard, as was mentioned above.  

What it does: Think of the motherboard as the glue that holds everything else 
together. 

(The Raspberry Pi, like the one featured in our summer course for kids,  Build and 
Code Your Own Take-Home Laptop, is a motherboard.) 

The motherboard‘s video card and Central Processing Unit are contained in an 
integrated (built-in) chipset, shown in the picture below: 

 

This is where input/output devices such as a keyboard, mouse, and speakers get 
plugged in. 

2. The Central Processing Unit (CPU) 
What it is: The CPU is often called the "brain" of a computer, thanks to its direct 
plug connection to the motherboard, and communication with all of the 
computer‘s other components. 

Get your child started with STEM via online learning 

DOWNLOAD BROCHURE 

What it does: Whenever you write a line of code (in Python, Java, C++, or any 
other programming language), it's broken down into assembly language—
which is a language that the processor can understand. It fetches, decodes, and 
executes these instructions. 

And that‘s where the CPU comes in—all the processes a computer handles are 
taken care of by the CPU. 
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3. The Graphics Processing Unit (GPU) 
What it is: It's not uncommon to hear gamers obsess over the next new graphics 
card, as these graphic cards make it possible for computers to generate high-end 
visuals like those found in the many different types of video games. 

In addition to video games, though, good graphics cards also come in handy for 
those who rely on images in order to execute their craft, like 3D modelers using 
resource-intensive software. 

What it does: Graphics cards often communicate directly with the display 
monitor, meaning a $1,000 graphics card won't be of much use if there isn't a 
high-end monitor connected to it. 

 

4. Random Access Memory (RAM) 
What it is: RAM, also known as volatile memory, stores data regarding frequently 
accessed programs and processes. (It's called volatile memory because it gets 
erased every time the computer restarts.) 

What it does: RAM helps programs and games start up and close quickly. 

https://www.idtech.com/blog/different-types-of-video-game-genres


 

5. Storage 
What it is: All computers need somewhere to store their data. Modern computers 
either use a Hard Disk Drive (HDD) or Solid State Drive (SSD). 

What it does: HDDs are made of an actual disk onto which data is stored. The 
disk is read by a mechanical arm. (HDDs are cheaper than SSDs, but are slowly 
becoming more and more obsolete.) 

SSDs (think SIM cards) have no moving parts and are faster than a hard drive, 
because no time is spent waiting for a mechanical arm to find data on a physical 
location on the disk. 

Fun, right? 
Some enjoy computers from the frontend, spending time on YouTube, shopping 
on eBay, and playing video games (and experiencing the benefits of doing so.).  

But for others, it‘s the ―how‖ that proves to be more intriguing! Taking computers 
apart and putting them back together, adding new hardware, troubleshooting 
hardware assembly, and booting them up (and crossing their fingers!) is all part 
of such intrigue.  

Does the latter sound like your child?  

Our ―build your own laptop‖ courses offer introductions to hardware, engineering, 
and coding, offering students the opportunity to assemble laptops, code with 
Python to create games, and use the Linux OS. All of this also improves soft 
skills like project-planning and hands-on coordination! 

To learn more, visit the links below: 

Raspberry Pi Summer Camp (build a laptop computer; ages 10-12) 
Python Coding Summer Camp  (for Machine Learning; ages 13-17) 

Outside of summer, kids can still get hands-on with coding and micro:bit in online 
private lessons (micro:bit Included), working with JavaScript or visual coding to 
turn on lights and power different components.  

Check out our many different online coding courses for kids and teens. 

https://www.idtech.com/blog/video-games-are-good-for-you
https://www.idtech.com/courses/build-and-code-a-laptop
https://www.idtech.com/courses/intro-to-coding-for-machine-learning
https://www.idtech.com/blog/online-coding-classes-for-kids-teens


 

 

Q2: Discuss about the classification of computers based on size and capacity.  

Ans . Classification of Computer Based on Size and Capability 

  

Introduction 

Classification of computers are based on their architecture, speed of executing commands or 

instructions, peripheral used and also their uses. Microcomputers are usually used in home and 

offices and only a single user can perform the task using a microcomputer. Its storage and data 

handling capacity are limited as per the requirement for home and office work. The another type 

of computer is called minicomputer which has usually larger storage and can handle multiuser at 

a time. This chapter includes the classification of computers. 

  

Computer's Classification 

Computers are classified on different parameters, such as, storage capacity, processing speed 

and component (CPU) used in computers. Depending upon the components used and features 

of different computers, they are classified into four groups, Microcomputers, Minicomputers, 

Mainframe computers and Supercomputers. 

  

Micro Computers 

Micro Computer is a computer whose CPU (Central Processing Unit) is a microprocessor. All the 

components of a microprocessor are on a single integrated circuit chip. Micro computer can be 

categorized as the desktop, programmable and workstation. The microprocessor based 

computers are called third generation computers. They are the backbone of the modern 

computer era. The first and second generation computers are based on vacuum tubes and 

bipolar junction transistors. 

  



 

  

Desktop Computers 

Desktop computer is a type of microcomputer. A desktop computer has a keyboard for input 

data, a LCD or CRT monitor to display information and Central processing unit tower contains 

storage, memory, different types of drives, such as, CD drive, hard drive, etc. A desktop 

computer is mainly used at home and office applications. 

  

Programmable Computers (PDA) 

Personal digital assistance is a type of hand held programmable digital computer. It is used as 

notepads, address books and can connect to world web wave to share information. A PDA is 

equipped with mobile phone hence, called smallest computer. 

  

  

Workstation 

A workstation computer has greater memory capability and more extensive mathematical 

abilities. It is connected with other workstation computers or personal computer to exchange data 

and mostly used for scientific applications. It also supports multitasking applications. 

  

Mini Computers 

Minicomputers were introduced in early 1960s. They were faster than micro computers. Basically 

these computers were mainly multi-user systems, where many users work on the systems. 

Generally these types of computers had larger memories and greater storage capacity. They had 

large instruction set and address field. These kinds of computers have efficient storage for 

handling of text, in comparison to lower bit machines. Due to more efficient processor, speed and 



memory size, minicomputer was used in variety of applications and could support business 

applications along with the scientific applications. Minicomputer was a multi-user system which 

means more than one user could use this system simultaneously. 

  

Comparison of Micro and Mini computers 

  

Features Microcomputer Minicomputer 

Primary 
memory  

Shall memory Larger memory 

Word length  Small word 
length  

Larger word 
length 

Cost low Low High 

Processor Low High 

  

Mainframe Computers 

Mainframe computers are large and expensive machines. The word length of mainframe 

computers may be 48, 60 or 64 bits, memory capacity being in some megabytes and storage 

capacity in some terabytes. Generally they handle huge volumes of information and data. In 

terms of speed, they are having significant processing capacity. They are used in research 

organizations, large industries, airlines reservation where a large database has to be maintained. 

  

 

  

Super Computers 

Super Computers are the fastest computer in current era. The processing capabilities of super 

computer lies in the range of GIPS2, word length 64-128 or may be in 256 or so. The memory 

capacity of super computer is in some gigabytes or in terabytes. The storage capacity of this type 

of computer is in exabytes. 



  

 

  

The parallel processing of a super computer makes it very fast because it contains number of 

CPU that operates parallel. They are used at some research centers and government agencies 

involving sophisticated scientific and engineering tasks. 

  

Super computers are used for the followings: 

  

  Weapons research and development 

  Nuclear and plasma physics 

  Rocket research and development 

  Atomic research 

  Aerodynamics 

  

Units For Measuring Word Length, Data, And Storage Capacity of a Computer 

Q3: What is the meaning of computer generation? How many Computer Generations 

aredefined? What technologies were/are used? 



Ans . Generation in computer terminology is a change in technology a computer is/was 

being used. Initially, the generation term was used to distinguish between varying hardware 

technologies. Nowadays, generation includes both hardware and software, which together 

make up an entire computer system. 

How many generations of computers are 
there? 
Updated: 08/31/2020 by Computer Hope 

Computer generations are based on when 

major technological changes in computers 
occurred, like the use of vacuum tubes, 

transistors, and the microprocessor. As of 
2020, there are five generations of the 

computer. 

Review each of the generations below for 

more information and examples of 

computers and technology that fall into 

each generation. 

First generation (1940 - 1956) 

 

The first generation of computers 

used vacuum tubes as a major piece of 

technology. Vacuum tubes were widely 

used in computers 

https://www.computerhope.com/jargon/v/vacuumtu.htm


from 1940 through 1956. Vacuum tubes 

were larger components and resulted in 

first generation computers being quite 

large in size, taking up a lot of space in a 

room. Some of the first generation 

computers took up an entire room. 

The ENIAC is a great example of a first 

generation computer. It consisted of 

nearly 20,000 vacuum tubes, 

10,000 capacitors, and 70,000 resistors. It 

weighed over 30 tons and took up a lot of 

space, requiring a large room to house it. 

Other examples of first generation 

computers include the EDSAC, IBM 701, 

and Manchester Mark 1. 

Second generation (1956 - 1963) 

 

The second generation of computers saw 

the use of transistors instead of vacuum 

tubes. Transistors were widely used in 

computers from 1956 to 1963. Transistors 

were smaller than vacuum tubes and 

allowed computers to be smaller in size, 

faster in speed, and cheaper to build. 

https://www.computerhope.com/history/1940.htm
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The first computer to use transistors was 

the TX-0 and was introduced in 1956. 

Other computers that used transistors 

include the IBM 7070, Philco Transac S-

1000, and RCA 501. 

Third generation (1964 - 1971) 

 

The third generation of computers 

introduced the use of IC (integrated 

circuits) in computers. Using IC's in 

computers helped reduce the size of 

computers even more compared to 

second-generation computers, and make 

them faster. 

Nearly all computers since the mid to late 

1960s have utilized IC's. While the third 

generation is considered by many people 

to have spanned from 1964 to 1971, IC's 

are still used in computers today. Over 45 

years later, today's computers have deep 

roots going back to the third generation. 

Fourth generation (1972 - 2010) 

https://www.computerhope.com/jargon/i/ic.htm
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The fourth generation of computers took 

advantage of the invention of 

the microprocessor, more commonly 

known as a CPU. Microprocessors, with 

integrated circuits, helped make it possible 

for computers to fit easily on a desk and 

for the introduction of the laptop. 

Some of the earliest computers to use a 

microprocessor include the Altair 

8800, IBM 5100, and Micral. Today's 

computers still use a microprocessor, 

despite the fourth generation being 

considered to have ended in 2010. 

Fifth generation (2010 to present) 
 

The fifth generation of computers is 

beginning to use AI (artificial intelligence), 

an exciting technology with many potential 

applications around the world. Leaps have 

been made in AI technology and 

https://www.computerhope.com/jargon/c/cpu.htm
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computers, but there is still room for much 

improvement. 

One of the more well-known examples of 

AI in computers is IBM's Watson, which 

was featured on the TV show Jeopardy as 

a contestant. Other better-known 

examples include Apple's Siri on the 

iPhone and Microsoft's Cortana on 

Windows 8 and Windows 10 computers. 

The Google search engine also utilizes AI 

to process user searches. 

Q4: Differentiate between Volatile & Non- Volatile memories. 

Ans . Difference between Volatile Memory 
and Non-Volatile Memory 

Computer EngineeringComputer NetworkMCA 

 

 

Volatile and Non-Volatile Memory are both types of computer memory. Volatile 
Memory is used to store computer programs and data that CPU needs in real time 
and is erased once computer is switched off. RAM and Cache memory are volatile 
memory. Where as Non-volatile memory is static and remains in the computer even 
if computer is switched off. ROM and HDD are non-volatile memory. 

Following are the important differences between Volatile and Non-Volatile Memory. 

Sr. 

No. 

Key Volatile Memory Non-Volatile Memory 

1 
Data 

Retention 

Data is present till power 

supply is present. 

Data remains even after power 

supply is not present. 

2 
Persistence Volatile memory data is not 

permanent. 

Non-volatile memory data is 

permanent. 

https://www.computerhope.com/jargon/s/siri.htm
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Sr. 

No. 

Key Volatile Memory Non-Volatile Memory 

3 
Speed Volatile memory is faster 

than non-volatile memory. 

Non-volatile memory access is 

slower. 

4 
Example RAM is an example of 

Volatile Memory. 

ROM is an example of Non-Volatile 

Memory. 

5 
Data 

Transfer 

Data Transfer is easy in 

Volatile Memory. 

Data Transfer is difficult in Non-

Volatile Memory. 

6 

CPU 

Access 

CPU can access data stored 

on Volatile memory. 

Data to be copied from Non-Volatile 

memory to Volatile memory so that 

CPU can access its data. 

7 
Storage Volatile memory less storage 

capacity. 

Non-Volatile memory like HDD has 

very high storage capacity. 

8 

Impact Volatile memory such as 

RAM is high impact on 

system's performance. 

Non-volatile memory has no impact 

on system's performance. 

9 
Cost Volatile memory is costly per 

unit size. 

Non-volatile memory is cheap per 

unit size. 

 

 

  



Q5: Distinguish among system software, application software and open source software 

on the 

basis of their features.  

Ans . Main Difference 

Volatile Memory refers to the temporary memory in the computer that 

only contains data until power is supplied, once the system is turned off 

the data present in the memory is lost. RAM (Random Access Memory) of 

the computer system is the common type of volatile memory as it only 

stores data of the current ongoing processes in it and as the system is 

turned off the data in the RAM vanishes. Non-Volatile Memory is the type 

of computer memory that stores the data permanently even after the power 

is off. Secondary storage or ROM is the kind of Non-volatile memory as 

the data stored in them is saved even after the system is turned off. 

Common examples of the Non-volatile memory includes hard discs, flash 

memory, optical disc, etc. 

Comparison Table 

 

Volatile Memory Non-Volatile Memory 

Definition 
Volatile Memory is the type of computer memory that is temporary in 

nature. It stores the data inside it only until the power is supplied. 

Non-Volatile Memory is the type of computer memory that is 

permanent in nature. The data stored in such kind of memory remains 

there even after the system is turned off. 

Data 

Stored 

Volatile memory store data of the programs that are currently in process by 

the CPU. Frequently used data and information about the process is stored 

in Volatile memory. 

Non-volatile memory store data of the basic booting process of the 

computer system BIOS. All kind of media and data that has to be saved 

permanently or for the longer period. 

Effects 

Volatile Memory has effects on the system’s performance. The more storage 

space on the volatile memory such as RAM and cache, the more efficient will 

be the performance of the system. 

Non-Volatile Memory has effects on the system storage. The more 

storage space, the more amount of data can be stored in the computer 

system and can be stored permanently. 

Speed 
Volatile memories are the fastest memories in nature. They contain 

frequently used data inside them and data is accessed from them quickest 

Non- Volatiles memories whereas are relatively slow as compare to 

volatile memories. The data accessed from non-volatile memory is slow 



than all. as compared to volatile memory. 

Example 
Common Examples of volatile memory includes the RAM of the computer, 

Cache, etc. 

Common Examples of the Non-volatile memory includes ROM ( 

Secondary Storage, Hard disc) of the computer, optical storage discs, 

flash memory, etc. 

ADVERTISEMENT 

CONTINUE READING BELOW 

What is Volatile Memory? 

Volatile Memory is the kind of computer memory that stores data 

temporarily. It is also referred as temporary memory. The data in the 

volatile memory is stored only until the power is supplied to the system, 

once the system is turned off the data present inside the volatile memory is 

deleted automatically. RAM and cache of the computer system are the best 

common example of the volatile memory. Volatile memory due to its 

temporary nature its stores only the frequently used data. The data of the 

programs running on the processor is stored in volatile memory. It is quite 

fast and efficient in nature and can be accessed rapidly. Volatile memory is 

directly linked to the performance of the computer system. The more 

amount of volatile memory the more effective performance the computer 

system will possess. Common examples of the volatile memory include 

RAM, Cache, etc. 

ADVERTISEMENT 

What is Non-volatile Memory? 

Non-volatile Memory is the kind of computer memory that stores the data 

permanently. The data stored in the non-volatile memory remains there 

even after the system is turned off. ROM of the computer is the non-

volatile memory. It is not that much efficient and fast in nature as compare 

to volatile memory but stores data for the longer period. Non-volatile 

memory possesses the basic system information inside it such as the boot 

process information, system starting up information and BIOS. Non-

volatile memory is slow regarding accessing. All such data that needs to be 

stored permanently or for a longer period is stored in non-volatile memory. 

Non-volatile memory has a direct impact on the system’s storage 

capability. The more non-volatile memory, the more permanent storage 

space will be there. Common examples of non-volatile memory include a 

hard drive, optical discs, flash memory, etc. 



Volatile Memory vs. Non-Volatile Memory 

 Volatile Memory is the temporary memory of the computer system. 

 Non-volatile Memory is the permanent memory of the computer 

system. 

 Data of programs in the process and frequently used data is stored in 

volatile memory. 

 System’s information, BIOS and all the other kind of data is stored 

in non-volatile memory. 

 Volatile memory is fast and efficient in nature. 

 Non-volatile memory is slow and permanent in nature. 

What is open source? 
 

x 

Subscribe now 

Get the highlights in your inbox every week. 

The term open source refers to something people can modify and share 
because its design is publicly accessible. 

The term originated in the context of software development to designate a 
specific approach to creating computer programs. Today, however, "open 
source" designates a broader set of values—what we call "the open source 
way." Open source projects, products, or initiatives embrace and celebrate 
principles of open exchange, collaborative participation, rapid prototyping, 
transparency, meritocracy, and community-oriented development. 

What is open source software? 

Open source software is software with source code that anyone can 
inspect, modify, and enhance. 

"Source code" is the part of software that most computer users don't ever 
see; it's the code computer programmers can manipulate to change how a 
piece of software—a "program" or "application"—works. Programmers who 
have access to a computer program's source code can improve that 

https://opensource.com/article/18/2/coining-term-open-source-software
https://opensource.com/open-source-way
https://opensource.com/open-source-way


program by adding features to it or fixing parts that don't always work 
correctly. 

What's the difference between open source 
software and other types of software? 

Some software has source code that only the person, team, or organization 
who created it—and maintains exclusive control over it—can modify. 
People call this kind of software "proprietary" or "closed source" software. 

Only the original authors of proprietary software can legally copy, inspect, 
and alter that software. And in order to use proprietary software, computer 
users must agree (usually by signing a license displayed the first time they 
run this software) that they will not do anything with the software that the 
software's authors have not expressly permitted. Microsoft Office and 
Adobe Photoshop are examples of proprietary software. 

Open source software is different. Its authors make its source code 
available to others who would like to view that code, copy it, learn from it, 
alter it, or share it. LibreOffice and the GNU Image Manipulation 
Program are examples of open source software. 

As they do with proprietary software, users must accept the terms of 
a license when they use open source software—but the legal terms of open 
source licenses differ dramatically from those of proprietary licenses. 

Open source licenses affect the way people can use, study, modify, and 
distribute software. In general, open source licenses grant computer 
users permission to use open source software for any purpose they wish. 
Some open source licenses—what some people call "copyleft" licenses—
stipulate that anyone who releases a modified open source program must 
also release the source code for that program alongside it. Moreover, some 
open source licenses stipulate that anyone who alters and shares a 
program with others must also share that program's source code without 
charging a licensing fee for it. 

By design, open source software licenses promote collaboration and 
sharing because they permit other people to make modifications to source 
code and incorporate those changes into their own projects. They 
encourage computer programmers to access, view, and modify open 
source software whenever they like, as long as they let others do the same 
when they share their work. 

https://opensource.com/business/13/5/open-source-your-code
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Is open source software only important to 
computer programmers? 

No. Open source technology and open source thinking both benefit 
programmers and non-programmers. 

Because early inventors built much of the Internet itself on open source 
technologies—like the Linux operating system and the Apache Web server 
application—anyone using the Internet today benefits from open source 
software. 

Every time computer users view web pages, check email, chat with friends, 
stream music online, or play multiplayer video games, their computers, 
mobile phones, or gaming consoles connect to a global network of 
computers using open source software to route and transmit their data to 
the "local" devices they have in front of them. The computers that do all this 
important work are typically located in faraway places that users don't 
actually see or can't physically access—which is why some people call 
these computers "remote computers." 

More and more, people rely on remote computers when performing tasks 
they might otherwise perform on their local devices. For example, they may 
use online word processing, email management, and image editing 
software that they don't install and run on their personal computers. 
Instead, they simply access these programs on remote computers by using 
a Web browser or mobile phone application. When they do this, they're 
engaged in "remote computing." 

Some people call remote computing "cloud computing," because it involves 
activities (like storing files, sharing photos, or watching videos) that 
incorporate not only local devices but also a global network of remote 
computers that form an "atmosphere" around them. 

Cloud computing is an increasingly important aspect of everyday life with 
Internet-connected devices. Some cloud computing applications, like 
Google Apps, are proprietary. Others, like ownCloud and Nextcloud, are 
open source. 

Cloud computing applications run "on top" of additional software that helps 
them operate smoothly and efficiently, so people will often say that 
software running "underneath" cloud computing applications acts as a 
"platform" for those applications. Cloud computing platforms can be open 

https://opensource.com/resources/what-is-linux
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source or closed source. OpenStack is an example of an open source 
cloud computing platform. 

Why do people prefer using open source 
software? 

People prefer open source software to proprietary software for a number of 
reasons, including: 

Control. Many people prefer open source software because they have 
more control over that kind of software. They can examine the code to 
make sure it's not doing anything they don't want it to do, and they can 
change parts of it they don't like. Users who aren't programmers also 
benefit from open source software, because they can use this software for 
any purpose they wish—not merely the way someone else thinks they 
should. 

Training. Other people like open source software because it helps 
them become better programmers. Because open source code is publicly 
accessible, students can easily study it as they learn to make better 
software. Students can also share their work with others, inviting comment 
and critique, as they develop their skills. When people discover mistakes in 
programs' source code, they can share those mistakes with others to help 
them avoid making those same mistakes themselves. 

Security. Some people prefer open source software because they consider 
it more secure and stable than proprietary software. Because anyone can 
view and modify open source software, someone might spot and correct 
errors or omissions that a program's original authors might have missed. 
And because so many programmers can work on a piece of open source 
software without asking for permission from original authors, they can fix, 
update, and upgrade open source software more quickly than they can 
proprietary software. 

Stability. Many users prefer open source software to proprietary software 
for important, long-term projects. Because programmers publicly 
distribute the source code for open source software, users relying on that 
software for critical tasks can be sure their tools won't disappear or fall into 
disrepair if their original creators stop working on them. Additionally, open 
source software tends to both incorporate and operate according to open 
standards. 

https://opensource.com/resources/what-is-openstack
https://opensource.com/life/13/5/tumblr-open-publishing
https://opensource.com/life/13/5/tumblr-open-publishing
https://opensource.com/life/13/6/learning-program-open-source-way
https://opensource.com/government/10/9/scap-computer-security-rest-us
https://opensource.com/government/13/2/bug-fix-day
https://opensource.com/life/12/9/should-we-develop-open-source-openly
https://opensource.com/life/12/9/should-we-develop-open-source-openly


Community. Open source software often inspires a community of users 
and developers to form around it. That's not unique to open source; many 
popular applications are the subject of meetups and user groups. But in the 
case of open source, the community isn't just a fanbase that buys in 
(emotionally or financially) to an elite user group; it's the people who 
produce, test, use, promote, and ultimately affect the software they love. 

Doesn't "open source" just mean something is 
free of charge? 

No. This is a common misconception about what "open source" implies, 
and the concept's implications are not only economic. 

Open source software programmers can charge money for the open source 
software they create or to which they contribute. But in some cases, 
because an open source license might require them to release their source 
code when they sell software to others, some programmers find that 
charging users money for software services and support (rather than for the 
software itself) is more lucrative. This way, their software remains free of 
charge, and they make money helping others install, use, and troubleshoot 
it. 

While some open source software may be free of charge, skill in 
programming and troubleshooting open source software can be quite 
valuable. Many employers specifically seek to hire programmers with 
experience working on open source software. 

What is open source "beyond software"? 

At Opensource.com, we like to say that we're interested in the ways open 
source values and principles apply to the world beyond software. We like to 
think of open source as not only a way to develop and license computer 
software, but also an attitude. 

Approaching all aspects of life "the open source way" means expressing a 
willingness to share, collaborating with others in ways that are transparent 
(so that others can watch and join too), embracing failure as a means of 
improving, and expecting—even encouraging—everyone else to do the 
same. 

https://opensource.com/education/12/7/clearing-open-source-misconceptions
https://opensource.com/open-organization/16/5/appreciating-full-power-open
https://opensource.com/business/14/7/making-your-product-free-and-open-source-crazy-talk
https://opensource.com/business/16/2/add-open-source-to-your-resume
https://opensource.com/business/16/2/add-open-source-to-your-resume
https://opensource.com/business/16/5/2016-open-source-jobs-report
https://opensource.com/business/16/5/2016-open-source-jobs-report
https://opensource.com/open-source-way


It also means committing to playing an active role in improving the world, 
which is possible only when everyone has access to the way that world is 
designed. 

The world is full of "source code"—blueprints, recipes, rules—that guide 
and shape the way we think and act in it. We believe this underlying code 
(whatever its form) should be open, accessible, and shared—so many 
people can have a hand in altering it for the better. 

Here, we tell stories about the impact of open source values on all areas of 
life—science, education, government, manufacturing, health, law, 
and organizational dynamics. We're a community committed to telling 
others how the open source way is the best way, because a love of open 
source is just like anything else: it's better when it's shared. 

Where can I learn more about open source? 

We've compiled several resources designed to help you learn more about 
open source. We recommend you read our open source FAQs, how-to 
guides, and tutorials to get started. 

Q6. a) Create a file in MS-word to insert a paragraph about yourself and save it with file 

name 

“yourself”. Describe all steps involved in it 

Q6 b) Write steps regarding followings 

ont style 

 

 

  

https://opensource.com/resources/what-open-access
https://opensource.com/life/11/6/architecture-open-source-applications-learn-those-you
https://opensource.com/life/12/6/open-source-like-sharing-recipe
https://opensource.com/life/12/4/day-my-mind-became-open-sourced
https://opensource.com/resources/open-science
https://opensource.com/resources/what-open-education
https://opensource.com/resources/open-government
https://opensource.com/resources/what-open-hardware
https://opensource.com/resources/what-open-organization
https://opensource.com/resources
https://opensource.com/resources


Ans. A  How to Change Font Style in MS Word 

The basic steps to change the font of a text in a document are given below; 

o Select the text you want to modify 

o Select the Home tab and locate the Font group 

o Click the drop-down arrow next to font style box 

o Font style menu appears 

o With a left click select the desired font style 

o If you want to change the font to bold or italic, click the 'B' or 'I' icons on the 

format bar. 

See the image: 

 

Ans . B Font size and display size 

You can change your font size and display size to make your screen easier to see. 

Important: Some of these steps work only on Android 7.0 and up. Learn how to check your 

Android version. 

Change font size 

To make your font size smaller or larger: 

1. Open your device's Settings app  

2. Tap Accessibility, then tap Font size 

3. Use the slider to choose your font size 

The font size setting doesn't apply to the Google Chrome app, which has its own text scaling 

control. 

https://support.google.com/android/answer/7680439
https://support.google.com/android/answer/7680439


Change display size 

To make items on your screen smaller or larger: 

1. Open your device's Settings app  

2. Tap Accessibility, then tap Display size 

3. Use the slider to choose your display size 

Some apps on your screen might change position. 

Ans .c Change the default text color (font 
color) in Word 

1. Open the template or a document based on the 

template whose default settings you want to change. 

2. Go to Home and select the Font dialog launcher  . 

3. Select the arrow next to Font color, and then choose 

a color. 

 

4. Select Set As Default and then select one of the 

following: 

 This document only? 

 All document based on the Normal.dotm 

template? 



 

D . How do I change the font color, size, 
style, or type in Word? 
Updated: 12/31/2020 by Computer Hope 

 

In Microsoft Word, you can change the 
properties of any text, including font type, 

size, color, and make it bold, italic, 

or underlined (font style). The following 
illustration shows the formatting bar, and a 

description of the tools it contains. 

 

The font settings placement changed after 

Word 2003, with all the settings placed in 

the Font section on 

the Ribbon's Home tab. An example of the 

font settings in Word 2016 is pictured 

below. 

https://www.computerhope.com/jargon/m/microsoft-word.htm
https://www.computerhope.com/jargon/b/bold.htm
https://www.computerhope.com/jargon/i/italic.htm
https://www.computerhope.com/jargon/u/underlin.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


 

Select a link below to learn how to change 

font color, size, style, or type in Microsoft 

Word. 

 Changing font color. 

 Changing font size. 

 Changing font style. 

 Changing font type. 

Changing font color 
To change the font color in a Microsoft 

Word document, follow the steps below. 

1. Highlight the text you want to change. 

2. Click the down arrow next to the color 
icon on the formatting bar or Ribbon. It is 
usually displayed as the letter "A" with a 

red underline. 

 

3. After clicking the down arrow, select a 

color for the text. 

https://www.computerhope.com/issues/ch000829.htm#fontcolor
https://www.computerhope.com/issues/ch000829.htm#fontsize
https://www.computerhope.com/issues/ch000829.htm#fontstyle
https://www.computerhope.com/issues/ch000829.htm#fonttype
https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


Changing font size 
To change the font size in a Microsoft 

Word document, follow the steps below. 

1. Highlight the text you want to change. 

2. Click the down arrow next to the size box 
on the formatting bar or Ribbon. The 

default font size is usually 11 or 12. 

 

3. After clicking the down arrow for the size, 

you'll see a list of predesignated sizes to 
select. Some fonts do not scale properly, 

so they may have limited size options. 

Changing font style 
To change the font style, including bold, 

italic, and underline, in a Microsoft Word 

document, follow the steps below. 

1. Highlight the text you want to change. 

2. Click the B, I, or U option on 
the formatting bar or Ribbon to change 

the text to bold, italic, or underlined. 

 

https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


3. After clicking the B, I, or U option, the 

text changes to the selected font style. 

Changing font type 
To change the font type in a Microsoft 

Word document, follow the steps below. 

1. Highlight the text you want to change. 

2. Click the down arrow next to the font field 
on the formatting bar or Ribbon. (If you 

want to change the font to bold, italic, or 
underlined, click the B, I, or U on the 

format bar.) 

 

3. After clicking the down arrow for the font, 
you can select from each of the installed 

fonts on your computer. Click the font you 
want to use, and the highlighted text I 
used sockets to connect two Android tablets as a 

network over wifi using the same router. one is a 

server and the other is a client. 

the problems is that every time I want to connect the client and server tablets, I have to type in the 
server tablet's IP address in the client tablet. Is there a way to avoid this? 

I have not figured out how to send the server IP address to the client tablet before they are 
networked. 

I wish there was a way to network the two tablets without having to know the IP address of the 

server tablet. 

One idea is to have the server tablet connect to a website written in php and have the website get 

the IP address and store it in a database. next i would have the client tablet get the IP address 

from that website. Then the client tablet having the server's IP will be abble to make the 

connection. All of this will avoid the user having to know the IP and typing it in every time they 
want to connect. 

https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


Q7. Chapter 1. Creating, Opening, 
and Saving Documents 

Every Word project you create—whether it’s a personal letter, a TV 

sitcom script, or a thesis in microbiology—begins and ends the 

same way. You start by creating a document, and you end by 

saving your work. Sounds simple, but to manage your Word 

documents effectively, you need to know these basics and beyond. 

This chapter shows you all the different ways to create a new Word 

document—like starting from an existing document or adding text to 

a predesigned template—and how to choose the best one for your 

particular project. 

You’ll also learn how to work faster and smarter by changing your 

view of your document. If you want, you can use Word’s Outline 

view when you’re brainstorming, and then switch to Print view when 

you’re ready for hard copy. This chapter gets you up and running 

with these fundamental tools so you can focus on the important 

stuff—your words. 

TIP 

If you’ve used Word before, then you’re probably familiar with opening and saving 

documents. Still, you may want to skim this chapter to catch up on the differences 

between this version of Word and the ghosts of Word past. You’ll grasp some of the big 

changes just by examining the figures. For more detail, check out the gray boxes and 

the notes and tips—like this one! 

Launching Word 

The first time you launch Word after installation, the program asks 

you to confirm your name and initials. This isn’t Microsoft’s 

nefarious plan to pin you down: Word uses this information to 

identify documents that you create and modify. Word uses your 



initials to mark your edits when you review and add comments to 

Word documents that other people send to you (Section 16.3). 

You have three primary ways to fire up Word, so use whichever 

method you find quickest: 

 Start menu. The Start button in the lower-left corner of your 

screen gives you access to all programs on your PC—Word 

included. To start Word, choose Start → All Programs → Microsoft 

Office → Microsoft Office Word. 

 Quick Launch toolbar. The Quick Launch toolbar at the 

bottom of your screen (just to the right of the Start menu) is a great 

place to start programs you use frequently. Microsoft modestly 

assumes that you’ll be using Word a lot, so it usually installs the 

Word icon in the Quick Launch toolbar. To start using Word, just 

click the W icon, and voilá! 

TIP 

When you don’t see the Quick Launch toolbar, here’s how to display it: On the bar at the 

bottom of your screen, right-click an empty spot. From the menu that pops up, choose 

Toolbars → Quick Launch. When you’re done, icons for some of your programs appear 

in the bottom bar. A single click fires up the program. 

 Opening a Word document. Once you’ve created some 

Word documents, this method is fastest of all, since you don’t have 

to start Word as a separate step. Just open an existing Word 

document, and Word starts itself. Try going to Start → My Recent 

Documents, and then, from the list of files, choose a Word 

document. You can also double-click the document’s icon on the 

desktop or wherever it lives on your PC. 

TIP 

If you need to get familiar with the Start menu, Quick Launch toolbar, and other Windows 

features, then pick up a copy of Windows XP: The Missing Manual, Second Edition 

or Windows Vista: The Missing Manual. 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch16.html#word2007tmm-CHP-16-SECT-3


So, what happens once you’ve got Word’s motor running? If you’re 

a newcomer, you’re probably just staring with curiosity. If you’re 

familiar with previous versions of Word, though, you may be doing a 

double take (Figure 1-1). In Word 2007, Microsoft combined all the 

old menus and toolbars into a new feature called the ribbon. Click 

one of the tabs above the ribbon, and you see the command 

buttons change below. The ribbon commands are organized into 

groups, with the name of each group listed at the bottom. 

(See Figure 1-1 for more detail on the ribbon.) 

Creating a New Document 

When you start Word without opening an existing document, the 

program gives you an empty one to work in. If you’re eager to put 

words to page, then type away. Sooner or later, though, you’ll want 

to start another new document. Word gives you three ways to do so: 

 

Figure 1-1. When you start Word 2007 for the first time, it may look a 

little top-heavy. The ribbon takes up more real estate than the old menus 

and toolbars. This change may not matter if you have a nice big monitor. 

But if you want to reclaim some of that space, you can hide the ribbon by 

double-clicking the active tab. Later, when you need to see the ribbon 

commands, just click a tab. 

 Creating a new blank document. When you’re preparing a 

simple document—like a two-page essay, a note for the babysitter, 

or a press release—a plain, unadorned page is fine. Or, when 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-1
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-1


you’re just brainstorming and you’re not sure what you want the 

final document to look like, you probably want to start with a blank 

slate or use one of Word’s templates (more on that in a moment) to 

provide structure for your text. 

 Creating a document from an existing document. For 

letters, resumes, and other documents that require more formatting, 

why reinvent the wheel? You can save time by using an existing 

document as a starting point (Section 1.2.2). When you have a 

letter format that you like, you can use it over and over by editing 

the contents. 

 Creating a document from a template (Section 1.2.3). Use 

a template when you need a professional design for a complex 

document, like a newsletter, a contract, or meeting 

minutes. Templates are a lot like forms—the margins, formatting, 

and graphics are already in place. All you do is fill in your text. 

TIP 

Microsoft provides a mind-boggling number of templates with Word, but they’re not the 

only source. You can find loads more on the Internet, as described in Section 5.2.1. Your 

employer may even provide official templates for company documents. 

To start your document in any of the above ways, click the Windows 

logo in the upper-left corner of the screen. That’s Office 2007’s 

new Office button. Click it, and a drop-down menu opens, revealing 

commands for creating, opening, and saving documents. Next to 

these commands, you see a list of your Word documents. This list 

includes documents that are open, as well as those that you’ve 

recently opened. 

The Office button is also where you go to print and email 

your documents (Figure 1-2). 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-SECT-2.2
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-SECT-2.3
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch05.html#word2007tmm-CHP-5-SECT-2.1
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-2


 

Figure 1-2. The phrase most frequently uttered by experienced Word fans 

the first time they start Word 2007 is, “Okay, where’s my File menu?” 

Never fear, the equivalent of the File menu is still there—it’s just 

camouflaged a bit. Clicking the Office button (the one that looks like a 

Windows logo) reveals the commands you use to create, open, and save 

Word documents. 

Creating a New Blank Document 

Say you want a new blank document, just like the one Word shows you 

when you start the program. No problem—here are the steps: 

1. Choose Office button → New. 

The New Document dialog box appears. 

2. In the upper-left corner of the large “Create a new Word 

document” panel, click “Blank document” (Figure 1-3). 

The New Document box presents a seemingly endless number of 

options, but don’t panic. The ―Blank document‖ option you want is 

on the left side of the first line. 

3. At the bottom of the New Document dialog box, click 

Create. 

The dialog box disappears, and you’re gazing at the blank page of a 

new Word document. 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-3


Better get to work. 

 

Figure 1-3. Open the New Document box (Office button → New, or Alt+F, 

N), and Word gives you several ways to create a new document. Click 

“Blank document” to open an empty document, similar to the one Word 

shows when you first start the program. Or you can click “New from 

existing” to open a document that you previously created under a new 

name. 

Creating a New Document from an Existing Document 

A blank Word document is sort of like a shapeless lump of clay. With 

some work, you can mold it to become just about anything. Often, 

however, you can save time by opening an existing document that’s 

similar to the one you want to create. Imagine that you write the minutes 

for the monthly meetings of the Chief Executive Officer’s Surfing 

Association (CEOSA). When it’s time to write up the June minutes, it’s a 

lot faster to open the minutes from May. You keep the boilerplate text and 

all the formatting, but you delete the text that’s specific to the previous 

month. Now all you have to do is enter the text for June and save the 

document with a new name: JuneMinutes.docx. 

Word gives you a ―New from existing‖ document-creation option to 

satisfy your desire to spend more time surfing and less time writing 

meeting minutes. Here’s how to create a new document from an existing 

document: 



1. Choose Office button → New (Alt+F, N) to open the New 

Document window. Then click “New from existing…” (it sits 

directly below the “Blank document” button). 

The three dots at the end of the button’s title tell you that there’s 

another dialog box to come. And sure enough, when you click ―New 

from existing…‖, it opens another box, appropriately titled New from 

Existing Document (Figure 1-4). This box looks—and works—like a 

standard Windows Open File box. It lets you navigate to a specific 

folder and open a file. 

2. On your computer, find the existing document you’re 

using for a model. 

You can use the bar on the left to change the folder view. Word 

starts you in your My Documents folder, but you can switch to your 

desktop or your My Computer icon by clicking the icons on the left. 

Double-click folder icons in the large window to open them and see 

their contents. 

3. Click to select the file, and then click Create New (in the 

lower-right corner). (Alternatively, just double-click the file’s 

icon to open it. This trick works in all Open File boxes.) 

Instead of the usual Open button at the bottom of the box, the 

button in the New from Existing Document box reads Create New—

your clue that this box behaves differently in one important respect: 

Instead of opening an existing file, you’re making a copy of an 

existing file. Once open, the file’s name is something 

like Document2.docx instead of the original name. This way, when 

you save the file, you don’t overwrite the original document. (Still, 

it’s best to save it with a new descriptive name right away.) 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-4


 

Figure 1-4. Use the New from Existing Document box to find an existing 

Word document that you’d like to open as a model for your new 

document. When you click Create New at bottom-right, Word opens a 

new copy of the document, leaving the original untouched. You can 

modify the copy to your heart’s content and save it under a different file 

name. 

TIP 

Windows’ Open File boxes, like New from Existing Document, let you do a lot more than 

just find files. In fact, they let you do just about anything you can do in Windows 

Explorer. Using keyboard shortcuts, you can cut (Ctrl+X), copy (Ctrl+C), and paste 

(Ctrl+V) files. A right-click displays a shortcut menu with even more commands, letting 

you rename files, view Properties dialog boxes, and much more. You can even drag and 

drop to move files and folders. 

POWER USERS’ CLINIC: WORD’S NEW FILE FORMATS: .DOCX AND 

.DOCM 

With Office 2007, Microsoft took the drastic step of changing its file formats in hopes of 

improving your computer’s security. Malicious programmers were using Office’s macros 

to do nasty things to unsuspecting computers. The .docx format, the new standard for 

Word files, doesn’t permit macros, making it safe from those threats. The .docm format 

indicates that a document contains macros or other bits of programming code. When 



opening one of these files, play it safe: If you don’t know who created the .docm file, then 

don’t open it. 

The downside of the new file formats is that older versions of Word don’t know how to 

open these .docx and .docm documents. To open Word 2007 files with an older version 

(even Word 2003), you need to install the Microsoft Office Compatibility Pack. 

This software fix gives pre-2007 versions of Word the power to open documents in the 

new formats. Even then, you may not be able to use or edit parts of the file that use new 

Word features (like themes, equations, and content controls). To download the free 

compatibility pack, go to www.office.microsoft.com and type office 2007 compatibility into 

the search box at the top of the page. 

Also, if you’re preparing a Word document for someone who’s using an older Word 

version, then you have to save it in a compatible format, as described in the tip 

in Section 1.2.2. (Fortunately, the compatibility issue doesn’t go both ways: Word 2007 

can open old .doc docs just fine.) 

Creating a New Document from a Template 

Say you’re creating meeting minutes for the first time. You don’t have an 

existing document to give you a leg up, but you do want to end up with 

handsome, properly formatted minutes. Word is at your service—

with templates. Microsoft provides dozens upon dozens of 

prebuilt templates for everything from newsletters to postcards. Remember 

all the busy stuff in the New Document box in Figure 1-3? About 90 

percent of the items in there are templates. 

In the previous example, where you use an existing document to create the 

meeting minutes for the Chief Executive Officer’s Surfing Association 

(CEOSA), each month you open the minutes from the previous month. 

You delete the information that pertains to the previous month and enter 

the current month’s minutes. A template works pretty much the same way, 

except it’s a generic document, designed to be adaptable to lots of different 

situations. You just open it and add your text. The structure, formatting, 

graphics, colors, and other doodads are already in place. 

http://www.office.microsoft.com/
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-SECT-2.2
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-3


1. Choose Office button → New (Alt+F, N) to open the New 

Document window. 

On the left of the New Document box is a Template Categories list. 

The top entry on this list is Installed Templates—the ones Word has 

installed on your computer. 

You could use any of these, but you also have a world of choice 

waiting for you online. On its Web site, Microsoft offers hundreds 

of templates for all sorts of documents, and you can access them 

right from the New Document box. If you have a fast Internet 

connection, then it’s just as quick and easy to use an online 

template as it is using the ones stored on your computer. In fact, 

you’ll use an online template for this example. 

2. Scroll down the Template Categories list to the Microsoft 

Office Online heading. Under this heading, select Minutes. 

In the center pane, you’ll see all different types of minutes 

templates, from PTA minutes to Annual shareholder’s meeting 

minutes (Figure 1-5). When you click a template’s icon, a preview 

appears in the pane on the right. 

 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-5


Figure 1-5. The New Document box lists prebuilt templates that live at 

Microsoft Office Online in categories like Agendas, Brochures, Calendars, 

and Minutes. Below the thumbnail you see an estimate of how long it 

takes to download the template from the Microsoft Office Online Web 

site. A rating, from 0 to 5 stars, tells you what other people think of the 

template (the rating system is kind of like the one at Amazon.com). 

3. When you’re done perusing the various styles, click the 

Formal Meeting Minutes icon. (After all, CEOSA is a very 

formal organization.) Then click Download. 

Word downloads and opens the document. 

4. Start writing up the minutes for the CEO Surfers. 

To follow the template’s structure, replace all the words in square 

brackets ([ ]) with text relevant to CEOSA. 

TIP 

If you’d rather not download the Formal Meeting Minutes template every time you use it, 

then you can save the file on your computer as a Word template. The steps for saving 

files are just around the corner in Section 1.5. 

Opening an Existing Document 

If you’ve mastered creating a document from an existing document 

and creating a document from a template, you’ll find that opening 

an existing document is a snap. The steps are nearly identical. 

1. Choose Office button → Open (Alt+F, O). In the Open 

window (Figure 1-6), navigate to the folder and file you want to 

open. 

The Open window starts out showing your My Documents folder, 

since that’s where Word suggests you save your files. When your 

document’s in a more exotic location, click the My Computer icon, 

and then navigate to the proper folder from there. 
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2. With the file selected, click Open in the lower-right corner. 

The Open box goes away and your document opens in Word. 

You’re all set to get to work. Just remember, when you save this 

document (Alt+F, S or Ctrl+S), you write over the previous file. 

Essentially, you create a new, improved, and only copy of the file 

you just opened. If you don’t want to write over the existing 

document, use the Save As command (Alt+F, A), and then type a 

new name in the File Name text box. 

 

Figure 1-6. This Open dialog box shows the contents of the tale of two 

cities folder, according to the “Look in” box at the top. The file tale of two 

cities. docx is selected, as you can see in the “File name box” at the 

bottom of the window. By clicking Open, Mr. Dickens is ready to go to 

work. 

TIP 

Opening a file in Word doesn’t mean you’re limited to documents created in Word. You 

can choose documents created in other programs from the Files of Type drop-down 

menu at the bottom of the Open dialog box. Word then shows you that type of document 

in the main part of the window. You can open Outlook messages (.msg), Web pages 

(.htm or .html), or files from other word processors (.rtf, .mcw, .wps). 

Your Different Document Views 

Now that you know a handful of ways to create and open Word 

documents, it’s time to take a look around the establishment. You 

may think a document’s a document—just look at it straight on and 



get your work done. It’s surprising, though, how changing your view 

of the page can help you work faster and smarter. When you’re 

working with a very long document, you can change to Outline view 

and peruse just your document’s headlines without the paragraph 

text. In Outline view, you get a better feeling for the manuscript as a 

whole. Likewise, when you’re working on a document that’s headed 

for the Web, it makes sense to view the page as it will appear in a 

browser. Other times, you may want to have two documents open 

on your screen at once (or on each of your two monitors, you lucky 

dog), to make it easy to cut and paste text from one to the other. 

The key to working with Word’s different view options is to match 

the view to the job at hand. Once you get used to switching views, 

you’ll find lots of reasons to change your point of view. Find the 

tools you need on the View tab (Figure 1-7). To get there, click the 

View tab (Alt+W) on the ribbon (near the top of Word’s window). 

The tab divides the view commands into four groups: 

 Document Views. These commands change the big picture. 

For the most part, use these when you want to view a document in 

a dramatically different way: two pages side by side, Outline view, 

Web layout view, and so on. 

 Show/Hide. The Show/Hide commands display and conceal 

Word tools like rulers and gridlines. These tools don’t show when 

you print your document; they’re just visual aids that help you when 

you’re working in Word. 

 Zoom. As you can guess, the Zoom tools let you choose 

between a close-up and a long shot of your document. Getting in 

close makes your words easier to read and helps prevent eyestrain. 

But zooming out makes scrolling faster and helps you keep your 

eye on the big picture. 

TIP 

In addition to the Zoom tools on the ribbon, handy Zoom tools are available in the 

window’s lower-right corner. Check out the + (Zoom In) and–(Zoom Out) buttons and the 

slider in between them. See Section 1.4.3 for the details on using them. 
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 Window. In the Window group, you’ll find creative ways to 

organize document windows on your screen—like split views of a 

single document or side-by-side views of two different documents. 

All the commands in the View tab’s four groups are covered in the 

following pages. 

NOTE 

This section provides the short course on viewing your Word documents. For even more 

details and options for customizing your Word environment, see Chapter 17. 

 

Figure 1-7. The View tab is your document-viewing control center. Look 

closely, and you see it’s divided into four groups with names at the 

bottom of the ribbon: Document Views, Show/Hide, Zoom, and Window. 

To apply a view command, just click the button or label. 

Document Views: Five Ways to Look at Your Manuscript 

Word gives you five basic document views. To select a view, go to the 

View tab (Alt+W) and choose one of the Document Views on the left side 

of the ribbon (Figure 1-8). You have another great option for switching 

from one view to another that’s always available in the lower-right corner 

of Word’s window. Click one of the five small buttons to the left of the 

slider to jump between Print Layout, Full Screen Reading, Web Layout, 

Outline, and Draft views. Each view has a special purpose, and you can 

modify them even more using the other commands on the View tab. 
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Figure 1-8. On the left side of the View tab, you find the five basic 

document views: Print Layout, Full Screen Reading, Web Layout, Outline, 

and Draft. You can edit your document in any of the views, although they 

come with different tools for different purposes. For example, Outline 

view provides a menu that lets you show or hide headings at different 

outline levels. 

 Print Layout (Alt+W, P). The most frequently used view in 

Word, Print Layout, is the one you see when you first start the 

program or create a new blank document. In this view, the page you 

see on your computer screen looks much as it does when you print 

it. This view’s handy for letters, reports, and most documents 

headed for the printer. 

 Full Screen Reading (Alt+W, F). If you’d like to get rid of the 

clutter of menus, ribbons, and all the rest of the word-processing 

gadgetry, then use Full Screen Reading view. As the name implies, 

this view’s designed primarily for reading documents. It includes 

options you don’t find in the other views, like a command that 

temporarily decreases or increases the text size. In the upper-right 

corner you see some document-proofing tools (like a text highlighter 

and an insert comment command), but when you want to change or 

edit your document, you must first use the View Options → Allow 

Typing command. For more details on using Word for reviewing and 

proofing, see Chapter 16. 

 Web Layout (Alt+W, L). This view shows your document as if 

it were a single Web page loaded in a browser. You don’t see any 

page breaks in this view. Along with your text, you see any photos 
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or videos that you’ve placed in the document—just like a Web 

page. Section 13.2 has more details on creating Web pages with 

Word. 

 Outline (Alt+W, U). For lots of writers, an outline is the first 

step in creating a manuscript. Once they’ve created a framework of 

chapters and headings, they dive in and fill out the document with 

text. If you like to work this way, then you’ll love Outline view. It’s 

easy to jump back and forth between Outline view and Print Layout 

view or Draft view, so you can bounce back and forth between a 

macro and a micro view of your epic. (For more details on using 

Word’s Outline view, see Section 8.1.) 

 Draft (Alt+W, V). Here’s the no-nonsense, roll-up-your-

sleeves view of your work (Figure 1-9). You see most formatting as 

it appears on the printed page, except for headers and footers. 

Page breaks are indicated by a thin dotted line. In this view, it’s as if 

your document is on one single roll of paper that scrolls through 

your computer screen. This view’s a good choice for 

longer documents and those moments when you want to focus on 

the words without being distracted by page breaks and other 

formatting niceties. 

Show and Hide Window Tools 

Word gives you some visual aids that make it easier to work with your 

documents. Tools like rulers and gridlines don’t show up when you print 

your document, but they help you line up the elements on the page. Use 

the ruler to set page margins and to create tabs for your documents. 

Checkboxes on the View tab let you show or hide tools, but some tools 

aren’t available in all the views, so they’re grayed out. You can’t, for 

example, display page rulers in Outline or Full Screen Reading views. 

Use the checkboxes in the Show/Hide group of the View tab (Figure 1-10) 

to turn these tools on and off: 
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 Ruler. Use the ruler to adjust margins, set tabs, and position 

items on your page. For more detail on formatting text and 

paragraphs, see Chapter 4. 

 Gridlines. When you click the Gridlines box, it looks like you 

created your document on a piece of graph paper. This effect isn’t 

too helpful for an all-text document, but it sure comes in handy if 

you’re trying to line up photos on a page. 

 

Figure 1-9. In Draft view, you see most text and paragraph formatting, but 

headers, footers, and other distracting page formatting features are 

hidden. Your text appears as a continuous scroll, with the margins hidden. 

Page breaks appear as dotted lines. 

 Message Bar. The Message Bar resides directly under the 

ribbon, and it’s where you see alerts about a document’s behavior. 

For example, when a document is trying to run a macro and your 

Word settings prohibit macros, an alert appears in the Message 

Bar. Click the checkbox to show or hide the Message Bar. 

 Document Map. If you work with long documents, you’ll like 

the Document Map. This useful tool appears to the left of your text 

(you can see it in Figure 1-10), showing the document’s headings at 

various levels. Click the little + and–buttons next to a heading to 

expand or collapse the outline. Click a heading, and you jump to 

that location in your document. 
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 Thumbnails. Select the Thumbnails option, and you see little 

icons of your document’s pages in the bar on the left. Click a 

thumbnail to go to that page. In general, thumbnails are more useful 

for shorter documents and for pages that are visually distinctive. For 

longer documents, you’ll find the Document Map easier to use for 

navigation. 

Zooming Your View In and Out 

When you’re working, do you ever find that you sometimes hold pages at 

arm’s length to get a complete view, and then, at other times, you stick 

your nose close to the page to examine the details? Word’s Zoom options 

(Figure 1-11) let you do the same thing with your screen—but without 

looking nearly as silly. 

 

Figure 1-10. Use the Show/Hide group on the View tab to display or 

conceal Word tools. The Ruler gives you a quick and easy way to set tabs 

and margins. The Document Map is particularly helpful when you work 

with longer documents because it displays headings in the bar on the left 

of the screen. In the left pane, you can see that Mr. Dickens wrote more 

than his fair share of chapters. 
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Figure 1-11. The Zoom group of options lets you view your document close 

up or at a distance. The big magnifying glass opens the Zoom dialog box 

with more controls for fine-tuning your zoom level. For quick changes, 

click one of the three buttons on the right: One Page, Two Pages, or Page 

Width. 

 

Figure 1-12. The Zoom dialog box lets you choose from a variety of views. 

Just click one of the option buttons, and then click OK. The monitor and 

text sample at the bottom of the Zoom box provide visual clues as you 

change the settings. 

Zooming by percentage 

In the box’s upper-left corner, you find controls to zoom in and out of your 

document by percentage. The view varies depending on your computer 

screen and settings, but in general, 100% is a respectable, middle-of-the-

road view of your document. The higher the percentage, the more zoomed 

in you are, and the bigger everything looks—vice versa with a lower 

percentage. 



The three radio buttons (200%, 100%, and 75%) give you quick access to 

some standard settings. For in-between percentages (like 145%), type a 

number in the box below the buttons, or use the up-down arrows to change 

the value. For a quick way to zoom in and out without opening a dialog 

box, use the Zoom slider (Figure 1-13) in the lower-right corner of your 

window. Drag the slider to the right to zoom in on your document, and 

drag it to the left to zoom out. The percentage changes as you drag. 

 

Figure 1-13. The Zoom slider at the bottom of the document window gives 

you a quick and easy way to change your perspective. Drag the slider to 

the right to zoom in on your document, and drag it to the left to zoom out. 

To the left of the slider are five View buttons: Print Layout, Full Screen 

Reading, Web Layout, Outline, and Draft (Section 1.4.2). Since the first 

button is selected, this document is in Print Layout view. 

Zooming relative to page or text 

Not everyone’s a number person. (That’s especially true of writers.) So 

you may prefer to zoom without worrying about percentage figures. The 

Zoom dialog box (on the View tab, click the magnifying-glass icon) gives 

you four radio buttons with plain-English zoom settings: 

Page width. Click this button, and the page resizes to fill the screen from 

one side to the other. It’s the fastest way to zoom to a text size that most 

people find comfortable to read. (You may have to scroll, though, to read 

the page from top to bottom.) 
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Text width. This button zooms in even farther, because it ignores the 

margins of your page. Use this one if you have a high-resolution monitor 

(or you’ve misplaced your reading glasses). 

Whole page. When you want to see an entire page from top to bottom and 

left to right, click this button. It’s great for getting an overview of how 

your headings and paragraphs look on the page. 

Many pages. This view is the equivalent of spreading your document out 

on the floor, and then viewing it from the top of a ladder. You can use it to 

see how close you are to finishing that five-page paper, or to inspect the 

layout of a multi-page newsletter. 

The ribbon offers radio buttons for three popular page views. (You can see 

them back in Figure 1-11, to the Zoom tool’s right.) They’re a quick and 

dirty way to change the number of pages you see onscreen without 

fiddling with zoom controls. 

 One Page. This view shows the entire page in Word’s 

document window. If your screen is large enough, you can read and 

edit text in this view. 

 Two Pages. In this view, you see two pages side by side. This 

view’s handy when you’re working with documents that have two-

page spreads, like booklets. 

 Page Width. This button does the exact same thing as 

the Page Width button in the Zoom dialog box (Section 1.4.3). It’s 

more readable than the One Page and Two Page options, because 

the page fills the screen from edge to edge, making the text appear 

larger. 

The Window Group: Doing the Splits 

Back when dinosaurs roamed the earth and people used typewriters (or 

very early word processors), you could work on only one document at a 

time—the one right in front of you. Although Word 2007 has more options 

for viewing multiple documents and multiple windows than ever, some 

folks forget to use them. Big mistake. If you ever find yourself comparing 
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two documents or borrowing extensively from some other text, then 

having two or more documents visible on your screen can double or triple 

your work speed. 

The commands for managing multiple documents, views, and windows are 

in the View tab’s Window group (Figure 1-14). 

 

Figure 1-14. In the Window group, the three commands on the left—New 

Window, Arrange All, and Split—let you open and view your work from 

multiple vantage points. The commands in the middle—View Side by Side, 

Synchronous Scrolling, and Reset Window Position—are helpful when 

reviewing and comparing documents. The big Switch Windows button lets 

you hop from one document to another. 

 New Window (Alt+W, N). When you’re working on a long 

document, sometimes you want to see two different parts of the 

document at the same time, as if they were two separate 

documents. You may want to keep referring to what you said in the 

Introduction while you’re working in Chapter 5. Or perhaps you want 

to keep an Outline view open while editing in Draft view. That’s 

where the New Window command comes in. When you click this 

button (or hit this keystroke), you’ve got your document open in two 

windows that you can scroll independently. Make a change to one 

window, and it immediately appears in the other. 
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 Arrange All (Alt+W, A). Great—now you’ve got documents 

open in two or more windows, but it takes a heck of a lot of mousing 

around and window resizing to get them lined up on your screen at 

the same time. Click Arrange All and, like magic, your open Word 

document windows are sharing the screen, making it easy to work 

on one and then the other. Word takes an egalitarian approach to 

screen real estate, giving all windows an equal amount of property 

(Figure 1-15). 

 Split (Alt+W, S). The Split button divides a single window so 

you can see two different parts of the same document—particularly 

handy if you’re copying text from one part of a document to another. 

The other advantage of the Split command is that it gives you more 

room to work than using Arrange All for multiple windows because it 

doesn’t duplicate the ribbon, ruler, and other Word tools (Figure 1-

16). 

 

Figure 1-15. One downside of Office 2007’s ribbon: It takes up more space 

on your computer’s screen than menus or even the older button bars. 

When you open a couple of windows, you’re not left with much space to 

do your work, especially when you’re working on an ultra-portable laptop 

or a computer with a small screen. You can double-click the active tab to 

hide the ribbon, but in most cases, you’re better off working with a split 

screen, as shown in Figure 1-16. 
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Figure 1-16. When you’re viewing two different parts of a single 

document, use the Split command; it leaves you more room to work than 

two separate windows, as shown in Figure 1-15. Each section of the split 

window has a scroll bar, so you can independently control different parts 

of your document. If you want to fine-tune your split, just drag the middle 

bar exactly where you want it. When you’re done, click Remove Split to 

return to a single screen view. 

Viewing multiple windows 

One common reason for wanting to see two documents or more on your 

screen at once is so you can make line-by-line comparisons. Imagine you 

have two Word documents that are almost identical, but you have to find 

the spots where there are differences. A great way to make those 

differences jump out is to put both versions on your screen side by side 

and scroll through them. As you scroll, you can see differences in the 

paragraph lengths and the line lengths. Here are the commands to help you 

with the process: 

 View Side by Side (Alt+W, B). Click the View Side by Side 

command and Word arranges two windows vertically side by side. 

As you work with side-by-side documents, you can rearrange 

windows on your screen by dragging the very top of the Window 

frame. You can resize the windows by pointing to any edge of the 

frame. When you see a double arrow, just drag to resize the 

window. Synchronous Scrolling (described next) is automatically 

turned on. 

 Synchronous Scrolling (Alt+W, Y). The Synchronous 

Scrolling feature keeps multiple document windows in lock step. 

When you scroll one window, the other windows automatically scroll 

too. Using the same button or keystroke, you can toggle 

Synchronous Scrolling on and off as you work with your documents. 

 Reset Windows Position (Alt+W, T). If you’ve moved or 

resized your document windows as described earlier under View 

Side by Side, then you can click this button to reset your view so 

the windows share the screen equally. 
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Saving and Closing Documents 

From the earliest days of personal computing, the watchword has 

been ―save early, save often.‖ There’s nothing more frustrating than 

working half the day and then having the Great American Novel 

evaporate into the digital ether because your power goes out. So, 

here are some tips to protect your work from disasters human-made 

and natural: 

 Name and save your document shortly after you first create it. 

You’ll see the steps to do so later in this section. 

 Get in the habit of doing a quick save with Alt+F, S 

(think File Save) when you pause to think or get up to go to the 

kitchen for a snack. (Note for old-timers: Ctrl+S still works for a 

quick save too.) 

 If you’re leaving your computer for an extended period of time, 

save and close your document with Alt+F, C (think File Close). 

UP TO SPEED: WHERE ARE MY KEYBOARD SHORTCUTS? 

Ribbons, buttons, and menus are all well and good when you’re doing something new or 

complicated. But when you know where you’re going, a good keyboard shortcut can 

save time. Word 2007 has dozens of keyboard shortcuts. If you don’t have your favorites 

memorized, use the Alt key to reveal them. 

Press the Alt key, and you see small badges with letters and numbers pop up next to 

menus and buttons. These are your shortcuts. If you’re looking for the keyboard shortcut 

to close your document, follow these steps: 

1. Press and release the Alt key to show the keyboard shortcut badges. 

When you do this, the badges appear over menu items and ribbon buttons. (The Alt 

key acts as a toggle. If you change your mind and don’t want to use a shortcut, then 

press the Alt key again and you’re back in normal typing mode.) 

2. Press F to open the Office menu. 



Pressing F (which used to stand for File menu) does the same thing as clicking the 

button with your mouse, except that now it sports little keyboard shortcut badges. 

3. Press C to close your document. 

Looking at the bottom of the Office menu, you see the Close command. A small C 

badge indicates that pressing C closes your document. 

As you can guess, most keyboard shortcuts are based on the initial letter of the actual 

command words. This doesn’t always work out for popular letters. As a result, you have 

cases like the References tab, which has the keyboard shortcut S. 

Even if you don’t deliberately work to memorize the keyboard shortcuts, you’ll find that 

you begin to learn your favorites as you use them. Before long, your fingers will tap them 

out automatically. 

If a substantial portion of your brain is occupied by keyboard shortcuts from previous 

versions of Word, never fear. Most of those old commands still work—including Ctrl+B 

for Bold, Ctrl+N for new document, and F7 for spell checking. 

The Many Ways to Save Documents 

It’s the Microsoft Way to give you multiple ways to do most everything. 

Whether that’s because the company’s programmers believe in giving you 

lots of choices, or because they can’t make up their minds about the best 

way to do something is a question best left to the philosophers. But the 

point is, you do have a choice. You don’t have to memorize every 

keystroke, button, and command. Especially with saving, the important 

thing is to find a way you like and stick with it. Here’s a list of some ways 

you can save the document you’re working on: 

Saving by keyboard shortcut 

 Ctrl+S. If you’re an old hand at Word, this keyboard shortcut 

may already be burned in your brain. It still works with Word and 

other Office programs. This command quickly saves the document 

and lets you get back to work. 



 Alt+F, S. This keyboard shortcut does the exact same thing 

as Ctrl+S. Unlike Ctrl+S, though, you get visual reminders of which 

keys to press when you press the Alt key. See the box above. 

Saving by menu command 

 Office button → Save. If you don’t want to use keyboard 

shortcuts, you can mouse your way to the same place using menus. 

Like the options above, this command saves your file with its 

current name. 

 Office button → Save As. The Save As option lets you save 

your file with a new name (Figure 1-17). When you use this 

command, you create a new document with a new name that 

includes any changes you’ve made. (The individual steps are 

described in the next section.) 

 

Figure 1-17. Use Office button → Save As to save your file with a new 

name or in a different file format. In this example, the Word file tale of 

two cities is being saved as an HTML type file—a format used for Web 

pages. 

 Office button → Close. When you close a document, Word 

checks to see if you’ve made any changes to the file. When you’ve 

made changes, Word always asks whether you’d like to save the 

document (Figure 1-18). 

 

Figure 1-18. When you see this message box, you have three choices: Yes 

saves your document before closing it; No closes your document without 

saving it; Cancel leaves your document open without saving it. 
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Saving with a new name 

When you save a new document or save a document with a new name 

(Save As), you’ve got three things to consider: a filename, a file location, 

and a file format. 

POWER USERS’ CLINIC: PREVENTING AND RECOVERING FROM 

DISASTER 

Lightning strikes. Children trip over power cords. Computers crash. Saving your work 

frequently and keeping backup copies of your documents are important safeguards. You 

can have Word save backup copies every time you save a document, so you always 

have the last two versions of your work stored on your computer. Word 

doesn’t automatically save backup copies of your files, but it’s easy enough to change 

this setting. Click the Office button, and then click Word Options at the bottom of the box. 

After the Word Options dialog box opens, scroll down to the Save group, and turn on the 

―Always create backup copy‖ checkbox. Choose Office button → Open to find and open 

your backup file (Figure 1-19). 

When disaster strikes in spite of your meticulous preventive measures, Word can help 

too. Word’s new file formats have been designed to be easier to recover and repair. In 

many cases, if a picture or a table is corrupted in the file, you can still retrieve everything 

else (Figure 1-20). 

 

Figure 1-19. To open a backup file, choose All Files (*.*) in the “Files of 

type” drop-down menu at the bottom of the Open dialog box. Look for a 

file that begins with the words “Backup of.” Double-click to open the file. 

Here are the steps for saving a file, complete with a new name: 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-19
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1. Choose Office button → Save As to open the Save As 

box. 

You use the Save As command when you’re saving a file with a 

new name. Word also displays the Save As box the first time you 

save a new document. 

2. Use the “Save in” drop-down list or double-click to open 

folders in the window to find a location to store your file. 

The buttons in the upper-right corner can also help you navigate. 

See the details in Figure 1-21. Word doesn’t care where you save 

your files, so you can choose your desktop or any folder on your 

computer. 

 

Figure 1-20. When you can’t open a file with a normal Open command, 

click the arrow to the right of the Open button, and choose Open and 

Repair from the drop-down menu. Some parts of your file may still be 

damaged, but you can usually recover most of your work. 

. 

3. At the bottom of the Save As dialog box, type a name in 

the File name box. 

Word accepts long names, so you don’t need to skimp. Use a 

descriptive name that will help you identify the file two weeks or two 

years from now. A good name saves you time in the long run. 

4. Use the “Save as type” box to choose a file type. 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-21


In most cases you don’t need to change the file type. Word 

automatically selects either .docx or .docm depending on the 

contents of your file, but Word can save files in over a dozen 

different formats. If you’re sharing the file with someone who’s using 

an older version of Word, then choose Word 97-2003 Document to 

save the document in .doc format. If you’re sharing with someone 

who uses a Mac or Linux computer, then you may want to use the 

more universal Rich Text Format (.rtf). 

 

Unless you’re sharing your file with someone using an older version 

of Word or a different operating system or making a template, stick 

with the new standard Word file types .docx (for normal Word files) 

and .docm (for files that run macros). See the box in Section 

1.2.3 for a complete rundown. 

5. Click Save. 

Word does the rest. All you need to do is remember where you 

saved your work. 

 

Figure 1-21. The Save As dialog box has all the controls you need to 

navigate to any location on your computer—including five nifty buttons in 

the upper-right corner. From left to right: The left arrow button steps you 

backward through your past locations (just like the back button in a Web 

browser). The up arrow takes you out to the folder enclosing the one 

you’re in now. The X button deletes folders and files—be careful with it. 

Click the folder with the star in the corner to create a new folder. 

UP TO SPEED: UNDERSTANDING WORD FILE TYPES 
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Q8. Create a file in MS-word for the following 

document and save it with file name ‘equations’. 

Describe 

all steps involved in it. 

Ans .  

 

Q9. Create a file in MS-word that convert existing 

highlight text to table as shown below and save it as 

file name ‘text_to_table’. Describe all steps involved in 

it. 

Ans . Creating and numbering equations with 

Microsoft Word 2007 

Microsoft (MS) Word 2007 has a built-in equation editor which is now the default 
when you create equations. The equation editor is only available in Word 2007 and 
not Excel, Powerpoint or other applications. 

Microsoft Equation 3.0, the default equation editor in previous versions, is still 
available and can also be used in Excel, PowerPoint, or any application that supports 
Object Linking and Embedding (OLE). See the course notes on using Microsoft Word 
'97 for the old equation editor for more information. 

Comparison of options for equation editing 

Feature Office 2007 built-in equation 

editor 

Microsoft Equation 3.0 

(old version) 

Ease of use Very intuitive, "builds-up" 

equations as you type 
Not as intuitive, steeper 
learning curve 

Keyboard 

shortcuts 
Standard math and LaTeX 
symbols work 

Custom (e.g., Ctrl-H for 

superscript) 

https://uwaterloo.ca/information-systems-technology/services/scientific-computing-software-support/supported-software-scientific-computing/creating-numbering-and-cross-referencing-equations-microsoft
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Display equations Display equations can't be on the 

same line as other text 

Able to use tabs on same line 

as display equations 

Equation 

numbering 
Need to use tables to create 
equation numbers 

Adding equation 
numbers is simpler 

Rendering Very high quality Moderate quality 

Interoperability Not accepted by some journals, 

no workarounds! 

Commonly used and 

interoperable 

When not to use the Office 2007 equation editor 

When you convert a document that includes Office 2007 equations to the old ".doc" 
format, the equations are turned into graphics. They are visible, but not editable. We 
recommend that you do not use the Office 2007 Equation Editor if: 

 You need to submit to a journal that does not accept Office 2007 .docx files 
 You need to collaborate with people who do not have Office 2007 
 You use Office 2007 in Compatibility Mode (.doc files) 

In these situations, the recipients of your documents will not be able to edit the 
equations. This would make collaboration difficult, and in the case of journals, would 
make submission problematic and revision impossible. 

Why use the Office 2007 equation editor 

Word 2007's method of entering equations from the keyboard and building up 
equations is more natural, intuitive and efficient than earlier approaches to 
typesetting equations. Word's internal representation of the equations resembles 
mathematics, and is much more readable. 

By comparison the MS Equation Editor approach takes a visual rather than 
mathematical approach. A markup language like LaTeX remains the best choice for 
complicated documents and for overall typesetting quality, yet the source code for an 
equation in LaTeX rarely looks like math. 

How Office 2007's equation editor "builds-up" equations 

The new Office 2007 equation editor works in a different way than the old equation 
editor. It uses the AutoCorrect feature of MS Word to do some of the formatting, and 
it introduces a concept of "Linear" vs. "Professional" formats. Linear format is what 
you might use in a programming language to write mathematics: e.g., y = 
(a*x+b)/(x^2+1). 

As you type an equation, Word converts it on the fly (Microsoft calls this "building 
up") into professional format. In order to use the equation editor efficiently, you will 



need to get used to how Word builds up equations. A good way to learn is to carefully 
watch what happens on screen as you push each key. 

Some symbols are inserted automatically by Word as you type using AutoCorrect. 
And some formatting is applied as you type. The rule is that the equation is built up 
when you type any character than makes what you've typed so far unambigious. As a 
result, AutoCorrect and building up are only triggered by certain keys. The spacebar 
always builds up and triggers autocorrect, and using it is a good way to force Word 
2007 to interpret what you've typed so far. 

Learning how to use the equation editor 

To insert an equation in a Word 2007 document, click on the "Insert" menu/tab to 
see the "Insert" ribbon. In the "Symbols" section, choose "Equation". You can also 
press "Alt+=" on your keyboard. 

 

 

You will now see Equation Tools | Design Ribbon. There are three main sections. 

Tools 

 

In the "Tools" section you have access to the "Equation" gallery, and you can select 
"Professional", "Linear" or "Normal Text" modes. Professional format is rendered 
two-dimensional math, as you would write on paper or a blackboard. Linear format 
is the equation editor's internal format. Normal text is for non-mathematical text 
annotations within an equation. 

Professional format:  

Linear format:  



Notice that linear format has redundant brackets to make the mathematical 
interpretation unambiguous. When the equation is formatted, Word automatically 
removes these brackets. The square root symbol is a single character, and its operand 
is the bracketed expression immediately following the square root character. You can 
force Word to show an expression in brackets by using two sets of brackets around 
the expression. 

Symbols 

 

The symbols section contains commonly-used mathematical symbols. You can use 

the two scroll buttons to see more, or click the  icon to view all of the "Basic Math" 
symbols. Then click on "Basic Math" to see other sections of symbols: 

1. Basic math 
2. Greek letters 
3. Letter-like symbols 
4. Operators 
5. Arrows 
6. Negated relations 
7. Scripts 
8. Geometry 

Exercise 

Insert an equation, explore the symbol palettes and find symbols that you will need 
in your manuscripts. 

Structures 

 

The "Structures" section contains the formatting tools you will use to create 
equations. Each section contains 'structures' which are like a template with one or 
more symbols, and one or more placeholders for you to place your mathematical 
content into. 

For example, to create a fraction, choose "Fraction" then the first template. You will 
see a fraction where the numerator and denominator are both boxes with dotted 
lines. You will place your content in the place of these boxes. 



The "Matrix" structures are not only useful for true matrices and arrays, but can also 
be used to align certain types of equations and to place notes in and around 
equations. 

Examples of structures 

The integral menu contains indefinite, definite, double and triple integrals. There 
will be a placeholder for the integrand. Definite integrals also include placeholders 
for the upper and lower limits of integration. 

 

More complicated expressions can be constructed by having structures inside of 
other structures, for example: 

 

The right hand side of the above equations consists of a "Bracket" structure. Inside 
the bracket's placeholder is a 3x2 matrix. In order for this to look right, the matrix 
has been modified for left alignment of the second column, and the word "if" has 
been changed to "Normal text". 

Keyboard entry of equations 

Standard characters that are on your keyboard you will type directly into the 
equation editor. The equation editor also recognizes many conventions for typing 
math: 

Keyboard Result 

^ Superscript 

_ Subscript 

/ Fraction 

() {} [] Standard brackets 

<, > Inequalities 

<=, >= Converted to standard less/greater than or equal to 



In addition, there are a number of symbols that can be entered by typing backslash 
"\" and the name of the character. (These are mainly based on LaTeX codes.) 

Keyboard Description Example 

\alpha \beta \gamma \delta Greek Letters Αβγδ 

\Alpha \Beta \Gamma \Delta Uppercase Greek Letters ΑΒΓΓ 

\pm or +- Plus/Minus symbol ± 

\sqrt(x) \sqrt(n&x) Square root, nth root 
√,  

\le or <= Less than or equal to ≤ 

\sum \prod Sum, product ∑, ∏ 

\int Integration symbol ∫ 

\times Multiplication x 

\ominus \oplus \otimes Operators in circles ⊖⊕⊗ 

\equiv Congruent symbol ≡ 

\approx Approximately equal to ≈ 

\in Element of set ∈ 

As you type, the equation editor converts recognized symbols to the corresponding 
graphical characters. This conversion happens as soon as you've typed enough to 
make the math unambiguous. You can trigger an update by pressing the space bar. 
You can also choose "Professional" format to force the equation editor to render and 
interpret what you've typed so far. 

Putting an equation button on the tool bar 

If you are entering many equations, you may find it convenient to have an "Insert 
Equation" button right on the "Quick Access Toolbar". 

1. Click on the arrow to the right of the "Quick Access Toolbar" 

 

2. Choose "More Commands..." 
3. Under "Choose commands from", select "Insert Tab", choose "Equation" from the list 

and click "Add" 



 

4. Click "OK". 

Moving around the equation 

The cursor indicates where you are about to enter information on the equation. The 
equation editor highlights the region of the formula in which you are working, e.g. 
the placeholder of a bracket, a superscript, a numerator/denominator of a fraction. 
You can set the insertion point by clicking with the mouse, or with the keyboard. You 
can use the left arrow and right arrow keys to move through the equation. For more 
advanced editing, can you change the equation to "Linear Mode", make corrections, 
then switch back to "Professional Mode". 

Exercise 

Enter the equation: 

 

Method 1 

Start the equation editor (Insert | Symbols | Equation or ALT+=) and: 

1. Type "x=" from the keyboard 
2. Choose a fraction from Structures | Fraction 
3. Click on the numerator, type -b from the keyboard 
4. Select "plus or minus" from the Symbols ribbon 
5. Select a radical from Structures | Radical 



6. Click in the placeholder 
7. Type b from the keyboard 
8. Select "b" 
9. Select a superscript from the Script palette 
10. Select the superscript, Type "2" from the keyboard 
11. Press the right arrow to come down a level, and type "-4ac" 
12. Click the denominator (or press the right arrow twice) Type 2a 

Method 2: Keyboard entry 

Tip: You can use extra brackets to show Word how to interpret what you type. 

Type "x=(-b+-\sqrt(b^2-4ac))/2a" 

Notice: 

1. When you type the second "\" Word replaces +- with the plus or minus symbol. You 
could also type \pm. 

2. When you type the second "(" Word replace \sqrt with the square root symbol. 
3. When you type "-4ac" Word turns "^2" into a superscript. 
4. When you type the SECOND ")" Word expands the square root. 
5. Word automatically hides redundant parentheses, we entered these to show Word 

how to format the equation. 
6. Word puts "2a" in the denominator even though this is ambiguous the way we typed 

it. 

Method 3: "Cheating" 

Click on the Equation button, and you will find that the quadratic formula is 
available as a Building Block in the Equation Gallery. You can save your own 
equations to the Equation Gallery so that you will only have to typeset them once. 

Deleting from equations 

As you are entering the equation, you can backspace at any time. You can also select 
parts of the equation with the mouse, and delete. 

Growing brackets 

Brackets, parentheses and braces will automatically grow with the enclosed text. You 
can toggle this behave by right-clicking in the placeholder section of a bracket, and 
choose "Stretch Brackets". 



Exercise: Typeset a continued fraction 

 

(To enter the above continued fraction from the keyboard, you can type: 
"1/(2+3/(4+5/(6+7/(8+9/10))))" then press the spacebar to format the final 
fraction.) 

Matrices 

Matrices of any size can be created from the Matrix section of the Structures ribbon. 
Once you have inserted a Matrix, you will be able to right click on it to add or delete 
columns and rows. You can also change the alignment settings for the rows and 
columns. 

Exercise: Typeset a 4x4 matrix in square brackets 

There is a built-in option for a matrix surrounded by square brackets. It is also 
possible to add the square brackets to an existing matrix. 

 

Exercise: Format the matrix 

Once you've created a matrix, you can right-click inside it to access spacing settings. 
These allow you to adjust the overall positioning of the matrix and the row and 
column spacing. You can also access settings for alignment of rows and columns. 

Aligning at the equal sign character 

When you are typing a derivation, you may want to show a calculation with your 
equals signs lining up. Compare Word's default of centering: 



 

to the more standard view: 

 

Exercise: Typeset a calculation aligned at the equals sign 

1. Create an equation (Insert | Equation) or Alt+= 
2. Type y=(x-1)(x+1)(x^2+1) 
3. Press Shift-Enter (this tells Word to create a new line, but to group it with the current 

equation) 
4. Type y=(x^2-1)(x^2+1) 
5. Press Shift+Enter 
6. Type =(x^4-1) 
7. Your equations are now being centered as a group, but they are aligned on the left 
8. Select the equals sign (=) in each equation, right click and choose "Align at this 

character" 

Aligning a set of equations 

In system of several variables, you may have several equations in the same variables 
and want the coefficients lined up: 

 

At this time, there is no way to create an equation array from the menu interface. You 
would not want to use a matrix for this type of alignment, because it would be 
difficult to get the spacing right. In addition, an equation array automatically aligns 
at the equals signs. Here is how to create an equation array using the keyboard: 

1. Create an equation (Insert | Equation) or ALT+= 
2. Type \eqarray 
3. Type (2&x + &3&y + &&z = &10& @ 
4. Type 4&x + &&y -&&z = &3& @ 
5. Type &x + &10&y+&&z = &25&) 
6. Press spacebar 



How this works 

The \eqarray symbol tells Word that this is an equation array. Everything in the 
brackets that follows it the equation array. A new row is started with @. The & 
symbols are used to line up the equation. The & before a number tells Word to insert 
space at that position if necessary. The & after the number is the alignment point. 
The first, third, fifth, and every odd ampersand is an alignment point. Each even 
ampersand is a spacer where Word can add space to line up the equations. 

Functions 

Properly typeset function names should be in roman text (not italic). Word has a 
built-in list of recognized functions and will make this change automatically for 
these. If you use other function names, you can manually change them to "Normal 
text" or add them to Word's list of recognized functions. In the piecewise function 
definition above, we manually changed "if" to normal text. But you would never have 
a variable called "if". Here's how you add "if" to Word's list of functions. 

1. Click on an equation to display the Equation Tools | Design ribbon. 
2. In the Tools section, click the small arrow pointing down and to the right. 

 

3. Click on Recognized Function 
4. Type "if" and click Add 
5. Click OK on each window to return to your document 

Editing an existing equation from a legacy document 

"Microsoft Office Word 2007 includes built-in support for writing and editing 
equations. Previous versions used the Microsoft Equation 3.0 add-in or the Math 
Type add-in. Equation 3.0 was included in previous versions of Word and is available 
in Office Word 2007. Math Type was not included in previous versions of Word but 
was available for purchase. If an equation was written in a previous version of Word 
and you want to edit the equation by using Office Word 2007, you need to use the 
add-in that was used to write the equation. If you purchased Math Type, you need to 
have Math Type installed." (from Microsoft Word 2007's help) 

An existing equation can be edited either by double clicking on it, or by right clicking 
on it and selecting Equation Object, and either Open or Edit. 

Positioning of equations 



Equations can appear in-line  in a line of text. The line spacing will adjust 
accordingly (and will likely look better than in this web-based example). If you wish 
to have equations appear in a paragraph by themselves, simply press Return before 
and after the equation. 

To align an equation, click on the equation to select it, click on the equation menu, 
and choose the appropriate alignment under Justification. You can also choose either 
"Change to Inline" or "Change to Display" to change the equation's size and display 
position. 

Display equations in Word 2007 cannot have any other text on the same line. If you 
add text to the line containing your equation, Word 2007 will automatically change it 
to an inline equation. In most cases, you do not want this, it will make your equations 
too small, especially if they contain complicated fractions or subscripts. 

This makes numbering equations in Word 2007 more complicated than in previous 
versions, and the common practice of numbering equations on the right hand side 
requires a workaround. 

Numbering equations 

Equations to be numbered are usually centered with the number at the right margin. 
Word 2007 does not have built-in support for equation numbering, and at this time, 
we do not have a preferred solution. 

What follows is a method of using tables suggested by Microsoft developers, but it is 
not perfect. There are also equation numbering macros available from a member of 
Microsoft Research, however they are unofficial and not supported by Microsoft. 

Because of these limitations, we highly recommend that you check with your thesis 
supervisor, department, and any journals you are planning to submit to and 
determine what formatting will be required. You will want to ensure that you have 
set this up in Word before you start typesetting your work. 

Equation numbering using tables 

One technique is suggested by Jennifer Michelstein in a Microsoft blog. 

In this approach, you create a 3x1 table, with the middle (2nd) column wide and 
centered. The equation goes in the middle column, and the equation number goes in 
the the right-most column. To use chapter numbers in your equation numbers with 
this technique, you will need to manually update the numbering at the beginning of 
each chapter. 

1. Insert a table with 3 columns and 1 row. 



 

2. Click in the rightmost cell in your table. In Table Tools | Layout | Cell Size, click the 
dialog launcher icon to open Table Properties: 

 

3. In Table, set Preferred width to 100%. 
4. In Column set width to 15%, 70% and 15% for columns 1, 2, and 3. 
5. In the Cell tab (for the rightmost cell) set vertical alignment to Center. 
6. Click OK and select your table. 
7. In Table Tools | Design, click the arrow for Borders then No Border. 
8. Click in the rightmost cell. In the Home Ribbon, click the arrow for lists, and choose 

Define new Multilevel List: 

 

9. Add brackets to the formatting string for level 1. This will be the format for equation 
numbers without chapter numbers. For equation numbers with chapter numbers, 
select level 2 and select Include level number from Level 1. 



 

10. Now add a period between the 1 and the a and insert an open bracket at the 
beginning.Then change Number style to 1, 2, 3... (Leaving the "a" in place lets you see 
the difference between the numbers for levels 1 and 2.) 

 

11. If necessary, change the List Level for your number to include or not include the 
chapter number.Right-click on the number, choose Numbering, then Change List 
Level then select the appropriate format. 

 

12. Click in the middle cell of your table and insert an equation (ALT+=). 
13. Select your table, and choose the Equation menu, then Save Selection to 

Equation Gallery: 



 

14. Give your equation a name (e.g. Numbered Equation), 
under Category choose Create New Category and provide a name starting 
with AAA. (This makes your equation show up first, the category has to be 
alphabetically before "Built-in". Click OK. 

15. Now to insert a numbered equation, click on the equation button and 
choose Numbered Equation from the menu. 

 

16. If you include the chapter numbers in your equation numbers, you will need to 
update these manually. At the first equation number in a new chapter, right click on 
the equation number and choose Set Numbering Value. Click on Continue from 
previous list and check off Advance value. Then you will be able to set the value 
for both the chapter number and the equation number. 

 

Equation numbering using macros that create tables 

Another technique comes from Dong Yu of Microsoft Research. He has 
developed macros for equation numbering that create 2x1 tables with a tab in the 
first column to align the equations. You can choose whether to number with or 
without chapter numbers. There is also a mechanism to include a chapter increase 

https://www.microsoft.com/en-us/research/people/dongyu/
https://www.microsoft.com/en-us/research/people/dongyu/


indicator with your chapter headings so that chapter numbers increase properly. 
These methods should make equation numbering mostly automatic. 

Although these macros come from someone who works at Microsoft Research, they 
are not an official feature, so are not supported and may not work in future versions 
or updates of Office 2007. You should only use them if you are familiar with macros 
and have the confidence and ability to modify them to suit your needs. 

Cross referencing an equation 

You may wish to create a cross reference to an equation, a statement in your 
document such as "As was shown in Equation 3..." While you could enter the 
equation number as text, this will quickly become out of date as you edit your 
document. You want Word to insert the appropriate equation number, and update it 
if the number of the equation should change. 

At first glance it would appear that you could do an Insert, Cross-reference and 
select "Equation" as the reference type. However, this will only work if you let Word 
caption your equations, and Word will only caption an equation above or below the 
equation, which is not standard formatting. 

You will need to use a Bookmark to reference the equation number. 

Bookmarking an equation number 

Click on the equation number to select it, then issue the command Insert, 

Bookmark.  

2. Assign a meaningful name to the Bookmark (bookmark names should start with 
a letter and should not include any spaces), and click Add. Repeat this process 
for any equation that you wish to reference. 



Creating the cross reference 

1. To create a cross reference to the equation somewhere in your text, first type any 
introductory text, such as "As we saw in Equation" and then issue the 
command Insert, Reference, Cross Reference. 

 

2. Under Reference Type select Bookmark, and from the presented list of bookmarks, 
choose the appropriate one. Under Insert reference to select Paragraph number 
(full context) and click Insert. 

Updating field numbering 

If you add or delete equations in the middle of the document, the numbers may not 
be automatically updated. To update, press Ctrl+A for Select All, then press F9. 

Creating equations in PowerPoint 

You can copy and paste an equation from a Word 2007 document into PowerPoint, 
however the equation will appear as a bitmap graphic and will not resize gracefully. 
To get around this, increase the font size of the equation in Word before copying it. 

See the notes for Microsoft Equation Editor 3.0 for instructions on how to use the 
previous version of the equation editor in PowerPoint. 

 

 Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved 

in it. 
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Ans. How to display the 

filename and path in a Word 

document or title bar 
 

Image: iStockphoto.com/Jacob Ammentorp Lund 

When you open a Word document, Word displays its name in the title bar. 
If it's a new blank document, Word displays a generic name, documentx, 
until you name the file. That's adequate for most of us, but occasionally, 
you'll want the document's name to print with the content or you'll want the 
entire path in the title bar. Unfortunately, both requirements often leave 
users scratching their heads in frustration. That's because what seems 
simple has some unexpected kinks. In this article, I'll show you solutions to 
these requirements and warn you when they don't work as expected. 
I'm using Word 2016 on a Windows 10 64-bit system, but you can apply 
these solutions all the way back to Word 2003. You can use any file you 
want or you can  The solutions discussed in this article aren't compatible 
with 365. 
Use {FILENAME} field 

More about Office 

When you want to display the document's name and path in the file itself, 
you can type it, but if you change the filename, you must remember to 
update the name in your document. If you use the {FILENAME} field 
instead, it doesn't update automatically either. You must remember to 
update the field--how is that any better than typing it manually? One 
advantage is clear when you're working with multiple instances of a 
filename: Updating the field once updates it throughout the document. 

Let's use this field to display the filename in a document's header and see 
what happens: 

1. Double-click the header area to open it in edit mode and position the 
cursor where you want to display the filename. In Word 2003, choose 
Header And Footer from the View menu. 



2. Click the Insert tab and choose Field from the Quick Parts dropdown in 
the Text group (Figure A). In Word 2003, you'll find this setting in the 
AutoText options. 

3. Select FileName from the Field Names list. 
4. If you want to display the full path, check the Add Path To FileName 

Option (Figure B). 
5. Click OK to return to the document. 
6. Double-click outside the header to close the header. 

Figure A 

 

Field codes are part of the Quick Parts feature. 

Figure B 

 

You can display the filename with or without the full path. 

As you can see in Figure C, Word displays the name and path in the 
document's header, so it'll be visible on every page of the document. Later, 
I'll show you how to display it conditionally. 

Figure C 

 

Word displays the filename and path in this document's header. 

Unfortunately, if you save the file using a different name, you must update 
the field manually to display the new name. To do so, open the header, 
right-click the field, and choose Update Field (Figure D). If you're using our 
demo file, be sure to open the header and update the field to see the 
correct path for your system. 

Figure D 

 

Update the field if you change the file's name. 

If you're likely to forget to update the field and it's important that the file 
print with the right name, you can set a print option to update fields before 
printing, as follows: 



1. Click the File tab. 
2. Click Print in the left pane. 
3. Click Page Setup at the bottom. 
4. On the Paper tab, click Print Options. 
5. In the Printing Options section, check Update Fields Before Printing 

(Figure E). 
6. Click OK twice. 

Figure E 

 

Set this option to update fields before printing the document. 

Without a lot of effort, this is the best you can hope for. You might consider 
adding an ActiveDocument.Fields.Update event to the FileSaveAs event, 
but the timing's wrong and it won't work. VBA updates the fields before 
saving the new name. The file won't update the field the next time you open 
it either, so you might consider adding the Update event to an AutoOpen 
macro, so at the very least, the document displays the correct name when 
opened. However, doing so won't help if the field is in the header or footer. 
The update method updates fields only in the document body. 

There's no silver bullet because each document will be unique regarding 
fields. Since our example field is in the header, we'll add a VBA procedure 
that updates fields in the header (or footer). Add the sub procedure 
in Listing A to the document's AutoOpen event in the ThisDocument 
module as follows: 
1. Open the Visual Basic Editor (VBE) by pressing [Alt]+[F11] or clicking 

Visual Basic in the Code group on the Developer tab. 
2. Click ThisDocument (if necessary) in the Explorer window. 
3. Enter the code in Listing A. To avoid errors in the VBE, don't cut and 

copy the code from this web page. Enter the code manually or download 
the demonstration document or class file. 

4. Return to the document and save it as a macro-enabled file. If you're 
using Word 2003, this step isn't necessary. 

Opening the document triggers the AutoOpen procedure and the Update 
method updates only the fields in the header section. The value 1 
represents the page number. If the header isn't on page 1, update this 
value argument. If you're using the footer section, change Headers(x) to 
Footers(x). It's a can of worms you'd almost rather not open, but for simple 
documents, this solution works. 

Conditional display 



You might not want to display the filename on every page; perhaps you'd 
like to see it only on the last page, which seems reasonable. When this is 
the case, you can wrap the field in an {IF} expression. For instance, the 
following expression will display the filename only on the last page of the 
document: 
{ IF { PAGE } = { NUMPAGES } { FILENAME \P \* MERGEFORMAT } } 

This is just one of many possibilities. We're not going to cover an extensive 
list of expressions, but it's important to know that expressions give you 
more flexibility and control over where the document displays the field. 

SEE  

Use VBA for title bar display 

Displaying the filename in the document will be adequate for most of us. If 
you need a bit more, consider using VBA to display the full path and 
filename in the title bar. Using the directions from above to open the VBE, 
add the code in Listing B and Listing C to a document when you want to 
display the full pathname in the title bar... except, the solution doesn't 
always work. 
Saving the file triggers an internal event, FileSaveAs. The code is Listing B 
usurps this event and allows Word to display the document's FullName 
property in the title bar. For better or worse, this simple macro most likely 
will not display the full path; I have never seen it work consistently. 
Because Word will display the document's name automatically, there's little 
use for it. I've included it for the sake of discussion only--it's one of those 
kinks I mentioned. If you must have the pathname in the title bar, you can 
find an excellent solution by Graham Mayor, MVP in a discussion at 
the Microsoft Office Community. The good news is that the AutoOpen 
event in Listing C does display both the filename and path in the title bar, 
as you can see in Figure F, when you open the file. Unfortunately, you lose 
it as soon as you save the file. 

Figure F  

 

The AutoOpen event displays the path; the FileSaveAs event usually doesn't. 

No panacea 
These solutions might satisfy your simplest requirements, but they have 
inherent problems that are difficult to work around. Next month, watch for a 

http://answers.microsoft.com/en-us/office/forum/office_2007-customize/how-can-i-get-the-file-path-bar-to-display/0b521e58-677d-4038-b96e-efd154ec8850?auth=1


solution that displays the file's location on the Quick Access Toolbar. It's 
certainly easier, even though it works only in the most recent versions. 

Send me your question about Office 

I answer readers' questions when I can, but there's no guarantee. Don't 
send files unless requested; initial requests for help that arrive with 
attached files will be deleted unread. When contacting me, be as specific 
as possible. For example, "Please troubleshoot my workbook and fix what's 
wrong" probably won't get a response, but "Can you tell me why this 
formula isn't returning the expected results?" might. Please mention the 
app and version that you're using. I'm not reimbursed by TechRepublic for 
my time or expertise when helping readers, nor do I ask for a fee from 
readers I help. You can contact me at susansalesharkins@gmail.com. 

Also read... 

Microsoft Weekly Newsletter 

Be your company's Microsoft insider by reading these Windows and Office tips, tricks, 
and cheat sheets. Delivered Mondays and Wednesdays 

 Sign up today 

Get more great Office tips and tricks every week. Sign up for TechRepublic's Microsoft in 

the Enterprise newsletter! 

Q11. Create a following worksheet in MS-excel and save it with name ‘book1’. 

 

Ans . Create a following worksheet in MS-excel and save it with name ‘book1’. 

Chapter 1. Creating, Opening, 
and Saving Documents 

Every Word project you create—whether it’s a personal letter, a TV 

sitcom script, or a thesis in microbiology—begins and ends the 

same way. You start by creating a document, and you end by 

saving your work. Sounds simple, but to manage your Word 

documents effectively, you need to know these basics and beyond. 

This chapter shows you all the different ways to create a new Word 

document—like starting from an existing document or adding text to 



a predesigned template—and how to choose the best one for your 

particular project. 

You’ll also learn how to work faster and smarter by changing your 

view of your document. If you want, you can use Word’s Outline 

view when you’re brainstorming, and then switch to Print view when 

you’re ready for hard copy. This chapter gets you up and running 

with these fundamental tools so you can focus on the important 

stuff—your words. 

TIP 

If you’ve used Word before, then you’re probably familiar with opening and saving 

documents. Still, you may want to skim this chapter to catch up on the differences 

between this version of Word and the ghosts of Word past. You’ll grasp some of the big 

changes just by examining the figures. For more detail, check out the gray boxes and 

the notes and tips—like this one! 

Launching Word 

The first time you launch Word after installation, the program asks 

you to confirm your name and initials. This isn’t Microsoft’s 

nefarious plan to pin you down: Word uses this information to 

identify documents that you create and modify. Word uses your 

initials to mark your edits when you review and add comments to 

Word documents that other people send to you (Section 16.3). 

You have three primary ways to fire up Word, so use whichever 

method you find quickest: 

 Start menu. The Start button in the lower-left corner of your 

screen gives you access to all programs on your PC—Word 

included. To start Word, choose Start → All Programs → Microsoft 

Office → Microsoft Office Word. 

 Quick Launch toolbar. The Quick Launch toolbar at the 

bottom of your screen (just to the right of the Start menu) is a great 

place to start programs you use frequently. Microsoft modestly 
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assumes that you’ll be using Word a lot, so it usually installs the 

Word icon in the Quick Launch toolbar. To start using Word, just 

click the W icon, and voilá! 

TIP 

When you don’t see the Quick Launch toolbar, here’s how to display it: On the bar at the 

bottom of your screen, right-click an empty spot. From the menu that pops up, choose 

Toolbars → Quick Launch. When you’re done, icons for some of your programs appear 

in the bottom bar. A single click fires up the program. 

 Opening a Word document. Once you’ve created some 

Word documents, this method is fastest of all, since you don’t have 

to start Word as a separate step. Just open an existing Word 

document, and Word starts itself. Try going to Start → My Recent 

Documents, and then, from the list of files, choose a Word 

document. You can also double-click the document’s icon on the 

desktop or wherever it lives on your PC. 

TIP 

If you need to get familiar with the Start menu, Quick Launch toolbar, and other Windows 

features, then pick up a copy of Windows XP: The Missing Manual, Second Edition 

or Windows Vista: The Missing Manual. 

So, what happens once you’ve got Word’s motor running? If you’re 

a newcomer, you’re probably just staring with curiosity. If you’re 

familiar with previous versions of Word, though, you may be doing a 

double take (Figure 1-1). In Word 2007, Microsoft combined all the 

old menus and toolbars into a new feature called the ribbon. Click 

one of the tabs above the ribbon, and you see the command 

buttons change below. The ribbon commands are organized into 

groups, with the name of each group listed at the bottom. 

(See Figure 1-1 for more detail on the ribbon.) 

Creating a New Document 

When you start Word without opening an existing document, the 

program gives you an empty one to work in. If you’re eager to put 
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words to page, then type away. Sooner or later, though, you’ll want 

to start another new document. Word gives you three ways to do so: 

 

Figure 1-1. When you start Word 2007 for the first time, it may look a 

little top-heavy. The ribbon takes up more real estate than the old menus 

and toolbars. This change may not matter if you have a nice big monitor. 

But if you want to reclaim some of that space, you can hide the ribbon by 

double-clicking the active tab. Later, when you need to see the ribbon 

commands, just click a tab. 

 Creating a new blank document. When you’re preparing a 

simple document—like a two-page essay, a note for the babysitter, 

or a press release—a plain, unadorned page is fine. Or, when 

you’re just brainstorming and you’re not sure what you want the 

final document to look like, you probably want to start with a blank 

slate or use one of Word’s templates (more on that in a moment) to 

provide structure for your text. 

 Creating a document from an existing document. For 

letters, resumes, and other documents that require more formatting, 

why reinvent the wheel? You can save time by using an existing 

document as a starting point (Section 1.2.2). When you have a 

letter format that you like, you can use it over and over by editing 

the contents. 

 Creating a document from a template (Section 1.2.3). Use 

a template when you need a professional design for a complex 

document, like a newsletter, a contract, or meeting 

minutes. Templates are a lot like forms—the margins, formatting, 

and graphics are already in place. All you do is fill in your text. 
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TIP 

Microsoft provides a mind-boggling number of templates with Word, but they’re not the 

only source. You can find loads more on the Internet, as described in Section 5.2.1. Your 

employer may even provide official templates for company documents. 

To start your document in any of the above ways, click the Windows 

logo in the upper-left corner of the screen. That’s Office 2007’s 

new Office button. Click it, and a drop-down menu opens, revealing 

commands for creating, opening, and saving documents. Next to 

these commands, you see a list of your Word documents. This list 

includes documents that are open, as well as those that you’ve 

recently opened. 

The Office button is also where you go to print and email 

your documents (Figure 1-2). 

 

Figure 1-2. The phrase most frequently uttered by experienced Word fans 

the first time they start Word 2007 is, “Okay, where’s my File menu?” 

Never fear, the equivalent of the File menu is still there—it’s just 

camouflaged a bit. Clicking the Office button (the one that looks like a 

Windows logo) reveals the commands you use to create, open, and save 

Word documents. 

Creating a New Blank Document 

Say you want a new blank document, just like the one Word shows you 

when you start the program. No problem—here are the steps: 

1. Choose Office button → New. 
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The New Document dialog box appears. 

2. In the upper-left corner of the large “Create a new Word 

document” panel, click “Blank document” (Figure 1-3). 

The New Document box presents a seemingly endless number of 

options, but don’t panic. The ―Blank document‖ option you want is 

on the left side of the first line. 

3. At the bottom of the New Document dialog box, click 

Create. 

The dialog box disappears, and you’re gazing at the blank page of a 

new Word document. 

Better get to work. 

 

Figure 1-3. Open the New Document box (Office button → New, or Alt+F, 

N), and Word gives you several ways to create a new document. Click 

“Blank document” to open an empty document, similar to the one Word 

shows when you first start the program. Or you can click “New from 

existing” to open a document that you previously created under a new 

name. 

Creating a New Document from an Existing Document 

A blank Word document is sort of like a shapeless lump of clay. With 

some work, you can mold it to become just about anything. Often, 

however, you can save time by opening an existing document that’s 

similar to the one you want to create. Imagine that you write the minutes 
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for the monthly meetings of the Chief Executive Officer’s Surfing 

Association (CEOSA). When it’s time to write up the June minutes, it’s a 

lot faster to open the minutes from May. You keep the boilerplate text and 

all the formatting, but you delete the text that’s specific to the previous 

month. Now all you have to do is enter the text for June and save the 

document with a new name: JuneMinutes.docx. 

NOTE 

The .docx extension on the end of the filename is Word 2007’s new version of .doc. The 

switch from three-letter to four-letter filename extensions indicates a change in the way 

Word stores documents. (If you need to share documents with folks using earlier 

versions of Word, choose Office button → Save As → Word 97-2003 document when 

you save the file. See the box in Section 1.2.3 for details.) 

Word gives you a ―New from existing‖ document-creation option to 

satisfy your desire to spend more time surfing and less time writing 

meeting minutes. Here’s how to create a new document from an existing 

document: 

1. Choose Office button → New (Alt+F, N) to open the New 

Document window. Then click “New from existing…” (it sits 

directly below the “Blank document” button). 

The three dots at the end of the button’s title tell you that there’s 

another dialog box to come. And sure enough, when you click ―New 

from existing…‖, it opens another box, appropriately titled New from 

Existing Document (Figure 1-4). This box looks—and works—like a 

standard Windows Open File box. It lets you navigate to a specific 

folder and open a file. 

2. On your computer, find the existing document you’re 

using for a model. 

You can use the bar on the left to change the folder view. Word 

starts you in your My Documents folder, but you can switch to your 

desktop or your My Computer icon by clicking the icons on the left. 
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Double-click folder icons in the large window to open them and see 

their contents. 

3. Click to select the file, and then click Create New (in the 

lower-right corner). (Alternatively, just double-click the file’s 

icon to open it. This trick works in all Open File boxes.) 

Instead of the usual Open button at the bottom of the box, the 

button in the New from Existing Document box reads Create New—

your clue that this box behaves differently in one important respect: 

Instead of opening an existing file, you’re making a copy of an 

existing file. Once open, the file’s name is something 

like Document2.docx instead of the original name. This way, when 

you save the file, you don’t overwrite the original document. (Still, 

it’s best to save it with a new descriptive name right away.) 

 

Figure 1-4. Use the New from Existing Document box to find an existing 

Word document that you’d like to open as a model for your new 

document. When you click Create New at bottom-right, Word opens a 

new copy of the document, leaving the original untouched. You can 

modify the copy to your heart’s content and save it under a different file 

name. 

TIP 

Windows’ Open File boxes, like New from Existing Document, let you do a lot more than 

just find files. In fact, they let you do just about anything you can do in Windows 

Explorer. Using keyboard shortcuts, you can cut (Ctrl+X), copy (Ctrl+C), and paste 

(Ctrl+V) files. A right-click displays a shortcut menu with even more commands, letting 



you rename files, view Properties dialog boxes, and much more. You can even drag and 

drop to move files and folders. 

POWER USERS’ CLINIC: WORD’S NEW FILE FORMATS: .DOCX AND 

.DOCM 

With Office 2007, Microsoft took the drastic step of changing its file formats in hopes of 

improving your computer’s security. Malicious programmers were using Office’s macros 

to do nasty things to unsuspecting computers. The .docx format, the new standard for 

Word files, doesn’t permit macros, making it safe from those threats. The .docm format 

indicates that a document contains macros or other bits of programming code. When 

opening one of these files, play it safe: If you don’t know who created the .docm file, then 

don’t open it. 

The downside of the new file formats is that older versions of Word don’t know how to 

open these .docx and .docm documents. To open Word 2007 files with an older version 

(even Word 2003), you need to install the Microsoft Office Compatibility Pack. 

This software fix gives pre-2007 versions of Word the power to open documents in the 

new formats. Even then, you may not be able to use or edit parts of the file that use new 

Word features (like themes, equations, and content controls). To download the free 

compatibility pack, go to www.office.microsoft.com and type office 2007 compatibility into 

the search box at the top of the page. 

Also, if you’re preparing a Word document for someone who’s using an older Word 

version, then you have to save it in a compatible format, as described in the tip 

in Section 1.2.2. (Fortunately, the compatibility issue doesn’t go both ways: Word 2007 

can open old .doc docs just fine.) 

Creating a New Document from a Template 

Say you’re creating meeting minutes for the first time. You don’t have an 

existing document to give you a leg up, but you do want to end up with 

handsome, properly formatted minutes. Word is at your service—

with templates. Microsoft provides dozens upon dozens of 

prebuilt templates for everything from newsletters to postcards. Remember 
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all the busy stuff in the New Document box in Figure 1-3? About 90 

percent of the items in there are templates. 

In the previous example, where you use an existing document to create the 

meeting minutes for the Chief Executive Officer’s Surfing Association 

(CEOSA), each month you open the minutes from the previous month. 

You delete the information that pertains to the previous month and enter 

the current month’s minutes. A template works pretty much the same way, 

except it’s a generic document, designed to be adaptable to lots of different 

situations. You just open it and add your text. The structure, formatting, 

graphics, colors, and other doodads are already in place. 

NOTE 

The subject of Word templates is a lengthy one, especially when it comes to creating 

your own, so there’s a whole chapter devoted to that topic—Chapter 20. 

Here’s how to get some help from one of Microsoft’s templates for 

meeting minutes: 

1. Choose Office button → New (Alt+F, N) to open the New 

Document window. 

On the left of the New Document box is a Template Categories list. 

The top entry on this list is Installed Templates—the ones Word has 

installed on your computer. 

You could use any of these, but you also have a world of choice 

waiting for you online. On its Web site, Microsoft offers hundreds 

of templates for all sorts of documents, and you can access them 

right from the New Document box. If you have a fast Internet 

connection, then it’s just as quick and easy to use an online 

template as it is using the ones stored on your computer. In fact, 

you’ll use an online template for this example. 
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NOTE 

If you can’t connect to the Internet right now, then simply choose one of 

the installed templates instead. Click Create, and then skip to step 4. 

2. Scroll down the Template Categories list to the Microsoft 

Office Online heading. Under this heading, select Minutes. 

In the center pane, you’ll see all different types of minutes 

templates, from PTA minutes to Annual shareholder’s meeting 

minutes (Figure 1-5). When you click a template’s icon, a preview 

appears in the pane on the right. 

 

Figure 1-5. The New Document box lists prebuilt templates that live at 

Microsoft Office Online in categories like Agendas, Brochures, Calendars, 

and Minutes. Below the thumbnail you see an estimate of how long it 

takes to download the template from the Microsoft Office Online Web 

site. A rating, from 0 to 5 stars, tells you what other people think of the 

template (the rating system is kind of like the one at Amazon.com). 

3. When you’re done perusing the various styles, click the 

Formal Meeting Minutes icon. (After all, CEOSA is a very 

formal organization.) Then click Download. 

Word downloads and opens the document. 

4. Start writing up the minutes for the CEO Surfers. 
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To follow the template’s structure, replace all the words in square 

brackets ([ ]) with text relevant to CEOSA. 

TIP 

If you’d rather not download the Formal Meeting Minutes template every time you use it, 

then you can save the file on your computer as a Word template. The steps for saving 

files are just around the corner in Section 1.5. 

Opening an Existing Document 

If you’ve mastered creating a document from an existing document 

and creating a document from a template, you’ll find that opening 

an existing document is a snap. The steps are nearly identical. 

1. Choose Office button → Open (Alt+F, O). In the Open 

window (Figure 1-6), navigate to the folder and file you want to 

open. 

The Open window starts out showing your My Documents folder, 

since that’s where Word suggests you save your files. When your 

document’s in a more exotic location, click the My Computer icon, 

and then navigate to the proper folder from there. 

TIP 

When you open a document you’ve used recently, you may see its name right on the 

Office button → Recent Documents menu. If so, simply click to open it without a trip to 

the Open dialog box. 

2. With the file selected, click Open in the lower-right corner. 

The Open box goes away and your document opens in Word. 

You’re all set to get to work. Just remember, when you save this 

document (Alt+F, S or Ctrl+S), you write over the previous file. 

Essentially, you create a new, improved, and only copy of the file 

you just opened. If you don’t want to write over the existing 

document, use the Save As command (Alt+F, A), and then type a 

new name in the File Name text box. 
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Figure 1-6. This Open dialog box shows the contents of the tale of two 

cities folder, according to the “Look in” box at the top. The file tale of two 

cities. docx is selected, as you can see in the “File name box” at the 

bottom of the window. By clicking Open, Mr. Dickens is ready to go to 

work. 

TIP 

Opening a file in Word doesn’t mean you’re limited to documents created in Word. You 

can choose documents created in other programs from the Files of Type drop-down 

menu at the bottom of the Open dialog box. Word then shows you that type of document 

in the main part of the window. You can open Outlook messages (.msg), Web pages 

(.htm or .html), or files from other word processors (.rtf, .mcw, .wps). 

Your Different Document Views 

Now that you know a handful of ways to create and open Word 

documents, it’s time to take a look around the establishment. You 

may think a document’s a document—just look at it straight on and 

get your work done. It’s surprising, though, how changing your view 

of the page can help you work faster and smarter. When you’re 

working with a very long document, you can change to Outline view 

and peruse just your document’s headlines without the paragraph 

text. In Outline view, you get a better feeling for the manuscript as a 

whole. Likewise, when you’re working on a document that’s headed 

for the Web, it makes sense to view the page as it will appear in a 

browser. Other times, you may want to have two documents open 

on your screen at once (or on each of your two monitors, you lucky 

dog), to make it easy to cut and paste text from one to the other. 



The key to working with Word’s different view options is to match 

the view to the job at hand. Once you get used to switching views, 

you’ll find lots of reasons to change your point of view. Find the 

tools you need on the View tab (Figure 1-7). To get there, click the 

View tab (Alt+W) on the ribbon (near the top of Word’s window). 

The tab divides the view commands into four groups: 

 Document Views. These commands change the big picture. 

For the most part, use these when you want to view a document in 

a dramatically different way: two pages side by side, Outline view, 

Web layout view, and so on. 

 Show/Hide. The Show/Hide commands display and conceal 

Word tools like rulers and gridlines. These tools don’t show when 

you print your document; they’re just visual aids that help you when 

you’re working in Word. 

 Zoom. As you can guess, the Zoom tools let you choose 

between a close-up and a long shot of your document. Getting in 

close makes your words easier to read and helps prevent eyestrain. 

But zooming out makes scrolling faster and helps you keep your 

eye on the big picture. 

TIP 

In addition to the Zoom tools on the ribbon, handy Zoom tools are available in the 

window’s lower-right corner. Check out the + (Zoom In) and–(Zoom Out) buttons and the 

slider in between them. See Section 1.4.3 for the details on using them. 

 Window. In the Window group, you’ll find creative ways to 

organize document windows on your screen—like split views of a 

single document or side-by-side views of two different documents. 

All the commands in the View tab’s four groups are covered in the 

following pages. 

NOTE 

This section provides the short course on viewing your Word documents. For even more 

details and options for customizing your Word environment, see Chapter 17. 
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https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-SECT-4.3
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch17.html


 

Figure 1-7. The View tab is your document-viewing control center. Look 

closely, and you see it’s divided into four groups with names at the 

bottom of the ribbon: Document Views, Show/Hide, Zoom, and Window. 

To apply a view command, just click the button or label. 

Document Views: Five Ways to Look at Your Manuscript 

Word gives you five basic document views. To select a view, go to the 

View tab (Alt+W) and choose one of the Document Views on the left side 

of the ribbon (Figure 1-8). You have another great option for switching 

from one view to another that’s always available in the lower-right corner 

of Word’s window. Click one of the five small buttons to the left of the 

slider to jump between Print Layout, Full Screen Reading, Web Layout, 

Outline, and Draft views. Each view has a special purpose, and you can 

modify them even more using the other commands on the View tab. 

 

Figure 1-8. On the left side of the View tab, you find the five basic 

document views: Print Layout, Full Screen Reading, Web Layout, Outline, 

and Draft. You can edit your document in any of the views, although they 

come with different tools for different purposes. For example, Outline 

view provides a menu that lets you show or hide headings at different 

outline levels. 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-8


NOTE 

Changing your view in no way affects the document itself—you’re just looking at the 

same document from a different perspective. 

 Print Layout (Alt+W, P). The most frequently used view in 

Word, Print Layout, is the one you see when you first start the 

program or create a new blank document. In this view, the page you 

see on your computer screen looks much as it does when you print 

it. This view’s handy for letters, reports, and most documents 

headed for the printer. 

 Full Screen Reading (Alt+W, F). If you’d like to get rid of the 

clutter of menus, ribbons, and all the rest of the word-processing 

gadgetry, then use Full Screen Reading view. As the name implies, 

this view’s designed primarily for reading documents. It includes 

options you don’t find in the other views, like a command that 

temporarily decreases or increases the text size. In the upper-right 

corner you see some document-proofing tools (like a text highlighter 

and an insert comment command), but when you want to change or 

edit your document, you must first use the View Options → Allow 

Typing command. For more details on using Word for reviewing and 

proofing, see Chapter 16. 

 Web Layout (Alt+W, L). This view shows your document as if 

it were a single Web page loaded in a browser. You don’t see any 

page breaks in this view. Along with your text, you see any photos 

or videos that you’ve placed in the document—just like a Web 

page. Section 13.2 has more details on creating Web pages with 

Word. 

 Outline (Alt+W, U). For lots of writers, an outline is the first 

step in creating a manuscript. Once they’ve created a framework of 

chapters and headings, they dive in and fill out the document with 

text. If you like to work this way, then you’ll love Outline 

 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch16.html
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch13.html#word2007tmm-CHP-13-SECT-2


Q12. Calculate the following things of a range 

(C2:C11) of data in the worksheet created in question 

no 

uestions and answers 

 

Brainly.in 

Question 

. Given the Following Spreadsheet, Write the appropriate Formula/ Expression/ Function 

to be used for (a) to (e)a) Write formula to calculate the Total Qty(C4:C7)) in cell C8b) Write 

the feature used for arranging the Price from Highest to Lowestc) To find the Product with 

Maximum Price to be written in Cell D10d) To find the Average Qty to be written in cell 

C9e) Write formula to calculate the Total Amount in cell E8 

Answer · 414 votes 

a) Formula to calculate the Total Qty(C4:C7) in cell C8: =SUM(C4,C7) b) For arranging the 

Price from highest to lowest click on the first cell that you desired to select on the 

spreadsheet and then drag the mouse to the last cell that you want to select. Then right 

click on the selected range and click on ‘Sort’ option and then click on the option ‘Sort 

Largest to Smallest’. c) Formula for finding the maximum price to be written in the cell 

D10: =MAX(D4,CD,D6,D7) d) Formula for finding the average Qty to be written in the cell 

C9: =AVERAGE(C4,C5,C6,C7) e) Formula for finding the total amount in E8: =SUM(E4,E7) 

 

Question 

2. Consider the following spreadsheet and answer the questions that follow: a. 

Calculate the Total Price as Price * No_of_copies in cell E2. b. Which option can be used 

to arrange the books in ascending order of price( lowest to highest)? c. Find the highest 

price of a book and display it in cell C6. d. Which option can be used to change the 

background color of a cell? e. Mention the feature used to display the data in a graphical 

form. f. Change the alignment of text in cell B2 to central alignment 

Answer · 151 votes 

a)=product (number1:number2)b)sort smallest to largestc)=max (c2:c5)d)fill 

coloure)chartf)doubleclick>centre alignment Hope it helps you! Pls mark the brainliest! 

More 

 

https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7659884
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7742178
https://brainly.in/question/7659884


Ans . Use the SUM function to 

sum numbers in a range 

Excel for Microsoft 365 Excel for the web Excel 2019 Excel 2016 Excel 2013 

You can use a simple formula to sum numbers in a range (a group of cells), but 

the SUM function is easier to use when you’re working with more than a few 

numbers. For example =SUM(A2:A6) is less likely to have typing errors than 

=A2+A3+A4+A5+A6. 

 

Here’s a formula that uses two cell ranges: =SUM(A2:A4,C2:C3) sums the numbers 

in ranges A2:A4 and C2:C3. You’d press Enter to get the total of 39787. 

To create the formula: 

1. Type =SUM in a cell, followed by an opening parenthesis (. 

2. To enter the first formula range, which is called an argument (a piece of data the 

formula needs to run), type A2:A4 (or select cell A2 and drag through cell A6). 

3. Type a comma (,) to separate the first argument from the next. 

4. Type the second argument, C2:C3 (or drag to select the cells). 

5. Type a closing parenthesis ), and then press Enter. 

Each argument can be a range, a number, or single cell references, all separated by 

commas. 

 =SUM(A2:A4,2429,10482) 

 =SUM(4823,A3:A4,C2:C3) 

 =SUM(4823,12335,9718,C2:C3) 

 =SUM(A2,A3,A4,2429,10482) 

Tip:  If you need to sum columns or rows of numbers next to each other, use AutoSum to sum 

numbers. 

https://support.microsoft.com/en-us/office/use-excel-as-your-calculator-a1abc057-ed11-443a-a635-68216555ad0a
https://support.microsoft.com/en-us/office/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89
https://support.microsoft.com/en-us/office/use-autosum-to-sum-numbers-543941e7-e783-44ef-8317-7d1bb85fe706
https://support.microsoft.com/en-us/office/use-autosum-to-sum-numbers-543941e7-e783-44ef-8317-7d1bb85fe706


Give it a try 

If you want to play around with our sample data, here’s some data to use. 

You can see how the SUM function works by copying the following table into a 

worksheet and pasting it into cell A1. 

Data 
  

-5 
  

15 
  

30 
  

'5 
  

TRUE 
  

Formula Description Result 

=SUM(3, 2) Adds 3 and 2. 5 

=SUM("5", 15, 

TRUE) 

Adds 5, 15 and 1. The text value "5" is first 

translated into a number, and the logical 

value TRUE is first translated into the 

number 1. 

21 

=SUM(A2:A4) Adds the values in cells A2 through A4. 40 

=SUM(A2:A4, 

15) 

Adds the values in cells A2 through A4, 

and then adds 15 to that result. 

55 

=SUM(A5,A6, 

2) 

Adds the values in cells A5 and A6, and 

then adds 2 to that result. Because non-

numeric values in references are not 

translated — the value in cell A5 ('5) and 

2 



Data 
  

the value in cell A6 (TRUE) are both 

treated as text — the values in those cells 

are ignored. 
 

B . rks in a range of cells (C2:C11 

Use the SUM function to sum 

numbers in a range 

Excel for Microsoft 365 Excel for the web Excel 2019 Excel 2016 Excel 2013 

You can use a simple formula to sum numbers in a range (a group of cells), but 

the SUM function is easier to use when you’re working with more than a few 

numbers. For example =SUM(A2:A6) is less likely to have typing errors than 

=A2+A3+A4+A5+A6. 

 

Here’s a formula that uses two cell ranges: =SUM(A2:A4,C2:C3) sums the numbers 

in ranges A2:A4 and C2:C3. You’d press Enter to get the total of 39787. 

To create the formula: 

1. Type =SUM in a cell, followed by an opening parenthesis (. 

2. To enter the first formula range, which is called an argument (a piece of data the 

formula needs to run), type A2:A4 (or select cell A2 and drag through cell A6). 

3. Type a comma (,) to separate the first argument from the next. 

https://support.microsoft.com/en-us/office/use-excel-as-your-calculator-a1abc057-ed11-443a-a635-68216555ad0a
https://support.microsoft.com/en-us/office/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89


4. Type the second argument, C2:C3 (or drag to select the cells). 

5. Type a closing parenthesis ), and then press Enter. 

Each argument can be a range, a number, or single cell references, all separated by 

commas. 

 =SUM(A2:A4,2429,10482) 

 =SUM(4823,A3:A4,C2:C3) 

 =SUM(4823,12335,9718,C2:C3) 

 =SUM(A2,A3,A4,2429,10482) 

Tip:  If you need to sum columns or rows of numbers next to each other, use AutoSum to sum 

numbers. 

Give it a try 

If you want to play around with our sample data, here’s some data to use. 

You can see how the SUM function works by copying the following table into a 

worksheet and pasting it into cell A1. 

Data 
  

-5 
  

15 
  

30 
  

'5 
  

TRUE 
  

Formula Description Result 

=SUM(3, 2) Adds 3 and 2. 5 

=SUM("5", 15, 

TRUE) 

Adds 5, 15 and 1. The text value "5" is first 

translated into a number, and the logical 

value TRUE is first translated into the 

21 

https://support.microsoft.com/en-us/office/use-autosum-to-sum-numbers-543941e7-e783-44ef-8317-7d1bb85fe706
https://support.microsoft.com/en-us/office/use-autosum-to-sum-numbers-543941e7-e783-44ef-8317-7d1bb85fe706


Data 
  

number 1. 

=SUM(A2:A4) Adds the values in cells A2 through A4. 40 

=SUM(A2:A4, 

15) 

Adds the values in cells A2 through A4, 

and then adds 15 to that result. 

55 

=SUM(A5,A6, 

2) 

Adds the values in cells A5 and A6, and 

then adds 2 to that result. Because non-

numeric values in references are not 

translated — the value in cell A5 ('5) and 

the value in cell A6 (TRUE) are both 

treated as text — the values in those cells 

are ignored. 

2 

Need more help? 

You can always ask an expert in the Excel Tech Community or get support in 

the Answers community. 

 

Oct 

16 

MAX function in Excel: formula examples 
to find and highlight highest value 
by Svetlana Cheusheva | updated on March 2, 2021 10 Comments 

The tutorial explains the MAX function with many formula examples that show how to find highest 
value in Excel and highlight largest number in your worksheet. 

MAX is one of the most straightforward and easy-to-use Excel functions. However, it does have a 
couple of tricks knowing which will give you a big advantage. Say, how do you use the MAX 

https://techcommunity.microsoft.com/t5/Excel/ct-p/Excel_Cat
https://go.microsoft.com/fwlink/?linkid=827514
https://www.ablebits.com/office-addins-blog/author/svetlana-cheusheva/
https://www.ablebits.com/office-addins-blog/2019/10/16/max-function-excel-highest-value/#comments


function with conditions? Or how would you extract the absolute largest value? This tutorial 
provides more than one solution for these and other related tasks. 

Excel MAX function 

The MAX function in Excel returns the highest value in a set of data that you specify. 

The syntax is as follows: 

MAX(number1, [number2], …) 

Where number can be represented by a numeric value, array, named range, a reference to a 
cell or range containing numbers. 

Number1 is required, number2 and subsequent arguments are optional. 

The MAX function is available in all versions of Excel for Office 365, Excel 2019, Excel 2016, 
Excel 2013, Excel 2010, Excel 2007, and lower. 

How to make a MAX formula in Excel 

To create a MAX formula in its simplest from, you can type numbers directly in the list of 
arguments, like this: 

=MAX(1, 2, 3) 

In practice, it's quite a rare case when numbers are "hardcoded". For the most part, you will deal 
with ranges and cells. 

The fastest way to build a Max formula that finds the highest value in a range is this: 

1. In a cell, type =MAX( 

2. Select a range of numbers using the mouse. 

3. Type the closing parenthesis. 

4. Press the Enter key to complete your formula. 

For example, to work out the largest value in the range A1:A6, the formula would go as follows: 

=MAX(A1:A6) 

 



If your numbers are in a contiguous row or column (like in this example), you can get Excel to 
make a Max formula for you automatically. Here's how: 

1. Select the cells with your numbers. 

2. On the Home tab, in the Formats group, click AutoSum and pick Max from the drop-down list. 
(Or click AutoSum > Max on the Formulas tab in the Function Library group.) 

This will insert a ready-to-use formula in a cell below the selected range, so please make sure 
there is at least one blank cell underneath the list of numbers that you've selected: 

 

5 things to know about MAX function 

To successfully use Max formulas your worksheets, please remember these simple facts: 

1. In the current versions of Excel, a MAX formula can accept up to 255 arguments. 

2. If the arguments do not contain a single number, the MAX function returns zero. 

3. If the arguments contain one or more error values, an error is returned. 

4. Empty cells are ignored. 

5. Logical values and text representations of numbers supplied directly in the list of arguments 
are processed (TRUE evaluates as 1, FALSE evaluates as 0). In references, logical and text 
values are ignored. 

How to use MAX function in Excel – formula 
examples 

Below you will find a few typical uses of the Excel MAX function. In many cases, there are a few 
different solutions for the same task, so I encourage you to test all the formulas to choose the 
one best suited for your data type. 



How to find max value in a group 

To extract the largest number in a group of numbers, supply that group to the MAX function as a 
range reference. A range can contain as many rows and columns as you desire. For example, to 
get the highest value in the range C2:E7, use this simple formula: 

=MAX(C2:E7) 

 

Find highest value in non-adjacent cells or ranges 

To make a MAX formula for non-contiguous cells and ranges, you need to include a reference to 
each individual cell and/or range. The following steps will help you to do that quickly and 
flawlessly: 

1. Start typing a Max formula in a cell. 

2. After you've typed the opening parenthesis, hold down the Ctrl key and select the cells and 
ranges in the sheet. 

3. After selecting the last item, release Ctrl and type the closing parenthesis. 

4. Press Enter. 

Excel will use an appropriate syntax automatically, and you will get a formula similar to this: 

=MAX(C5:E5, C9:E9) 



As shown in the screenshot below, the formula returns the maximum sub-total value from rows 5 
and 9: 

 

How to get max (latest) date in Excel 

In the internal Excel system, dates are nothing else but serial numbers, so the MAX function 
handles them without a hitch. 

For instance, to find the latest delivery date in C2:C7, make a usual Max formula that you'd use 
for numbers: 

=MAX(C2:C7) 

 

MAX function in Excel with conditions 

When you wish to get the maximum value based on conditions, there are several formulas for 
you to choose from. To make sure that all the formulas return the identical result, we will test 
them on the same set of data. 

The task: With the items listed in B2:B15 and sales figures in C2:C15, we aim to find the highest 
sale for a specific item input in F1 (please see the screenshot at the end of this section). 



Excel MAX IF formula 

If you a looking for a formula that works in all versions of Excel 2000 through Excel 2019, use 
the IF function to test the condition, and then pass the resulting array to the MAX function: 

=MAX(IF(B2:B15=F1, C2:C15)) 

For the formula to work, it must press Ctrl + Shift + Enter simultaneously to enter it as an array 
formula. If all done correctly, Excel will enclose your formula in {curly braces}, which is a visual 
indication of an array formula. 

It is also possible to evaluate several conditions in a single formula, and the following tutorial 
shows how: MAX IF with multiple conditions. 

Non-array MAX IF formula 

If you don't like using array formulas in your worksheets, then combine MAX with 
the SUMPRODUCT function that processes arrays natively: 

=SUMPRODUCT(MAX((B2:B15=F1)*(C2:C15))) 

For more information, please see MAX IF without array. 

MAXIFS function 

In Excel 2019 and Excel for Office 365, there is a special function named MAXIFS, which is 
designed to find the highest value with up to 126 criteria. 

In our case, there is just one condition, so the formula is as simple as: 

=MAXIFS(C2:C15, B2:B15, F1) 

For the detailed explanation of the syntax, please see Excel MAXIFS with formula examples. 

https://www.ablebits.com/office-addins-blog/2014/11/26/if-function-excel/
https://www.ablebits.com/office-addins-blog/2015/02/25/array-formulas-functions-excel/
https://www.ablebits.com/office-addins-blog/2015/02/25/array-formulas-functions-excel/
https://www.ablebits.com/office-addins-blog/2019/10/30/excel-max-if-formula/#maxif-multiple-criteria
https://www.ablebits.com/office-addins-blog/2016/08/24/excel-sumproduct-function-formula-examples/
https://www.ablebits.com/office-addins-blog/2019/10/30/excel-max-if-formula/#maxif-without-array
https://www.ablebits.com/office-addins-blog/2019/10/23/maxifs-function-excel-find-max-value-multiple-criteria/


The below screenshot shows all 3 formulas in action: 

 

Get max value ignoring zeros 

This is, in fact, a variation of conditional MAX discussed in the previous example. To exclude 
zeros, use the "not equal to" logical operator and put the expression "<>0" in either the criteria of 
MAXIFS or the logical test of MAX IF. 

As you understand, testing this condition only makes sense in case of negative numbers. With 
positive numbers, this check is superfluous because any positive number is greater than zero. 

To give it a try, let's find the lowest discount in the range C2:C7. As all the discounts are 
represented by negative numbers, the smallest discount is actually the largest value. 

MAX IF 

Be sure to press Ctrl + Shift + Enter to correctly complete this array formula: 

=MAX(IF(C2:C7<>0, C2:C7)) 

MAXIFS 

It's a regular formula, and a usual Enter keystroke will suffice. 

=MAXIFS(C2:C7,C2:C7,"<>0") 



 

Find highest value ignoring errors 

When you work with a large amount of data driven by various formulas, chances are that some of 
your formulas will result in errors, which will cause a MAX formula to return an error too. 

As a workaround, you can use MAX IF together with ISERROR. Given that you are searching in 
the range A1:B5, the formula takes this shape: 

=MAX(IF(ISERROR(A1:B5)), "", A1:B5)) 

To simplify the formula, use the IFERROR function instead of the IF ISERROR combination. This 
will also make the logic a bit more obvious – if there's an error in A1:B5, replace it with an empty 
string (''), and then get the maximum value in the range: 

=MAX(IFERROR(A1:B5, "")) 

A fly in the ointment is that you need to remember to press Ctrl + Shift + Enter because this only 
works as an array formula. 

In Excel 2019 and Excel for Office 356, the MAXIFS function can be a solution, provided that 
your data set contains at least one positive number or zero value: 

=MAXIFS(A1:B5,A1:B5,">=0") 

Since the formula searches for the highest value with the condition "greater than or equal to 0", it 
won't work for a data set consisting of solely negative numbers. 

All these limitations are not good, and we are evidently in need of a better solution. The 
AGGREGATE function, which can perform a number of operations and ignore error values, fits 
perfectly: 

=AGGREGATE(4, 6, A1:B5) 

The number 4 in the 1st argument indicates the MAX function, the number 6 in the 2nd argument 
is the "ignore errors" option, and A1:B5 is your target range. 

https://www.ablebits.com/office-addins-blog/2019/10/16/max-function-excel-highest-value/#max-if
https://www.ablebits.com/office-addins-blog/2017/09/27/excel-iferror-function-with-formula-examples/


Under perfect circumstances, all three formulas will return the same result: 

 

How to find absolute max value in Excel 

When working with a range of positive and negative numbers, sometimes you may wish to find 
the largest absolute value regardless of the sign. 

The first idea that comes to mind is to get the absolutes values of all numbers in the range by 
using the ABS function and feed those to MAX: 

{=MAX(ABS(range))} 

This is an array formula, so don't forget to confirm it with the Ctrl + Shift + Enter shortcut. Another 
caveat is that it only works with numbers and results in an error in case of non-numeric data. 

Not happy with this formula? Then let us build something more viable :) 

What if we find the minimum value, reverse or ignore its sign, and then evaluate along with all 
other numbers? Yep, that will work perfectly as a normal formula. As an extra bonus, it handles 
text entries and errors just fine: 

With the source numbers in A1:B5, the formulas go as follows. 

Array formula (completed with Ctrl + Shift + Enter): 

=MAX(ABS(A1:B5)) 

Regular formula (completed with Enter): 

=MAX(MAX(A1:B5), -MIN(A1:B5)) 

or 

=MAX(MAX(A1:B5), ABS(MIN(A1:B5))) 

The below screenshot shows the results: 

 

https://www.ablebits.com/office-addins-blog/2018/07/04/excel-absolute-value-abs-function/#excel-ABS-function


Return the maximum absolute value preserving the sign 

In some situations, you may have a need to find the largest absolute value but return the number 
with its original sign, not the absolute value. 

Assuming the numbers are in cells A1:B5, here's the formula to use: 

=IF(ABS(MAX(A1:B5))>ABS(MIN(A1:B5)), MAX(A1:B5), MIN(A1:B5)) 

Complex at first sight, the logic is quite easy to follow. First, you find the largest and smallest 
numbers in the range and compare their absolute values. If the absolute max value is greater 
than the absolute min value, the maximum number is returned, otherwise – the minimum 
number. Because the formula returns the original and not absolute value, it keeps the sign 
information: 

 

How to highlight max value in Excel 

In situation when you want to identify the largest number in the original data set, the fastest way 
is to highlight it with Excel conditional formatting. The below examples will walk you through two 
different scenarios. 

Highlight highest number in a range 

Microsoft Excel has a predefined rule to format top ranked values, which suits our needs 
perfectly. Here are the steps to apply it: 

1. Select your range of numbers (C2:C7 in our case). 

2. On the Home tab, in the Styles group, click Conditional formatting > New Rule. 

3. In the New Formatting Rule dialog box, choose Format only top or bottom ranked values. 

4. In the lower pane, pick Top from the drop-down list and type 1 in the box next to it (meaning 
you want to highlight just one cell containing the largest value). 

5. Click the Format button and select the desired format. 

6. Click OK twice to close both windows. 



Done! The highest value in the selected range is automatically highlighted. If there is more than 
one max value (duplicates), Excel will highlight them all: 

 

Highlight max value in each row 

Since there is no built-in rule to make the highest value stand out from each row, you will have to 
configure your own one based on a MAX formula. Here's how: 

1. Select all the rows in which you want to highlight max values (C2:C7 in this example). 

2. On the Home tab, in the Styles group, click New Rule > Use a formula to determine which 
cells to format. 

3. In the Format values where this formula is true box, enter this formula: 

=C2=MAX($C2:$E2) 

Where C2 is the leftmost cell and $C2:$E2 is the first row range. For the rule to work, be sure 
to lock the column coordinates in the range with the $ sign. 

4. Click the Format button and choose the format you want. 



5. Click OK twice. 

 

Tip. In a similar manner, you can highlight the highest value in each column. The steps are 

exactly the same, except that you write a formula for the first column range and lock the row 

coordinates: =C2=MAX(C$2:C$7) 

For more information, please see How to create a formula-based conditional formatting rule. 

Excel MAX function not working 

MAX is one of the most straightforward Excel functions to use. If against all expectations it does 
not work right, it's most likely to be one of the following issues. 

MAX formula returns zero 

If a normal MAX formula returns 0 even though there are higher numbers in the specified range, 
chances are those numbers are formatted as text. It's especially the case when you run the MAX 
function on data driven by other formulas. You can check this by using the ISNUMBER function, 
for example: 

https://www.ablebits.com/office-addins-blog/2014/06/10/excel-conditional-formatting-formulas/#conditional-formatting-using-formulas


=ISNUMBER(A1) 

If the above formula returns FALSE, the value in A1 is not numeric. Meaning, you should 
troubleshoot the original data, not a MAX formula. 

MAX formula returns #N/A, #VALUE or other error 

Please check the referenced cells carefully. If any of the referenced cells contains an error, a 
MAX formula will result in the same error. To bypass this, see  That's how to find max value in 
Excel. I thank you for reading and hope to see you on our blog soon! 

Available downloads: 

Excel MAX sample workbook 

You may also be interested in 

 MAX IF formula in Excel 
 Excel MAXIFS function to find highest value with multiple criteria 
 Excel MIN function - usage and formula examples 
 How to find average in Excel 
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1.  Khan says: 
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Well nd easy 

Reply 

2.  Tony O'Brien says: 

May 15, 2020 at 12:41 am 

How to find max, 2nd, 3rd & 4th latest dates by name in another sheet? 
Results e; 
Names in column A 
Dates in column B 
Distance in column C 
& so on 

Regards 
Tony 

Reply 

3.  Adrienne Adams says: 

July 6, 2020 at 5:19 pm 

THANK YOU!!! Do you know how complicated I have been making this for years?! And it 
was as simple as =Max!!! 
You have made my day! 

Reply 

4.  Gurpreet Kaur says: 

July 24, 2020 at 3:19 am 

which one of the following functions is designed to display the maximum value in a range 
of cells with question answer 

Reply 

5.  Graham says: 

September 17, 2020 at 2:34 am 

This is excellent, thanks for saving me a ton of time! 

Reply 
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6.  Nalin says: 

October 25, 2020 at 3:50 pm 

Dear Sir 

can you help me to do a formula to find highest value of 1st numbers letters 

Reply 

7.  Maria says: 

December 18, 2020 at 2:44 pm 

Hi, is it possible to create a formula to find the max value if some of the cells contain 
ranges please? 
i.e. working out that the max value is 505 from the following cells: 
Cell 1. 490 
Cell 2. 500, 
Cell 3. 490-505 

Reply 

8.  Michele Ostrofsky says: 

March 1, 2021 at 2:51 am 

I am trying to find a formula that returns for example to find which State had the highest 
sales for a specific month. Column A is the State and Column B is the sales for the 
specific month. Does anyone know a formula for this? Thanks. 
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In this article, we will learn about how to find the minimum value if it matches multiple 
conditions in Excel.  
Scenario: 
When working with long ranges of data, we need to find the minimum value among 
the range where more than one condition is matching. In simple words finding out 
the minimum value using Excel IF function. IF function returns True or False and 
MIN function looks for the minimum value from the corresponding array. 
Syntax to find min with multiple criteria 

{=MIN (IF (Criteria1=match1),IF(Criteria2=match2, range_min))} 

Note: Use Ctrl + Shift + Enter when working with arrays or ranges in Excel. This will 
generate Curly Braces on the formula by default. DO NOT try to hard code curly 
braces characters. 
Example: 
All of these might be confusing to understand. So, let's test this formula via running it 
on the example shown below. Here we will perform the formula over values with 
given criteria. 
Use the formula: 

{ =MIN( IF( B2:B11="East", IF( C2:C11 > 50 , D2:D11 )))} 

criteria 1 is price must be from the region "East" 
criteria 2 is price where quantity is greater than 50. 
Explanation: 

1. IF( C2:C11 > 50 , D2:D11 ) returns an array of FALSE values and price values 

where quantity is greater than 50. 

{ FALSE ; 303.63 ; 108.46 ; 153.34 ; FALSE ; 95.58 ; 520.01 ; 90.27 ; 177 ; FALSE } 

1. IF( B2:B11="East", IF( C2:C11 > 50 , D2:D11 )) returns an array of remaining price 

values where region is East. 

2. MIN function finds the minimum value from the returned array and that would be the 

required PRICE value. 
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Here we matched the range (B2:B11) with value "East" and quantity (C2:C11) 
greater than 50, which returns the minimum from the price range (D2:D11). Press 
Enter to get the minimum of the range 

 
As you can see we have the MIN value, if criteria match from the range of values.  
Here are some observational notes using the above formula. 
Notes: 

1. The formula returns the min value from the range. 

2. Use MINIFS function in MS Excel 365 version to get the minimum value from data 

having multiple criteria. Learn more about MINIFS function here. 

3. Named range in the formula be used with correct keywords. 

Hope this article about How to Find the Minimum with multiple criteria in Excel is 
explanatory. Find more articles on reference formulas here. If you liked our blogs, 
share it with your fristarts on Facebook. And also you can follow us 
on Twitter and Facebook. We would love to hear from you, do let us know how we 
can improve, complement or innovate our work and make it better for you. Write to 
us at info@exceltip.com. 
Related Articles 
IF with AND function : Implementation of logic IF function with AND function to 
extract results having criteria in Excel. 
IF with OR function : Implementation of logic IF function with OR function to extract 
results having criteria in excel data. 
How to use nested IF function : nested IF function operates on data having 
multiple criteria. The use of repeated IF function is nested IF excel formula. 
SUMIFS using AND-OR logic : Get the sum of numbers having multiple criteria 
applied using logic AND-OR excel function. 
Minimum value using IF function : Get the minimum value using the excel IF 
function and MIN function on array data. 
How to use wildcards in excel : Count cells matching phrases using the wildcards 
in excel 
Popular Articles 
50 Excel Shortcut to Increase Your Productivity : Get faster at your task. These 
50 shortcuts will make you work even faster on Excel. 
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The VLOOKUP Function in Excel : This is one of the most used and popular 
functions of excel that is used to lookup value from different ranges and sheets.  
COUNTIF in Excel 2016 : Count values with conditions using this amazing function. 
You don't need to filter your data to count specific values. Countif function is 
essential to prepare your dashboard. 
How to Use SUMIF Function in Excel : This is another dashboard essential 
function. This helps you sum up values on specific conditions. 

Q13 a) Describe various steps involved in the 

following 
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Explain the various steps involved in the process of organising. 
Medium 

Answer 
Main steps involved in the process of organizing an Organisation are: 1. Identification 

and Division of Work 2. Departmentalisation 3. Assignment of Duties 4. Establishing 

Reporting Relationships! 
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The feature of management which deals with the optimum use of human resource is 

________. 
Medium 

View solution 

 

Job Evaluation is a technique which aims at ___________. 
Easy 

View solution 

View more 

Create custom Assignments 

Customize assignments and download PDF’s 

Make now 

 

https://asktoppr.app.link/Gkc5mPdBc7
https://asktoppr.app.link/Gkc5mPdBc7
https://www.toppr.com/ask/question/the-feature-of-management-which-deals-with-the-optimum-use-of-human-resource-is/
https://www.toppr.com/ask/question/the-feature-of-management-which-deals-with-the-optimum-use-of-human-resource-is/
https://www.toppr.com/ask/question/the-feature-of-management-which-deals-with-the-optimum-use-of-human-resource-is/
https://www.toppr.com/ask/question/the-feature-of-management-which-deals-with-the-optimum-use-of-human-resource-is/
https://www.toppr.com/ask/topic-questions/2376880/medium/
https://www.toppr.com/ask/question/job-evaluation-is-a-technique-which-aims-at-2/
https://www.toppr.com/ask/question/job-evaluation-is-a-technique-which-aims-at-2/
https://www.toppr.com/ask/topic-questions/2376880/easy/
https://asktoppr.app.link/Gkc5mPdBc7


Learn with content 
Watch learning videos, swipe through stories, and browse through concepts 

 Concepts 

 Videos 

 Stories 

 

Change the column width and 

row height 

Excel for Microsoft 365 Excel 2019 Excel 2016 Excel 2013 Excel 2010 Excel 2007 

sIf you find yourself needing to expand or reduce Excel's row widths and column 

heights, there are several ways to adjust them. The table below shows the minimum, 

maximum and default sizes for each based on a point scale. 

Type Min Max Default 

Column 0 (hidden) 255 8.43 

Row 0 (hidden) 409 15.00 

Notes:  

 If you are working in Page Layout view (View tab, Workbook Views group, Page 

Layout button), you can specify a column width or row height in inches, centimeters and 

millimeters. The measurement unit is in inches by default. Go 

to File > Options > Advanced > Display > select an option from the Ruler Units list. If you 

switch to Normal view, then column widths and row heights will be displayed in points. 

 Individual rows and columns can only have one setting. For example, a single column can have a 

25 point width, but it can't be 25 points wide for one row, and 10 points for another. 

Newer versionsOffice 2007 – 2010 
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Set a column to a specific width 

1. Select the column or columns that you want to change. 

2. On the Home tab, in the Cells group, click Format. 

 

3. Under Cell Size, click Column Width. 

4. In the Column width box, type the value that you want. 

5. Click OK. 

Tip: To quickly set the width of a single column, right-click the selected column, click Column 

Width, type the value that you want, and then click OK. 

 

Change the column width to automatically fit the contents (AutoFit) 
 

 
Match the column width to another column 
 

 
Change the default width for all columns on a worksheet or workbook 
 

 
Change the width of columns by using the mouse 
 

 
Set a row to a specific height 
 

 
Change the row height to fit the contents 
 

 
Change the height of rows by using the mouse 
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Change the column width and row height in Excel for Mac 

Change the column width and row height in Excel Online 

Overview of formulas in Excel 

How to avoid broken formulas 

Find and correct errors in formulas 

Excel keyboard shortcuts and function keys 
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Excel functions (by category) 
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How to change the Row height in Excel 
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If you are new to spreadsheet concepts like Row, Column and Cell, please visit following 

link to learn the terms Row, Column and Cell in Excel worksheet before reading the tutorial 

lesson. 

If the default font in your copy of Excel is Calibri and font size is 11, then the default Row 

height for all the rows in all new worksheets of Excel workbooks is 15 Points (20 Pixels). If 

you change the default font type or size, the default Row height also will change in 

new worksheets. 

Following are the values related with Row height in Excel 2019. 

Minimum Maximum Default 

0 (For hidden Row) 409 15 (for default font Calibri, Size 11) 

If you try to increase the Row height beyond 409, Excel will show below dialog box. 

 

Once you start editing the Excel worksheet, the Row height will change according to the 

largest font a Cell can accommodate in a Row. You can verify it by selecting a Row and then 

by increasing the font size from Excel Ribbon. As you increase the font size, the Row height 

also will increase. 

If you have different font sizes in an Excel Row, the Row height of Excel will be according 

to the height of the largest font in any of the cells in that Row. 

Two methods for changing the Row height in Excel worksheet are explaind below. 

Method 1 - How to change Row height by clicking and dragging on boundary gridline 

To change the Row height of a single Row by clicking and dragging on Row 

boundary gridline, follow these steps. 

Step 1 - Select the Row you want to change its height by clicking on Row number. Place the 

mouse pointer on top or bottom gridline of the Row number until the mouse pointer turns to a 

double-sided arrow. You need to place the mouse pointer on top or bottom gridline 

depending on to top or bottom direction you want to change the Row height. In this example, 

Row number 4 and bottom gridline are selected. 

Now click on the bottom gridline of Row number, as shown below. 
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Step 2 - Drag the mouse till the desired height is reached and then drop the mouse to change 

the Row height. As you drag, Excel will keep displaying the changing Row height as tooltip 

message. 



 

  

An animation about how to change the Row height of a single Row by drag and drop is 

copied below. 

 

. 

Similarly, you can change the height of multiple Rows simultaneously by click, drag and 

drop. Select multiple Rows and then click, drag and drop on top-most or bottom-most 

gridline of the Rows selection for changing the height of multiple Rows simultaneously. 

An animation about how to change the Row height of multiple Rows by drag and drop is 

copied below 

 

  

https://www.omnisecu.com/excel/worksheet/how-to-select-range-in-excel-worksheet.php


Method 2 - How to change Row height by entering the exact Row height value 

Sometimes it is difficult to select the exact Row height by using drag and drop method 

described above, because the Row height value keep changing as you drag. Follow below 

steps to change single Row height by entering the exact Row height value. 

Step 1 - Right-click the Row you want to change the height and click the "Row Height" to 

open "Row Height" dialog box from the context menu, as shown in below image. 

 

You can open the "Row Height" dialog box also from Excel Ribbon > "Home" Tab > "Cells" 

> "Format" as shown below. 

 

Step 2 - Enter exact value for Row height in Row height dialog box and click "OK" to change 

the Row height, as shown below. 

 

  

Similarly, you can change the height of multiple Rows simultaneously by typing-in the Row 

height value. Select multiple Rows and then right-click on any Row in the selection. Click the 

"Row Height" from the context menu and type the Row height value in dialog box. Click 

"OK" button. 

  

Do you have any suggestions?    Please let us know! 
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Introduction 

By the end of this lesson, you should be 

able to: 
 Insert rows and columns 

 Delete rows and columns 

Inserting a row 

You can insert a row in a spreadsheet anywhere you need it. Excel moves the 

existing rows down to make room for the new one. 

To insert a row: 
 Click anywhere in the row below where you want to insert the 

new row. 

 Choose Insert Rows from the menu bar. 

 

 

 A new row is inserted above the cell(s) you originally selected. 

OR 

 Click anywhere in the row below where you want to insert the 

new row. 

 Right-click and choose Insert from the shortcut menu. 

 

 



 dialog box opens. 

 

 

 Choose Entire Row. 

 Click OK. 

 A new row is inserted above the cell(s) you originally selected. 

 

 

Select multiple rows before choosing Insert to add rows quickly. Excel 

inserts the same number of new rows you originally selected. 

Inserting a column 

In Excel, you can insert a column anywhere you need it. Excel moves the 

existing columns to make room for the new one. 

To insert a column: 
 Click anywhere in the column where you want to insert a new 

column. 

 Choose Insert Columns from the menu bar. 

 

 

 A new column is inserted to the left of the existing column. 

OR 

 Click anywhere in the column where you want to insert a new 

column. 

 Right-click and choose Insert from the shortcut menu. 

 

 



 The Insert dialog box opens. 

 

Click Entire Column in the Insert dialog box. 

 Click OK. 

 A new column is inserted to the left of the existing column. 

 

 

You can also select multiple columns before choosing Insert to add 

columns quickly. Excel inserts the same number of new columns you 

originally selected. 

Deleting columns and 

rows 

Columns and rows are deleted in much the same manner as inserting columns 

and rows. 

To delete a row and all information in it: 
 Select a cell in the row to be deleted. 

 Choose Edit Delete from the menu bar. 

 Click Entire Row in the Delete dialog box. 

 

 

 Click OK. 



To delete a column and all information 

in it: 
 Select a cell in the column to be deleted. 

 Choose Edit Delete from the menu bar. 

 Click Entire Column in the Delete dialog box. 

 

 

 Click OK. 

Challenge! 
 In column A, type the following names in cells A1, A2, A3, and 

A4, respectively: 

 

Mary in cell A1 

Bob in cell A2 

Susan in cell A3 

John in cell A4 

 In column B, type the following numbers next to each name 

entered in column A: 

 

44 in cell B1 to the right of Mary's name 

28 in cell B2 to the right of Bob's name 

36 in cell B3 to the right of Susan's name 

89 in cell B4 to the right of John's name 

 Insert a column between columns A and B. Type the following 

numbers in the new column B: 

 

76 in cell B1 to the right of Mary's name 

57 in cell B2 to the right of Bob's name 

29 in cell B3 to the right of Susan's name 

61 in cell B4 to the right of John's name 



 Insert a row between rows 2 and 3. Type the following numbers 

in the new row 3: 

Rick in cell A3 

45 in cell B3 

58 in cell C3 

Q13 b) Describe following terms in the 

worksheet 

 Helping Hand 

 24 answers 

 1.1K people helped 

Answer: 

Microsoft Excel terminology 

Workbook — The workbook refers to an Excel spreadsheet file. The 

workbook houses all of the data that you have entered and allows you to 

sort or calculate the results. A workbook that is available to be viewed and 

edited by multiple users on a network is known as a Shared Workbook. 

Worksheet — Within the workbook is where you'll find documents called 

worksheets. Also known as spreadsheets, you can have multiple 

worksheets nestled in a workbook. Tabs at the bottom of the of the screen 

will indicate which of your worksheets you are currently working on. This is 

also known as an active worksheet or active sheet. 

Cell — A cell is a rectangle or block housed in a worksheet. Any data that 

you want to enter into your worksheet must be placed in a cell. Cells can be 

color coded, display text, numbers and the results of calculations, based on 

what you want to accomplish. An Active Cell is one that is currently opened 

for editing. 

punineep and 24 more users found this answer helpful 

THANKS 15 

4.6 

(9 votes) 

Log in to add comment 



Still have questions? 
FIND MORE ANSWERS 

ASK YOUR QUESTION 

New questions in Computer Science 
 

How many times of data can be entered I an excelsheet 

 

https://buddysupplement-com/ultramax-rise/ 

 

the___ process the data 

 

MS excel is used for a)savingfiles b)calculation c)transformation 

 

jisko aana hai aa jaoo no forcedness for coming vwq-dzzk-xmi 

 

4. Ca_si__k5. S_i_tk_y 

 

1. Write down to thenames of the meetingwindos field in outlook 

 

The pages of the presentation are called slide. true or false 

 

Good Evening everyone plss don't Answer 

 

The pages of the presentation you are called slide.  

 

For example, A1 would refer to the first row (specified as 1) and the first 

column (specified as A). Similarly, B3 would be the third row and second 

column. 
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The power of Excel lies in the fact that you can use these cell references in 

other cells when creating formulas. 

Now there are three kinds of cell references that you can use in Excel: 

 Relative Cell References 

 Absolute Cell References 

 Mixed Cell References 

Understanding these different types of cell references will help you work 

with formulas and save time (especially when copy-pasting formulas). 

e cell references in Excel. 

Suppose I have a data set shown below: 

 

To calculate the total for each item, we need to multiply the price of each 

item with the quantity of that item. 

For the first item, the formula in cell D2 would be B2* C2 (as shown below): 

 

Now, instead of entering the formula for all the cells one by one, you can 

simply copy cell D2 and paste it into all the other cells (D3:D8). When you 

do it, you will notice that the cell reference automatically adjusts to refer to 

the corresponding row. For example, the formula in cell D3 becomes 

B3*C3 and the formula in D4 becomes B4*C4. 



 

These cell references that adjust itself when the cell is copied are 

called relative cell references in Excel. 

When to Use Relative Cell References in 

Excel? 

Relative cell references are useful when you have to create a formula for a 

range of cells and the formula needs to refer to a relative cell reference. 

In such cases, you can create the formula for one cell and copy-paste it 

into all cells. 

What are Absolute Cell References in 

Excel? 

Unlike relative cell references, absolute cell references don‘t change when 

you copy the formula to other cells. 

For example, suppose you have the data set as shown below where you 

have to calculate the commission for each item‘s total sales. 

The commission is 20% and is listed in cell G1. 

 



  

To get the commission amount for each item sale, use the following 

formula in cell E2 and copy for all cells: 

=D2*$G$1 

Note that there are two dollar signs ($) in the cell reference that has the 

commission – $G$2. 

What does the Dollar ($) sign do? 

A dollar symbol, when added in front of the row and column number, 

makes it absolute (i.e., stops the row and column number from changing 

when copied to other cells). 

For example, in the above case, when I copy the formula from cell E2 to 

E3, it changes from =D2*$G$1 to =D3*$G$1. 

Note that while D2 changes to D3, $G$1 doesn‘t change. 

Since we have added a dollar symbol in front of ‗G‘ and ‗1‘ in G1, it wouldn‘t 

let the cell reference change when it‘s copied. 

Hence this makes the cell reference absolute. 

When to Use Absolute Cell References in 

Excel? 

Absolute cell references are useful when you don‘t want the cell reference 

to change as you copy formulas. This could be the case when you have a 

fixed value that you need to use in the formula (such as tax rate, 

commission rate, number of months, etc.) 



While you can also hard code this value in the formula (i.e., use 20% 

instead of $G$2), having it in a cell and then using the cell reference allows 

you to change it at a future date. 

For example, if your commission structure changes and you‘re now paying 

out 25% instead of 20%, you can simply change the value in cell G2, and 

all the formulas would automatically update. 

What are Mixed Cell References in 

Excel? 

Mixed cell references are a bit more tricky than the absolute and relative 

cell references. 

There can be two types of mixed cell references: 

 The row is locked while the column changes when the formula is 

copied. 

 The column is locked while the row changes when the formula is 

copied. 

Let‘s see how it works using an example. 

Below is a data set where you need to calculate the three tiers of 

commission based on the percentage value in cell E2, F2, and G2. 

 



Now you can use the power of mixed reference to calculate all these 

commissions with just one formula. 

Enter the below formula in cell E4 and copy for all cells. 

=$B4*$C4*E$2 

 

The above formula uses both kinds of mixed cell references (one where the 

row is locked and one where the column is locked). 

Let‘s analyze each cell reference and understand how it works: 

 $B4 (and $C4) –  In this reference, the dollar sign is right before 

the Column notation but not before the Row number. This means that 

when you copy the formula to the cells on the right, the reference will 

remain the same as the column is fixed. For example, if you copy the 

formula from E4 to F4, this reference would not change. However, 

when you copy it down, the row number would change as it is not 

locked. 

 E$2 – In this reference, the dollar sign is right before the row number, 

and the Column notation has no dollar sign. This means that when 

you copy the formula down the cells, the reference will not change as 

the row number is locked. However, if you copy the formula to the 

right, the column alphabet would change as it‘s not locked. 



How to Change the Reference from 

Relative to Absolute (or Mixed)? 

To change the reference from relative to absolute, you need to add the 

dollar sign before the column notation and the row number. 

For example, A1 is a relative cell reference, and it would become absolute 

when you make it $A$1. 

If you only have a couple of references to change, you may find it easy to 

change these references manually. So you can go to the formula bar and 

edit the formula (or select the cell, press F2, and then change it). 

However, a faster way to do this is by using the keyboard shortcut – F4. 

When you select a cell reference (in the formula bar or in the cell in edit 

mode) and press F4, it changes the reference. 

Suppose you have the reference =A1 in a cell. 

Here is what happens when you select the reference and press the F4 key. 

 Press F4 key once: The cell reference changes from A1 to $A$1 

(becomes ‗absolute‘ from ‗relative‘). 

 Press F4 key two times: The cell reference changes from A1 to A$1 

(changes to mixed reference where the row is locked). 

 Press F4 key three times: The cell reference changes from A1 to $A1 

(changes to mixed reference where the column is locked). 

 Press F4 key four times: The cell reference becomes A1 again. 

You May Also Like the Following Excel Tutorials: 

FREE EXCEL BOOK 

https://trumpexcel.com/excel-keyboard-shortcuts/


Get 51 Excel Tips Ebook to skyrocket your productivity and get 
work done faster 

Name  

Email 

YES - SEND ME THE EBOOK 

12 thoughts on “Absolute, Relative, and Mixed 

Cell References in Excel” 

1. Ely Wagan 
March 2020 at 12:01 pm 

I have these 2 sheets, and I want to copy the exact data from sheet 1 to sheet 
2. 
Note that in sheet 2 it should have those spaces in between before I put the 
name 

Sheet 1 Sheet 2 

Name1 Name1 
Name 2 
Name 3 
Name 4 Name 2 

Name3 

Name 4 

In sheet 2 , I will use the formula to copy a cell it will will just have =B7 
but if I will copy this formula to Sheet2 in the next line which is the position of 
Name 2 it will give me the 
value of Name 4 instead because it skips 2 lines from sheet 1, what will I put 
in the formula so that 
it will tell just to skip one row at a time when copied to Sheet2. 

Thanks for your answer 
2. Mohamed 

August 2019 at 6:39 pm 

Thank you so much, it helps me a lot 
3. Sham 

https://trumpexcel.com/absolute-relative-mixed-cell-references/#comment-13563
https://trumpexcel.com/absolute-relative-mixed-cell-references/#comment-12231


August 2019 at 10:38 am 

Wonderful 
4. Jaspreet Kaur 

July 2019 at 2:19 pm 

Really very helpful, you decribe this in a very easiest way.. Thank you!! 
5. A SOCRATES 

July 2019 at 9:23 pm 

VERY NICE 
6. Maxwell 

June 2019 at 6:35 pm 

This tutorial has make understand the three terms better 
7. Swastik 

June 2019 at 12:51 pm 

It‘s good but would be better if added the differences 
8. Eka 

May 2019 at 12:49 am 

Very helpful tutorial! 
9. Mohammad A 

August 2017 at 10:03 am 

Thanks! I‘m always looking forward to your tutorials, getting notifications by 
email is very useful!! Thanks again 
 Sumit Bansal 

August 2017 at 12:41 pm 

Thanks for commenting.. Happy to know that you find the tutorials useful � 
10. Bhanwar Singh Choudhary 

August 2017 at 12:34 am 

Very vital and informative in a simple manner. I like flow of the article. 

 

 

ADDRESS Function 

https://trumpexcel.com/absolute-relative-mixed-cell-references/#comment-12198
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Provide a cell reference by taking a row and column number 

  

  

  

  

  

What is the Cell ADDRESS Function? 

The cell ADDRESS function is categorized under Excel Lookup and Reference functions. It 

will provide a cell reference (its ―address‖) by taking the row number and column letter. The 

cell reference will be provided as a string of text. The function can return an address in a 

relative or absolute format and can be used to construct a cell reference inside a formula. 

As a financial analyst, cell ADDRESS can be used to convert a column number to a letter, or 

vice versa. We can use the function to address the first cell or last cell in a range. 

  

Formula 

=ADDRESS(row_num, column_num, [abs_num], [a1], [sheet_text]) 

  

The formula uses the following arguments: 

1. Row_num (required argument) – This is a numeric value specifying the row number to be 
used in the cell reference. 

2. Column_num (required argument) – A numeric value specifying the column number to be 
used in the cell reference. 

3. Abs_num (optional argument) – This is a numeric value specifying the type of reference to 
return: 

  

4. A1(optional argument) – This is a logical value specifying the A1 or R1C1 reference style. 

In R1C1 reference style, both columns and rows are labeled numerically. It can either be 

TRUE (reference should be A1) or FALSE (reference should be R1C1).  

 When omitted, it will take on the default value TRUE (A1 style). 

5. Sheet_text (optional argument) – Specifies the sheet name. If we omit the argument, it will 
take the current worksheet. 

https://corporatefinanceinstitute.com/resources/excel/functions/
https://corporatefinanceinstitute.com/resources/careers/jobs/financial-analyst-job-description/
http://www.linkedin.com/shareArticle?mini=true&url=https://corporatefinanceinstitute.com/resources/excel/functions/cell-address-excel/&summary=ADDRESS+Function
https://www.facebook.com/sharer/sharer.php?u=https://corporatefinanceinstitute.com/resources/excel/functions/cell-address-excel/
https://twitter.com/intent/tweet?text=ADDRESS+Function&url=https://corporatefinanceinstitute.com/resources/excel/functions/cell-address-excel/
https://wa.me/?text=https://corporatefinanceinstitute.com/resources/excel/functions/cell-address-excel/&summary=ADDRESS+Function
https://corporatefinanceinstitute.com/resources/excel/functions/cell-address-excel/


  

How to use the ADDRESS Function in Excel? 

To understand the uses of the cell ADDRESS function, let us consider a few examples: 

  

Example 1 

Suppose we wish to convert the following numbers into Excel column references: 

  

 

  

The formula to use will be: 

  

 

  

We get the results below: 

  

 

  

The ADDRESS function will first construct an address containing the column number. It was 

done by providing 1 for row number, a column number from B6, and 4 for the abs_num 

argument. 

After that, we use the SUBSTITUTE function to take out the number 1 and replace with ―‖. 

  

Example 2 

The ADDRESS function can be used to convert a column letter to a regular number, e.g., 21, 

100, 126, etc. We can use a formula based on the INDIRECT and COLUMN functions. 

Suppose we are given the following data: 



  

 

  

The formula to use will be: 

  

 

  

We get the results below: 

  

 

  

The INDIRECT function transforms the text into a proper Excel reference and hands the 

result off to the COLUMN function. Then, the COLUMN function evaluates the reference 

and returns the column number for the reference. 

  

A few notes about the Cell ADDRESS Function 

1. If we wish to change the reference style that Excel uses, we should go to the File tab, click 
Options, and then select Formulas. Under Working with formulas, we can select or clear the 
R1C1 reference style checkbox. 

2. #VALUE! error – Occurs when any of the arguments are invalid. We would get this argument 
if: 

o The row_num is less than 1 or greater than the number of rows in the spreadsheet; 
o The column_num is less than 1 or greater than the number of columns in the 

spreadsheet; or 
o Any of the supplied row_num, column_num or [abs_num] arguments are non-

numeric or the supplied [a1] argument is not recognized as a logical value. 

  

Click here to download the sample Excel file 

  

https://corporatefinanceinstitute.com/assets/ADDRESS-Function.xlsx


Additional resources 

Thanks for reading CFI’s guide to important Excel functions! By taking the time to learn and 

master these functions, you’ll significantly speed up your financial analysis. To learn more, 

check out these additional CFI resources: 

 Excel Functions for Finance 
 Advanced Excel Formulas Course 
 Advanced Excel Formulas You Must Know 
 Excel Shortcuts for PC and Mac 

Free Excel Tutorial 

To master the art of Excel, check out CFI’s FREE Excel Crash Course, which teaches you 

how to become an Excel power user.  Learn the most important formulas, functions, and 

shortcuts to become confident in your financial analysis. 

  

 

Launch CFI’s Free Excel Course now 

to take your career to the next level and move up the ladder! 

 

CFI logo 

 

Q14. a) What tools are available to 

customize our PowerPoint presentation? 
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Related Posts 

 

4 eBooks to help master the top office 

programs 

November 20, 2019 

eBooksExcelphotoshopPowerPointword 

Photoshop and Excel have become required daily tools for many roles but can seem daunting 

to those who have little experience using them. Whether you are used to using technology at 

work or unfamiliar with a new program, learning the basics of how to use the most popular 

office programs and software is a great way to develop within or outside of your role and stay 

up to date on the latest industry trends and spruce up your CV. Check out our top 4 office 

software eBooks here. … 

 

is one training format that has both adapted with technology and stood the test of time: 

eBooks. Here are 4 reasons to implement eBooks into your learning strategy. … 

https://bookboon.com/blog/2019/11/4-ebooks-to-help-master-the-top-office-programs/
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How to improve soft skills in your workplace 

in Bangladesh 

March 7, 2019 

eBookseLearninglearning and developmentmobile learningSoft SkillstrainingWorkplaceWednesday 

Over the last few years, Bangladeshi businesses have begun to put more focus on soft skills 

training. With events and organisations centred around soft the importance of soft skills, 

Bangladesh is moving towards a soft skills focused workforce. Interpersonal skills, 

employability skills, leadership, and entrepreneurial development have become more 

important to organisations than ever before. The Learning and Development industry is 

growing and so is the need for information on soft skills training for leaders and 

managers.  Here are four ways to train your employees in soft skills. … 

https://bookboon.com/blog/2019/03/how-to-improve-soft-skills-in-your-workplace-in-bangladesh/
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Q14 b) Write the steps for the following 

action for creation of power point 

presentation 

ow to Make & Give Great 
PowerPoint Presentations 
(In 5 Simple Steps) 
by Andrew Childress15 Nov 2019 

Difficulty:BeginnerLength:LongLanguages:  

That strong response is usually rooted in our personal horror stories, like 

an embarrassing slip-up in a presentation for a class, or a talk at work that 

https://tutsplus.com/authors/andrew-childress
https://bookboon.com/blog/2019/02/how-to-effectively-use-ebooks-in-workplace-training/


fell flat. Giving a great PowerPoint presentation is a skill. And it's one 

that anyone can build and improve upon.  

Are you ready to learn how to make a great presentation in PowerPoint and 

present it like a pro? (graphic source) 

Giving presentations can feel overwhelming. It's hard to know where to 

start, even if you're willing to put in the time. This tutorial can help: 

  

PRESENT AT I ONS  

Make an Impact—How to Start a Presentation Strong and End Powerfully 

Julia Melymbrose 

 

Becoming a motivational speaker or renowned presenter doesn't have to 

be your main goal. You can become a proficient and effective speaker in a 

variety of contexts.  

You can learn a professional process that'll help you make a great 

presentation and present like a pro. That's why I've broken down the art of 

building a presentation into lists and actionable steps you can readily follow 

in this tutorial. 

We combine technical skills in Microsoft PowerPoint with best practices for 

presenting information. This tutorial explains how to do a PowerPoint 

presentation, step by step. 

Guide to Making Great Presentations (Free eBook 
Download) 

Also, take what you'll learn in this tutorial further. Download our free 

eBook: The Complete Guide to Making Great Presentations. In it, you'll 

https://graphicriver.net/item/public-business-training-conference-workshop/18453078
https://business.tutsplus.com/tutorials/how-to-start-a-presentation-strong-and-end-powerfully--cms-27601
https://business.tutsplus.com/tutorials/how-to-start-a-presentation-strong-and-end-powerfully--cms-27601
https://business.tutsplus.com/tutorials/how-to-start-a-presentation-strong-and-end-powerfully--cms-27601
https://business.tutsplus.com/tutorials/how-to-start-a-presentation-strong-and-end-powerfully--cms-27601
https://tutsplus.com/presentations-ebook


learn the complete presentation process of how to write your presentation 

effectively, design it like a pro, and more.  

 

Now follow along to learn step-by-step how to make a great presentation in 

PowerPoint that's ready to present to an eager audience.  

1. Content Comes First 

The first part of writing a successful PowerPoint-based presentation has 

nothing to do with PowerPoint. It's all about the content that you'll put inside 

of it. 

You're making a mistake if you start by looking at the design of your 

PowerPoint presentation or by making animations for your slides. Instead, 

prioritize writing the content for your presentation first. Write your content 

before you even open PowerPoint. 

Plan the content of your presentation first (Image source: Envato Elements) 

In summary, keep these two simple points in mind when you start writing 

the content for your presentation: 

1. Bad. You start off creating a PowerPoint presentation by opening the 

app and choosing a theme and your favorite colors. 

2. Good. Put yourself in your audience's shoes. Decide what they 

should feel and know at the end of your presentation. 

I use a simple note-taking app like Notes for Mac or Evernote to help me 

organize my thoughts. I also jot down my content ideas on a spare napkin 

or the back of a notebook. For this exercise, grab a piece of paper and 

follow each of the content-writing steps. 

Remember: The point is that we decide on what we want to say before 

we begin saying it in PowerPoint.  

https://elements.envato.com/pretty-girl-working-on-her-computer-in-cafe-9AG2345


Let's break down the detailed steps I use when writing presentations using 

Microsoft PowerPoint: 

Advertisement 

Step 1. Write Down Your Presentation's Goal 

I've been guilty of throwing all my data or ideas into a PowerPoint file and 

seeing what it looks like when I'm finished.  

This directionless wandering is a surefire recipe for presentations that'll 

bore your audience and lose their attention. That's why it's so important 

to set your presentation goal first. 

Here are some examples of goal setting for a presentation: 

 To educate the audience on the latest developments with the Swift 

programming language. 

 To update my team on the progress of a major project at the 

company. 

 To persuade the audience to use your product to grow their own 

freelance business. 

  

PRESENT AT I ONS  

15 Bad Business Presentation Mistakes (And How to Avoid Poor Results) 

Brad Smith 

 

You could break these main types of presentations down into other 

categories. But I find that this is a simple and helpful way to start setting 

your goal. 

https://business.tutsplus.com/tutorials/business-presentation-mistakes--cms-27325
https://business.tutsplus.com/tutorials/business-presentation-mistakes--cms-27325
https://business.tutsplus.com/tutorials/business-presentation-mistakes--cms-27325
https://business.tutsplus.com/tutorials/business-presentation-mistakes--cms-27325


Before you ever open PowerPoint, start by first writing down (or typing) the 

goal for your presentation. 

Before you start writing your presentation or pulling together all the data 

and visuals do this. Write the goal for your presentation on a piece of 

paper, or the app taking note of choice. Put it in front of you throughout the 

content writing process so you won't lose track of your ultimate goal for 

your presentation. 

Step 2. Define Your Audience 

Who will you be speaking to? What do they already know about the topic at 

hand? 

It seems so obvious, but many presenters use a one-size-fits all approach 

to sharing information. Instead, you've got to tailor your content to who will 

hear it and what they know about the topic beforehand. 

A presentation about the future of blockchain should be different if I'm 

speaking to a room of PhD economists that it would be if I were presenting 

to a group of high school students. Tailoring your content to the audience 

helps them get the most from your presentation. 

Do This: Describe your primary audience below the goal you wrote in 

step one. Write down what their level of familiarity with the topic is, and 

anything they might have in common. 

After you've established the goal, add your target audience to your 

presentation plan.  

Consider all the following when defining your audience: 

 What do they know about the topic before attending your 

presentation? 

 What do they know about you coming into the presentation? Your 

presentation could range from your daily colleagues to a complete 

group of strangers. 

https://www.vox.com/cards/bitcoin


 Decide upon their expectations for the presentation. Are they coming 

to find a solution to a problem, learn something new, or to be 

entertained? 

Consider all these factors when you're writing content. You'll approach an 

audience of your peers differently than an unfamiliar audience. 

Best of all, you can create many versions of your presentation if your 

audience changes. Each time your audience changes, you can tweak the 

presentation to match.  

Learn more about how to put your audiences needs first, as well as how to 

make a great PowerPoint presentation that's memorable and persuasive:  

  

PRESENT AT I ONS  

How to Make a Persuasive PowerPoint Presentation (With Powerful Tips) 

Celine Roque 

 

Step 3. Set Your Key Presentation Points 

We've defined the presentation's goal and considered our audience. Now, 

it's time to write a presentation outline that fits with both. 

I used to blow off the idea of writing an outline for my presentations. I 

thought I had all the ideas and key points clearly defined in my own mind. 

Unfortunately, this is a false sense of clarity. We're biased to understand 

our own ideas far better than anyone else is. 

https://business.tutsplus.com/tutorials/how-to-make-a-persuasive-powerpoint-presentation--cms-25459
https://business.tutsplus.com/tutorials/how-to-make-a-persuasive-powerpoint-presentation--cms-25459
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Below the audience we defined, start writing down the key supporting ideas 

for your presentation. Aim for four to five major points that'll be the 

cornerstone of your presentation. 

Set the major points as bullet points for your outline - in your note taking 

app of choice. 

If I'm writing a persuasive speech each of the major bullet points will be key 

ideas that reinforce my goal. Again, tie everything you write back to that 

original goal. 

There are no rules for writing an outline, and there's no reason to belabor 

the process. The goal is to solidify the structure of our content and lay 

out the road map for our presentation with each key idea as its own bullet 

point. 

Step 4. Build Your Supporting Points 

Let's keep working on that outline. We've identified the main points. It's time 

to go one level deeper.  

For each of our major ideas, let's add a second level of detail. These are 

the supporting points for each of the major ideas, or basically the second 

level of your outline. 

We've built a pyramid of content now. The bottom of the pyramid that 

guides the entire presentation is the goal. On top of it is the outline, with 

supporting points that drive the goal.  

For more detail, learn more about the presentation writing process in this 

helpful tutorial:  

  

PRESENT AT I ONS  

https://business.tutsplus.com/tutorials/how-to-write-a-professional-powerpoint-presentation-discover-the-writing-process--cms-25682
https://business.tutsplus.com/tutorials/how-to-write-a-professional-powerpoint-presentation-discover-the-writing-process--cms-25682


How to Write a Professional PowerPoint Presentation (Discover the Writing 

Process) 

Brad Smith 

 

In many ways, the hard work is finished. We now have all the pieces to 

build a great PowerPoint presentation. We just need to assemble them. 

2. Add Your Content 

At this point, you should have four key items written down. Now we're ready 

to use them to start putting together our presentation. These key items are: 

 The Presentation Goal. The driving force of why you're presenting 

and what your audience should understand at the end. 

 The Audience Defined. Who are you presenting to? What do they 

know coming into this presentation? 

 The Outline. The road map for your presentation, the guideposts that 

keep us on track when designing and giving a presentation. 

 The Support. The individual facts, ideas, and data that build the 

case for what you'll share with your audience. 

With that in hand, it's now time to jump over to PowerPoint and start 

building your presentation. Let's open PowerPoint and start working. 

Step 1. Work With PowerPoint's Outline View 

So far, we've been building an outline on paper or in another app. But 

PowerPoint actually allows you to build a presentation from outline view. 

Take the outline you've written down on paper and start loading it into your 

PowerPoint presentation.  

https://business.tutsplus.com/tutorials/how-to-write-a-professional-powerpoint-presentation-discover-the-writing-process--cms-25682
https://business.tutsplus.com/tutorials/how-to-write-a-professional-powerpoint-presentation-discover-the-writing-process--cms-25682
https://business.tutsplus.com/tutorials/how-to-write-a-professional-powerpoint-presentation-discover-the-writing-process--cms-25682
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To switch to outline view, find the View tab on the PowerPoint ribbon and 

click on Outline View. On the left side of the window, click next to one of 

the white boxes to get started. 

To add a new major point, press Enter. As you add a new bullet point to 

the outline view, PowerPoint will update the slide with the points. 

Press Control + Enter to add a second level of outline points. Type your 

outline points, and PowerPoint will populate the slides with your data. 

Using Outline view in PowerPoint allows you to build your PowerPoint 

slides using a traditional presentation Outline view in the sidebar. 

Use the outline you wrote in the first half of this tutorial to build the content 

on your PowerPoint slides. Of course, you'll want to rewrite what's in your 

outline in a presentation-friendly way. For example, keep the bullet points 

short and succinct to hold your audience's attention. 

Learn more about working with PowerPoint views in our guide: 

  

MI CROSOFT  POW ERPOI NT  

How to Work With Views in Microsoft PowerPoint 

Andrew Childress 

 

Step 2. Use Short Tips for Each Slide 

We've all sat through enough presentations where the speaker read the 

contents of a presentation word-for-word. 

This is the fastest way to lose your audience's attention. If I wanted to read 

slides, I would do it on my own and skip listening to someone do it for me. 

https://business.tutsplus.com/tutorials/how-to-work-with-powerpoint-views--cms-28442
https://business.tutsplus.com/tutorials/how-to-work-with-powerpoint-views--cms-28442
https://business.tutsplus.com/tutorials/how-to-work-with-powerpoint-views--cms-28442
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Bullet points shouldn't be full sentences, pulled from your outline. They 

should be summaries of your ideas that you'll elaborate on while 

speaking.  

Make the font size large for the best readability. And keep sentences short 

for your audience's attention span. Keeping your bullet points concise helps 

make a great PowerPoint presentation that's more memorable. 

Step 3. Put Layouts in PowerPoint to Use 

Layouts are the preset combination of elements like content boxes and 

placeholders for images and media. There are several choices to work 

with. When used well, they can make a good PowerPoint presentation 

great.   

To choose a layout, find the Layout button on the Home tab of the 

PowerPoint ribbon. Click on the dropdown option to choose a different 

layout for a different arrangement of the content on your slides. 

  

MI CROSOFT  POW ERPOI NT  

How to Change Slide Layouts in PowerPoint in 60 Seconds 

Andrew Childress 

 

These layouts are different ways to adapt your content. No matter what 

content you've typed in Outline view, changing the outline will keep the 

content but adapt it to a new arrangement. 

Layouts are combinations of elements on a PowerPoint slide. 

Depending on the PowerPoint presentation theme you're using, you should 

select a layout that gives you the elements that you want. If I know that my 

https://business.tutsplus.com/tutorials/how-to-change-slide-layouts-in-powerpoint--cms-28146
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slide will include images, I'll make sure to pick a layout with an image 

placeholder.  

To make a great PowerPoint presentation, choose the best slide layout that 

fits the content of each of your slides. It should also fit the overall flow of 

your presentation. 

3. Build the Look of Your PowerPoint 
Presentation 

You'll be much more confident if you know that your presentation's theme 

looks great. PowerPoint has some built-in themes that are a good starting 

point. But there are much better alternatives that are unique. 

Step 1. Work With a Custom PowerPoint Theme  

My favorite resource right now for giving a PowerPoint presentation is 

Envato Elements. This is really an incredible, all-you-can-eat buffet of great 

looking PowerPoint presentation themes. For one flat rate fee, you get 

access to a huge library of creative assets:  

Envato Elements has great PowerPoint presentation templates. 

That access includes hundreds of PowerPoint templates that you can use. 

If you're a subscriber, you can download an unlimited number of great 

PowerPoint presentation themes for your next big presentation. 

The best part about custom themes is that they include ideas for your 

slides. They'll include layouts that you can easily place your own content 

into.  

I'm almost always preparing a presentation on a tight deadline. I hardly 

have the time to build all my own illustrations, graphics and visuals from 

scratch. Elements has enough presentation themes for any type of 

presentation. 

https://elements.envato.com/presentation-templates/compatible-with-powerpoint
https://elements.envato.com/presentation-templates/compatible-with-powerpoint


You can also find great PowerPoint templates for individual sale on Envato 

Market to download one-at-a-time. Discover more trending presentation 

designs in this curated selection:    

  

MI CROSOF T  POW ERPOI NT  

40+ Awesome PowerPoint Templates (With Cool PPT Presentation Designs 2020) 

Sean Hodge 

 

Step 2. Change Themes and Styles for Your Presentation 

To change your PowerPoint theme, navigate to the Design tab on 

PowerPoint's ribbon. Click the drop-down arrow. Choose one of the 

thumbnails to change your PowerPoint theme to the best one for your 

presentation. 

Change theme designs in PowerPoint.  

Using themes and adding your content goes hand-in-hand. As you change 

your theme, you might need to rework the content so that it appears 

correctly. Learn more about how to work with professional PowerPoint 

templates to make your presentation: 

  

MI CROSOFT  POW ERPOI NT  

How to Create a PowerPoint Presentation From a PPT Template 

Sven Lenaerts 

https://graphicriver.net/popular_item/by_category?category=presentation-templates/powerpoint-templates
https://business.tutsplus.com/articles/awesome-powerpoint-templates-with-cool-ppt-designs--cms-27742
https://business.tutsplus.com/articles/awesome-powerpoint-templates-with-cool-ppt-designs--cms-27742
https://business.tutsplus.com/articles/awesome-powerpoint-templates-with-cool-ppt-designs--cms-27742
https://business.tutsplus.com/articles/awesome-powerpoint-templates-with-cool-ppt-designs--cms-27742
https://business.tutsplus.com/tutorials/how-to-create-a-powerpoint-presentation-from-a-template--cms-26727
https://business.tutsplus.com/tutorials/how-to-create-a-powerpoint-presentation-from-a-template--cms-26727
https://business.tutsplus.com/tutorials/how-to-create-a-powerpoint-presentation-from-a-template--cms-26727
https://business.tutsplus.com/tutorials/how-to-create-a-powerpoint-presentation-from-a-template--cms-26727


 

4. Add Visualizations to Your 
Presentation 

Visualizations are a great way to break up the monotony of bullet points in 

your PowerPoint presentation. A well-placed chart or stunning image can 

hold your audience's attention or provide a visual representation of a fact.  

Check out the tutorials below to learn about several key visualization 

techniques in PowerPoint. You'll also learn how to use them to make great 

PowerPoint presentations for class or work: 

  

How to Add Videos to Your PowerPoint Presentations 

 

Videos are a tad harder to add to your PowerPoint presentations than it'd seem at first 

glance. In this detailed tutorial, you'll learn step-by-step how to... 

 

Bob Flisser 

18 Mar 2014 

OFFICE 

  

How to Make Great PPT Charts & Graphs in Microsoft PowerPoint 

 

PowerPoint charts and graphs are powerful visual aids. Learn how to create great looking charts 

and graphs right inside of Microsoft PowerPoint using this... 

https://business.tutsplus.com/tutorials/how-to-add-videos-to-your-powerpoint-presentations--cms-20059
https://business.tutsplus.com/tutorials/how-to-add-videos-to-your-powerpoint-presentations--cms-20059
https://tutsplus.com/authors/bob-flisser
https://business.tutsplus.com/categories/office
https://business.tutsplus.com/tutorials/how-to-make-great-charts-in-microsoft-powerpoint--cms-28570
https://business.tutsplus.com/tutorials/how-to-make-great-charts-in-microsoft-powerpoint--cms-28570


 

Andrew Childress 

23 Apr 2020 

MICROSOFT POWERPOINT 

  

How to Get Started With Using SmartArt in PowerPoint 

 

Discover how to use SmartArt to create great looking charts, diagrams, process maps, and 

graphic visualizations inside of Microsoft PowerPoint quickly. 

 

Andrew Childress 

14 Feb 2017 

MICROSOFT POWERPOINT 

  

How to Insert an Excel File into PowerPoint in 60 Seconds 

 

In this quick-fire video, learn how to take your spreadsheet file and copy it from Excel over to 

embed in PowerPoint. Also, control how you style your data. 

 

Andrew Childress 

06 Feb 2017 

MICROSOFT POWERPOINT 

I add visualizations near the end of the process after I've selected the 

theme for the entire presentation. 

https://tutsplus.com/authors/andrew-childress
https://business.tutsplus.com/categories/microsoft-powerpoint
https://business.tutsplus.com/tutorials/how-to-get-started-with-smartart-in-powerpoint--cms-28171
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5. Prepare in PowerPoint and Then 
Present 

It's finally showtime. All your hard work to write your content and package it 

into an attractive presentation is about to pay off.  

Let's look at how to get ready to give a great presentation using 

PowerPoint. For many of us, this is the most intimidating stage in the 

process—where we step up and deliver.  

PowerPoint has several great features to cut down on your presentation 

anxiety. Use these while preparing to speak. 

Step 1. Prepare Your Speaker Notes 

Since our slides don't contain exactly what we'll say while presenting, 

the Speaker Notes is where to place that information. 

At the bottom of PowerPoint is a Notes button. Click it to open the speaker 

notes. This is a great place to type in and capture your cues or key 

speaking points for your presentation. 

Use PowerPoint speaker notes. 

Learn how to add Speaker Notes to your PowerPoint presentation quickly:  

  

MI CROSOFT  POW ERPOI NT  

How to Add Speaker Notes to PowerPoint in 60 Seconds 

Andrew Childress 

 

https://business.tutsplus.com/tutorials/how-to-add-speaker-notes-to-powerpoint--cms-27976
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Where do these notes show up? You'll see them in either presentation 

mode (more on that in a minute) or if you print a copy of the slides out. 

Either way, I use these to prompt my speech and remember my essential 

talking points. 

Step 2. Work With Presenter View in PowerPoint 

Presentation mode is perfect for those times when you've connected your 

device to an external display. What you see on your own screen can be 

different than what your audience sees. 

To enter this mode, check the Use Presenter View box on the Slide 

Show tab of PowerPoint's ribbon. When you enter Slide Show view (F5 is 

the keyboard shortcut), you'll enter a Custom Presenter view. 

Use Presenter View in PowerPoint. 

When you enter the Slide Show view, you'll have a different view on your 

own monitor, complete with the speaker notes below. 

Example of speaker notes in your own monitor view. 

If you've got a second screen, this is the best way to present. You'll keep 

your notes in front of you and have a quick view of the next slide in your 

deck. 

5 Quick PowerPoint Presentation Tips 

Now that you know how to make and give great PowerPoint presentations 

for class or work, here are a few extra tips. These will help you nail down 

your presentation and leave a great impression on your audience.    

1. Use Legible Fonts 

The first tip is to use legible fonts. This will ensure that your audience can 

read the contents of your presentation without having to squint their eyes. 



Stick to traditional serif and sans-serif fonts and avoid using decorative or 

script fonts.  

Batagor PowerPoint Template 

2. Make Eye Contact With Your Audience 

Maintaining eye contact with your audience is a great way to establish a 

connection with them and keep them interested. Focus on a few people in 

each section of the room and look at them often throughout the 

presentation.  

3. Be Careful With Colors 

It goes without saying that your presentation should include your brand or 

company colors. But, be careful not to overdo it. Otherwise your audience 

will have a hard time focusing on the topic of your presentation. 

Healthy - Medical PowerPoint Template 

4. Embrace White Space 

Ensure that there‘s plenty of space between different elements on your 

slides. This will help them stand out more instead of making your slide 

appear cluttered.  

5. Use Visual Aids 

Finally, don‘t be afraid of using visual aids to help present information and 

data in your presentation. Photos, charts, graphs, infographics, and even 

illustrations will make it easier for everyone to envision what you‘re talking 

about.  

 

Find More Great PowerPoint Templates: 
5 Top Designs 

https://elements.envato.com/batagor-powerpoint-template-NNK838
https://elements.envato.com/healthy-medical-powerpoint-google-slide-keynote-4MPBK5


Finding a great PowerPoint template isn't hard once you know where to go. 

We‘ve mentioned earlier that Envato Elements has thousands of great 

PowerPoint templates to choose from. Take a look at some of our best-

selling PowerPoint templates from Envato Elements below:  

1. Sparrow - Creative Agency PowerPoint Template 

 

The Sparrow is a creative and colorful PowerPoint template best suited for 

agencies or freelancers such as designers or artists. The template comes 

with over 100 unique slides that are based on master slides. Customize 

fonts and colors and use the drag and drop placeholders to quickly add 

your images.    

2. Yura PowerPoint Template 

Yura is a clean and minimal PowerPoint template. Use it for any type of 

presentation thanks to its versatile design. The template has 100 unique 

slides and was designed in widescreen format. You‘ll also get plenty of 

charts, graphs, and other infographic elements to create a powerful 

presentation.   

3. Cleira - Elegant PowerPoint Template 

 

The Cleira template is a perfect choice if you need to create a stylish and 

elegant presentation. The template has more than 150 slides and five color 

variations. It‘s entirely based on master slides, so you‘ll have an easy time 

editing it.  

4. Mild - Vibrant PowerPoint Template 

The Mild is a vibrant PowerPoint template. It can be used for business or 

portfolio presentations. The template comes with 35 unique slides and 50 

premade color schemes. Use these as a starting point for your presentation 

design. The template is easy to customize and was designed in full HD 

resolution.  

https://elements.envato.com/presentation-templates/compatible-with-powerpoint/
https://elements.envato.com/presentation-templates/compatible-with-powerpoint/
https://elements.envato.com/sparrow-creative-agency-powerpoint-presentation-K27TGZ
https://elements.envato.com/yura-powerpoint-template-AXAQUQ
https://elements.envato.com/cleira-powerpoint-templates-TYBHKY
https://elements.envato.com/mild-powerpoint-template-GYY7VG


5. Lekro PowerPoint Template 

 

The Lekro is a professional PowerPoint template. It‘s perfect for any type of 

corporate or business presentation. It's got more than 60 unique slides and 

comes with editable charts. The template is based on master slides for 

easier editing.  

To see even more great PowerPoint templates, be sure to check out these 

roundups: 

  

MI CROSOFT  POW ERPOI NT  

25+ Best Brochure PowerPoint Templates Free + Pro to Download for 2020 

Andrew Childress 

 

  

BUSI NESS  

30 Best SWOT Analysis PowerPoint Templates (Free & Premium PPTs 2020) 

Sarah Joy 

 

  

MI CROSOFT  POW ERPOI NT  

40+ Awesome PowerPoint Templates (With Cool PPT Presentation Designs 2020) 

https://elements.envato.com/lekro-powerpoint-presentation-67YW3M
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Sean Hodge 

 

Download Our Free eBook on Making 
Great Presentations 

 

Grab The Complete Guide to Making Great Presentations now for 

FREE with a subscription to the Tuts+ Business Newsletter. Get your ideas 

formed into a powerful presentation that'll move your audience! 

Explore More PowerPoint Tutorials on 
Tuts+ 

Also, we've been building a library of PowerPoint and presentation 

skills here on Envato Tuts+. Check out more great PowerPoint tutorials to 

keep learning: 

  

OFFI CE  

How to Use and Edit PowerPoint Master Slides 

Bob Flisser 

 

https://business.tutsplus.com/articles/awesome-powerpoint-templates-with-cool-ppt-designs--cms-27742
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  

How to Make Good PowerPoint Slide Designs Even Better in 2020 

Sven Lenaerts 

 

  

MI CROSOFT  POW ERPOI NT  

How to Make PPT Slide Layouts in Microsoft PowerPoint 

Andrew Childress 

 

What's your top tip for how to make a great PowerPoint presentation? Let 

me 

B  Save the presentation as Lab1.pptx.  

Ans .  ASSIGNMENT: PowerPoint Lab 1 

ITEMS COVERED IN THIS LAB 

 Create a Blank Presentation 

 Save a Presentation 

 Apply a Design Theme 

 Compare Presentation Views 

 Format Text 

 Insert SmartArt 

 Insert & Modify Shapes 

 Edit & Duplicate Slides 

https://business.tutsplus.com/tutorials/how-to-make-your-powerpoint-presentation-design-better--cms-28172
https://business.tutsplus.com/tutorials/how-to-make-your-powerpoint-presentation-design-better--cms-28172
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Instructions 

1. Open a Blank presentation 
2. Save the presentation as PowerPointLabOne.pptx 
3. Add a Title to the first slide: the name of your college 
4. Type your first name and last name in the Subtitle section 
5. Add a New Slide which has a Title and Content 
6. Add a title to the second slide ―My Future Goals‖ 

7. In the Content section of the second slide, add at least three Personal Goals 

8. Right click on the second slide from the left panel, then choose Duplicate Slide 
9. Highlight the text in the Content area of the third slide. Under the Home tab, 

click Convert to SmartArt, then choose Basic Cycle 
10. Change the SmartArt Colors to Colorful—Accent Colors 
11. Change the SmartArt Styles to 3D Polished 
12. From the left panel, drag the third slide between the first and second slide 
13. Change the layout of the third slide, the slide that does not have the SmartArt, 

to Comparison 
14. Leave the title ―My Future Goals‖ 
15. In the head of the first column, type ―Goals in College,‖ then center the heading 
16. In the head of the second column, type ―Goals after College,‖ then center the 

heading 
17. Add at least three goals in each section 
18. Make sure that slide #3 is selected from the left panel, then add a New Slide 
19. Change the layout of the new slide to Blank 
20. Insert a Graduation Online Picture from the Office ClipArt—Choose any image of 

your choice 
21. Change the ClipArt size to 3” X 3” and position it in the middle of the slide 
22. Apply the Wisp Design Theme 
23. Save and upload PowerPointLabOne.pptx to your instructor 

 

de: the name of your college 

Ans.  

Type your first name and last name in the Subtitle section 

Ans. 



TITLE Subtitle First name Last name Institutional affiliation (in original 

language) English), Country (in English) Abstract A short abstract 

(summary) of your contribution is inserted here. Please limit this to 

300 words. Do not use references, footnotes or images in this 

section. It should be as concise as possible. It should be complete, 

self paper itself. The abstract should be informative, giving the scope 

and emphasizing the main conclusions, results, or significance of the 

work described. Use verdana, 10, italic to write this part of the text. 

Keywords: Maximum 5. Use Subheading (if necessary) Full papers 

will be published in conference proceeding Only papers formatted 

according to the guidelines indicated in this document can be 

accepted for publication. The other condition for paper is registered 

for the conference. Additionally, a signed “copyright license 

agreement” form must be sent at the same time of the paper 

submission. 

Add a New Slide which has a Title and 

Content 

Ans . Title a slide 

PowerPoint for Microsoft 365 PowerPoint for Microsoft 365 for Mac More...There are multiple way 

to add titles to your slides in PowerPoint. Use the Layout option to create a standalone title 

slide or to add a title to a slide that contains other text. You can also use the Outline view to 

create and update the titles of your slides.  

Select a heading below to open it and see the detailed instructions. 

Microsoft 3652013-2019macOSWeb 

Select a heading below to open it and see the detailed instructions. 
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Find missing slide titles and edit them 
 

 
Use the Layout option to title a slide 
 

 
Use Outline view to title a slide 
 

 
Put a title on a slide, but make the title invisible 
 

 
Systematically hide slide titles 
 

 
Put the same title on every slide 
 

 
Why slide titles are important 
 

 
See Also 
 
 

 

Windows 7 support has ended. Get all the features you know and 

love in Windows 10. 

 

Get new features first 

Q.no 15 Write steps for creation of a set of PowerPoint slides that 

demonstrates your skill to use 

the tools of PowerPoint. It should include the following things 
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Ans . How to Create a PowerPoint Presentation 

By nelsone2 in CircuitsComputers 

1,528,234 

54 

28 

 

Introduction: How to Create a PowerPoint Presentation 
 

The possible uses of PowerPoint are countless.  A slide show can 
help a teacher teach a lesson, illustrate an event in history, easily 
display statistical information, or be used for training in 
corporations.  A slide show can be a valuable tool for teaching, 
sharing and learning.  Whether presenting at a conference or 
convincing your parents to get a puppy, PowerPoint presentations 
are useful no matter what the topic and help communicate ideas to 
an audience.  The invention of PowerPoint by Gaskins has saved 
presenters hours of painstakingly handcrafting displays, and 
created a professional and easy way to relay information.  The 
following are steps on how to create a basic PowerPoint 
presentation, however certain steps may vary slightly depending 
upon what version of PowerPoint you are using.  This tutorial is 
specifically using PowerPoint 2007. 

Add TipAsk QuestionCommentDownload 

Step 1: Launch the PowerPoint Program 

When you launch the PowerPoint program, you may be prompted 
to pick what kind of document you want to create.  Choose to create 
a blank presentation.  If it does not ask you this, a blank 
presentation will automatically launch. 

Add TipAsk QuestionCommentDownload 

Step 2: Choosing a Design 

https://www.instructables.com/member/nelsone2/
https://www.instructables.com/circuits/
https://www.instructables.com/circuits/


The next thing you want to do is decide what design you want for 
the presentation. To do this, go to the 'Design' tab at the top of the 
page. Scroll through all the options and decide which one looks 
best for the presentation you want. To get a preview of what the 
design will look like before applying it to the presentation, hover 
over the design you want to preview. This design will be 
automatically continued throughout the rest of your presentation. 
Once you have more than one slide, you can add a different design 
for just one slide. To do this, select the slide you want to change the 
design on by clicking on it. It will pop-up as the big slide in the 
screen. Then you can right-click the design you want for this slide 
and select 'Apply to Selected Slide'. It will appear on that slide, but 
will not change the design of the other slides. 
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Step 3: Create Title Page 

Click the first box that says 'Click to add title' and add the title of 
your presentation.  Click the bottom box to add your name, or any 
other subtitle that you choose.  Once you have your text in the 
boxes, you can change their font, size, color, etc. with the toolbar 
options at the top.  You can change the size of the text box by 
selecting it, and then dragging the corners of the box.  To move the 
text boxes, select the box, and move your arrow over the border of 
the box.  A four-arrow icon will appear, and clicking with this icon 
will allow you to move the text boxes wherever you choose. 
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Step 4: Add More Slides 

Chances are, you are going to need more than one slide.  There 
are a few ways you can add more slides.  Notice that there is a 
separate area to the left of the screen where your first slide is 
located.  The first way to add a slide is to right-click the area under 
where your first slide is located and select 'New Slide'.  A new slide 
will appear.  The second way to add another slide it to click 'New 
Slide' in the toolbar above the slides.  This button is divided into two 
parts,. The top will insert a new slide with a default layout.  You can 
also click the bottom half of this button, which will allow you to 



choose what type of layout you want.  You can choose a slide with 
two text-boxes and a title, one text-box, only a title, and many other 
options.  You will see your new slide appear to the left under the 
first, as well become the large slide that you can edit.  The design 
you picked earlier will have carried over to this slide.  The design 
will carry over for the rest of the slides you create unless you decide 
to change just one, like described earlier.  The guideline layout you 
chose will appear, and you can then add in your information. 
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Step 5: Add Charts, Pictures, Graphs, Etc. 

If you want to insert a chart, picture, graph, or any other graphic, 
click on the 'Insert' tab at the top of the window.  Here you will see 
buttons of all the options of what you can insert into your 
slide.  Click the designated box and insert what it is you want to 
have on that slide.  A second way you can insert pictures and 
graphs is when you have an empty text or image box.  Little 
pictures of the same options you saw in the toolbox will show up in 
the middle of the box, and you can click any of these to insert as 
well.  Once you have your chart or picture, you can add a border or 
edit it however you want in the 'Format' tab. 
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Step 6: Add Transitions 

To add transitions in between your slides, click the 'Animations' tab 
at the top of the page.  Here you can scroll through all the options of 
transitions, and hover over them to see a preview.  Select the slide 
you want the transition applied to, and then click the transition you 
chose.  You can do this for every slide, selecting the same or 
different transitions. 

Add TipAsk QuestionCommentDownload 

Step 7: Changing the Order 

Once you have all your slides made, you can change the order of 
the slides.  To do this, click and drag the slides from where they are 
to where you want them in the order.  Another possibility, which is 



particularly useful if you presentation is longer, is to click the 
'Outline' button.  You can find this small button above the left area 
where all your slides are located smaller, directly to the right of the 
'Slides' button.  Here you will see a list of all your slides and you 
can click and drag your slides to where you want them. 

Add TipAsk QuestionCommentDownload 

Step 8: Play the Presentation 

Once you have all your slides completed and in the order you want, 
view your slideshow.  Click the 'Slide Show' tab at the top of the 
page and select 'From Beginning'.  You can go through your entire 
slideshow, and change slides by clicking or pressing the right 
arrow.  A shortcut to this is pressing F5.  Congratulations! You have 
now made a PowerPoint presentation. 
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Inserting Excel Sheet 

Ans. How to Insert an Excel 

Worksheet into a Word Doc 
Very useful and very easy to do 

 

Written by: Ryan Dube, Twitter: @rdube 

Posted on: April 27th, 2020 in: Office Tips 

If you’ve ever wanted to include data that you have in an Excel file into a 

Word document, you’ve probably just copied the data from Excel and pasted 

it into Word. 

While this works, there are a number of limitations. One of the most 

important is that if the original data file ever changes, your Word document 

will never reflect those changes. 

https://www.instructables.com/member/jesus7872928ass/
https://helpdeskgeek.com/author/rdube/
https://twitter.com/rdube
https://helpdeskgeek.com/category/office-tips/


 

If either of those issues matter to you, there are better ways to insert an 

Excel worksheet into a Word doc. In this article, you’ll learn every way 

possible to do that as well as the pros and cons. 

Also, be sure to check out our YouTube video where we show you the same 

steps as in the article: 

Insert An Excel Worksheet Into A Word 

Doc Via Copy/Paste 
Of course, the fastest and easiest way to get data from an Excel worksheet 

into a Word document is just using Window’s copy and paste feature. 

 

If you place your cursor into your Word document and press Ctrl-V on the 

keyboard, you’ll notice that the cells you’ve selected appear perfectly in the 

Word document.  

https://helpdeskgeek.com/office-tips/how-to-customize-word-paste-function/


 

There are a few caveats here.  

The imported Excel cells become a Microsoft Word table. So if you want to 

format this table after the data is imported, you can’t do things like use 

Excel formulas or other Excel formatting features. 

The second issue is that it only works well for smaller tables of data. If you 

want to copy and paste data further down the Excel spreadsheet, you’ll lose 

the headers. 

 

This isn’t really very useful. In this case, you’ll want to try one of the options 

below to insert an Excel worksheet into a Word doc instead. 

 Pros: Fast and convenient, good for small tables.  

 Cons: Doesn’t update with source data, and lose headers on large tables, 

doesn’t fully conserve original formatting. 



Insert An Excel Worksheet As An 

Embedded Object 
If you want to be able to use Excel functions and other Excel formatting 

features later to update the table, you’re better off pasting the Excel data as 

an embedded object. 

To do this: 

1. Select the section of Excel worksheet that you want to copy and press Ctrl-C. 

2. In Microsoft Word, place the cursor where you want to insert the data table. 

3. In the Home menu, select the down arrow under Paste and select Paste 

Special. 

 

4. You’ll see a Paste Special dialogue box appear. Select Microsoft Excel 

Worksheet Object and select OK. 



 

This will insert the copied cells into your Word document. The new object 

won’t behave like a Microsoft Word table at all, and you won’t be able to edit 

the data inside the table from inside Microsoft Word. 



 

However, you can resize the entire object so that it fits inside the margins of 

your document. 

If you do want to edit the data, just double-click on the object and it will 

open the entire original spreadsheet inside Microsoft Excel. 

Keep in mind this is an entirely new Excel file (not the original). But any edits 

you make and save in that Excel file will update in your Word document. 

How this works: 

 When you use an embedded object to paste Excel data, Word creates a copy 

of the original Excel file. 

 When you double-click the object, Word opens the copied file for editing. 

 You can use all of Excel’s functions and formatting features to make any 

changes. 

What is nice about this approach is that none of the original formatting gets 

changed during the conversion to a Microsoft Word table. It also gives you 



an “attached” Excel data file of the original data file in case you ever want to 

modify the data or add additional data to your pasted Excel object in Word. 

 Pros: Fast and convenient, good for large tables, and conserves original 

formatting  

 Cons: Doesn’t update with source data, and can’t edit table directly inside 

Word 

Insert An Excel Worksheet As A Linked 

Object 
The best way to insert an Excel worksheet into a Word doc is by pasting it 

as a linked embedded object. 

The procedure to do this is identical to the one above, except in the Paste 

Special window you want to make sure to select the Paste Link checkbox. 

 

You’ll see that the inserted Excel data looks the same as in the previous 

section, but there’s a significant difference. 

https://helpdeskgeek.com/how-to/how-to-embed-html-into-a-google-doc/
https://helpdeskgeek.com/office-tips/paste-text-into-word-without-formatting/
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If you return to your original Excel file and make any changes to the data in 

any of the cells you pasted, you’ll see those changes immediately update in 

your Microsoft Word document. 

The changes take effect in Word even if you haven’t saved the changes in the 

Excel file. This essentially lets you create a live view from Word into changes 

someone is actively making in any Excel file.  

If you wanted to, you could use this feature to create a realtime dashboard in 

Word to display any important data points that someone may change in an 

Excel file.  

 Pros: Fast and convenient, good for large tables, conserves original 

formatting, and updates instantly with source data updates. 

 Cons: Can’t edit table directly inside Word. 

As you can see, there are multiple ways to insert an Excel worksheet into a 

Word doc. The option you choose really only depends on how you intend to 

use that data and whether you want to see or use data changes in the 

original Excel file. 

How have you imported Excel data into Word before? Have you had any 

issues when you tried to do so? Share your experience in the comments 

section below. 

 

Ryan has been writing how-to and other technology-based articles online since 2007. He 

has a BSc degree in Electrical Engineering and he's worked 13 years in automation 

engineering, 5 years in IT, and now is an Apps Engineer. Read Ryan's Full Bio 

Read More Posts: 

How to Use Excel’s Speak Cells Feature 

How To Change Default Download Location In Windows 10 
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 4 Situations When Live Location Sharing Could Save a Life 
 12 Chromebook Tips And Tricks 

 The Definitive Guide to Battery Charging 

 How Does Wireless Charging Work? 

Recent Posts 

 How to Measure Distance in Photoshop 

 What Is Microsoft Visual C++ Redistributable & Do You Need 

So Many? 
 4 Best Linux Tablets and Why You Should Use One 
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 How to Scan a QR Code on iPhone and Android 

Random Posts 

 How to Convert an ODT File to Word the Easy Way 

 How to Clear the Clipboard in Windows 10 

 How to Split Audio in Audacity and Other Useful Tricks 

 4 Lesser-Known Mechanical Keyboard Brands & Why They’re 

Worth Trying 

Clip art and Text 

Ans. Images are a great way to liven up a document, and Word 

offers a few methods to insert them. There are built-in clip 

art images for just about every topic, so you may be able to 

find a perfect clip art image for your document. If you have a 

more specific image in mind, you can insert a picture from a 

file. 

In this lesson, you will learn how to search for and insert clip 

art, how to insert an image from a file, and how to change 

the text wrapping settings for your images. 
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Inserting clip art and pictures 

Adding clip art and pictures to your document can be a great 

way to illustrate important information or add decorative 

accents to existing text. You can insert images from your 

computer or search Microsoft's extensive selection of clip art to 

find the image you need. Once an image has been inserted, you 

can format text to wrap around the image. 

Slide show effects 

Ans.  Slideshow Templates for After 

Effects 
13 Free After Effects Templates for Slideshow. Show off your portfolio or collect your 
special memories with these stunning slideshow templates for After Effects. From 
weddings and birthdays to simple and cinematic style templates, you can create your 
very own slideshow and always hold a ticket to go down memory lane. All of 
our After Effects Templates are free to download and ready to use in your next video 
project, under the Mixkit License. 
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Create a file in MS-Word for the following document 

and save it with file name ‘ms_word’. Describe 

all steps involved in it. 

Ans . 

 

  



 

  



 



 


